SE4000

DVB MPEG-2 Contribution Encoder

Installation and Operation Manual

01-0934-401, Rev E

4

TIERNAN

A Radyne Company

Tiernan, A Radyne Company e 7330 Trade Street » San Diego, CA 92121 e (858) 805-7000 ¢ Fax: (858) 805-7001 e www.radn.com




A Radyne Company



SE4000 MPEG-2 Contribution Encoder Warranty Policy

Notice

This manual and its contents are proprietary to Tiernan, A Radyne Company and are intended solely for the
contractual use of its customers for no other purpose than to install and operate the equipment described
herein. This manual and its contents shall not be used or distributed for any other purpose and/or otherwise
communicated, disclosed, or reproduced, in any way whatsoever, without prior written consent of Tiernan.

Only experienced personnel should install and/or operate this equipment. Prior to installing or operating any
equipment or parts thereof, personnel must carefully read and understand all of the contents of this manual.
To properly install and operate this equipment and/or all parts thereof, personnel must strictly and explicitly
follow all of the instructions in this manual.

Failure to completely read and fully understand and follow all of the contents of this manual prior to installing
and/or operating this equipment, or parts thereof, may result in injury to personnel and/or damage to the
equipment, or parts thereof.

Tiernan does not assume any liability arising out of the application or use of any products, component parts,
circuits, software, or firmware described herein. Tiernan further does not convey any license under its
patent, trademark, copyright, or common- law rights nor the similar rights of others. Tiernan further reserves
the right to make any changes in any products, or parts thereof, described herein without notice.

©2004 Tiernan, A Radyne Company. All rights reserved.

Tiernan, A Radyne Company is a registered trademark. Other brand and product names mentioned herein
may be trademarks or registered trademarks of their respective owners.

Contents are provided with Restricted Rights. Use, duplication, or disclosure by the government is subject to
restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software
[OCT. 1988] clause at DFARS 252.227-7013 and subparagraphs (a) through (d) of the Commercial
Computer Software-Restricted Rights [JUNE 1987] clause at FAR 52.227-19, as applicable. Manufacturer is
Tiernan, A Radyne Company, 7330 Trade Street, San Diego, CA 92121 USA.

Contents of this manual are provided as is without warranty of any kind, either expressed or implied,
including, but not limited to, the implied warranties of merchantability, fitness for a particular purpose, and
non-infringement.

Content could include technical inaccuracies or typographical errors. Changes are incorporated in new
editions of this manual. Tiernan, A Radyne Company may make improvements and/or changes in the
product(s) and/or the program(s) described in this manual at any time without notice.

In no event will Tiernan, A Radyne Company be liable for direct, indirect, special, incidental, economic,
cover, or consequential damages arising out of the use or inability to use the contents even if advised of the
possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of implied warranties,
or the limitation of liability for incidental or consequential damages, so the above limitation or exclusion may
not apply to you. For further information on legal and intellectual property matters, contact Tiernan, A
Radyne Company Corporate Counsel.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct the
interference at their own expense.
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Warranty Policy SE4000 MPEG-2 Contribution Encoder

A\ CAUTION!

WARNING! Electric Shock Hazard

Do Not Open The Equipment!
Service Only by Tiernan, A Radyne Company.

. Gefédhrliche Spannung!
Offuen des Geriétes und Service nur dur Tiernan, A Radyne Company

A\ WARNING!!

The SE4000 contains no user-serviceable parts. Do not attempt to
service this product yourself. Any attempt to do so will invalidate any
and all warranties.
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Preface

Using This Manual

This manual is your sourcebook for using the Tiernan SE4000 and describes the installation,
operation, and configuration for this product. An overview of system and product level
requirements, technical specifications, and troubleshooting procedures are also provided.

This manual is designed to help you find information quickly and easily. To take full advantage of
this design, please take a moment to review the specific formats.

Locating Information

To help you quickly locate information, this manual includes:
Table of contents

Index

Glossary
Quick reference cards

Important Information

Throughout this manual you will find icons designed to help you identify important information.

These icons are the:
A\ CAUTION!

A caution icon indicates a hazardous situation that if not avoided, may result in minor or moderate
injury. Caution may also be used to indicate other unsafe practices or risks of property damage.

A\ WARNING!!

A warning icon indicates a potentially hazardous situation that if not avoided, could result in death
or serious injury.

01-0934-401-E v



Preface SE4000 MPEG-2 Contribution Encoder

A note icon identifies information for the proper operation of your equipment, including helpful
hints, shortcuts, or important reminders

lllustrations

Some illustrations contained in this manual may differ slightly from those shown on your front
panel display, rear panel, or remote terminal due to variations in your system components,
configuration, or customization.

Figures depicting equipment may differ from those at your site; therefore, refer to the labeling on
your Tiernan equipment to identify the components. An effort has been made to use illustrations
that reflect basic equipment and configurations of the majority of customers.

Issuing Commands

Tasks and examples are presented in a series of step-by-step instructions. Commands or
information that you enter into the system appear in a different type, as shown in the following
example:

To restore the factory default configuration, select Quickset>dvb from the front panel, or
issue the remote command cm rest ore dvb.

If the command contains variable information that is to be typed into the system, the variable
information is found within karats < >. In the following example, TCA DELETE then the correct
value for <| abel > is typed:

Type TCA DELETE <I abel >
Front Panel Navigation
This manual uses right angle brackets (>) to indicate a sequence of menus, submenus, and

menu items.
For example, select Cont r ol >Dat eTi nre>03 Sept enber, 2003 means:

e From the main menu, select control.

e From the control menu, select clock.

e From the Date time menu, select date.

e At the date option, enter the date, 03 September, 2003, in the correct format.
Displays

The system may return values and messages on a front panel LCD, remote terminal, or both. In
this manual these values and messages appear in a different type:

date = 06/ 23/2003
restore = dvb
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Revision History

This manual is periodically updated and revised. For documentation updates, call Customer
Service Support.

Revision Date Type of Revision
A 09-22-03 Initial release.
B 11-24-03 Front panel command revisions
C 10-08-04 Corrected front and rear panel views and fault tables
Product Support

We hope this manual provides all the information and instructions you need to operate the
SE4000. However, if you need assistance, contact Tiernan Product Support at our corporate
headquarters, located in the United States, through any of the following methods:

Phone: 858-805-7000

Fax: 858-805-7001

Email: customerservice@radn.com
Website: http://www.radn.com

Product Shipments

Please verify that your company name and address are correct on the packing slip that is
included with your equipment. Notify Tiernan Product Support if any of the information is
incorrect.

Ensure that you write down the following numbers and include them in any correspondence with
Tiernan, A Radyne Company concerning your order:

e Purchase order

e Model

e Reference line

e Sales order
Errors

If any part of your shipment is missing or incorrect, call Tiernan Product Support.

Cartons and Packing Materials

The factory-shipping carton and packing materials are designed to protect the equipment from
excessive shock and vibration that can occur during shipping.

Use the original shipping carton and packing materials to repack the unit for shipment to another
location or to return the unit to Tiernan, A Radyne Company for repair.

For additional information on equipment repacking, refer to the Warranty booklet that
accompanied the product shipment.
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LCD Display
When you receive your SE4000, the LCD display may be covered with a plastic protective

covering. To remove the protective covering, gently lift one of the corners and peel off the
covering.

Warranty Information

For warranty or return material authorization information, refer to the Warranty booklet that
accompanied the product shipment.

Other Tiernan Products
Visit the corporate website at www.radn.com. This provides information about the entire line of

Tiernan products and systems, including encoders, integrated receivers/decoders (IRD),
switches, ATM products, network interfaces, and network management software.

Safety Precautions
Carefully read and follow all safety, use, and operating instructions before operating the SE4000.

Heed all warnings and cautions contained in this manual. Retain these instructions for future
reference.

Follow Startup Procedure

Do not plug in the SE4000 until you have connected the system and read the chapter on
installation.

Provide a Safe Location
Place the SE4000 in a rack or on a stable surface of sufficient size and strength, where it will not

be jarred, hit, or pushed off its surface. Ensure that all cables and cords are out of the way and
will not be tripped over, as this could cause personal injury or serious damage to the equipment.

Avoid Water and Moisture

If the equipment is exposed to any liquid, contact Tiernan, A Radyne Company, as serious
damage could occur to the SE4000 or its components.

Avoid Heat, Humidity, and Dust

To avoid internal damage, the SE4000 should be placed away from all heat sources, including
radiators, heater ducts, and so on, out of direct sunlight and away from high humidity, excessive
dust, or mechanical vibrations that can cause damage to internal parts.
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Provide Adequate Ventilation

Slots and openings on the SE4000 are provided for ventilation that is needed to ensure reliable
operation. To avoid overheating and ensure that the ventilation slots are not blocked, place the
SE4000 on a smooth, hard surface that has at least two inches of clearance around the unit and
adequate air circulation. If the equipment is placed in a closed area, such as a rack, ensure that
proper ventilation is provided and that the internal rack operating temperature does not exceed
the maximum rated temperature at the position of the SE4000.

Never place the SE4000 on a soft surface that would obstruct the required airflow into the
ventilation slots.

Use the Correct Power Source

For units equipped with a North American power cord, the cord has an IEC-compatible female
plug on one end, and a male plug on the other end. This cord is UL and CSA approved up to 125
VAC at 10 A and is ready to use with no user wiring required.

For units equipped with an International power cord, the cord has an IEC-compatible female plug
on one end, and three stripped and tinned bare wires on the other end. This cord is approved up
to 250 VAC at 6 A and complies with the international color codes of green/yellow (ground), blue
(neutral), and brown (line).

If these color codes do not correspond to the colored markings on the terminals in the plug, use
the following standards:

The green/yell~+- wire must be connected to the plug terminal marked by the letter E or
L
by the earth sy=»>0l ( ) or color-coded green and yellow.

The blue wire must be connected to the plug terminal marked with the letter N or color-
coded black.

The brown wire must be connected to the plug terminal marked with the letter L or color-
coded red.

An AC plug must be attached to the International power cord in accordance with government
standards and codes in effect at the installation site. If an unterminated power cord is supplied
with the unit, the appropriate certified termination plug must be installed. The following is a list of
the required certifying agencies for various countries:

Country Agency Country Agency
Australia SAA Italy IMQ
Austria OVE Japan MITI
Belgium CEBEC Netherlands KEMA
Canada CSA New Zealand SECV, SECQ, SECWA, EANSW,
ETSA, HECT, SANZ
Denmark DEMKO Norway NEMKO
Finland FEI Rep. S. Africa SABS
France UTE Spain AEE
Germany VDE Sweden SEMKO
India ISI Switzerland SEV
Ireland IIRS United Kingdom (UK) ASTA, BSI
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Route Power Cords Safely

Route power cords so they are not walked on or pinched. Pay particular attention to cords and
connections at the plugs, receptacles (such as power strips), and the point where they exit from
the SE4000 and attach to other equipment. Do not place any items on or against power cords.

No Stacking

Do not place or stack any objects on top of the SE4000. Other equipment may be placed in a
rack or on a shelf above or below the SE4000, but never stacked directly on top of it.

Protect Against Lightning and Power Surges

When the SE4000 is installed, have the professional installer ground the system to protect
against voltage surges and built-up static charges. For information on grounding standards for
electrical and radio equipment, refer to the electrical code in the country of installation.

Protect the SE4000 from lightning and power-line surges during a storm by unplugging it from the
wall outlet and disconnecting the coaxial cable.

Do Not Open the SE4000

There are no user serviceable parts inside the SE4000. It should be returned to and/or serviced
by Tiernan, A Radyne Company.

Keep Objects Outside

Touching internal SE4000 parts is dangerous to both the user and equipment. Never put any
object, including fingers, through slots or openings, as this could result in touching dangerous
voltage points, short-circuiting parts, electric shock, or fire.

There are no user-serviceable parts inside the SE4000. If an object falls into the equipment,

unplug the unit and contact the Radyne ComStream, Inc. Customer Service Department, as
serious damage could occur to the SE4000 or its components.

Clean the SE4000

Before cleaning the SE4000, unplug it from the wall outlet. Do not use any type of abrasive pads,
scouring powders, aerosol cleaners, or solvents such as alcohol or benzene.

Use only a clean, soft cloth lightly moistened with a mild detergent solution. Wipe all equipment
with a clean, soft cloth lightly moistened with water to remove the detergent solution.
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Service the SE4000

Do not attempt to service the SE4000 yourself, as there are no user-serviceable parts. Opening
or removing covers may expose you to dangerous voltages or other hazards as well as void your
warranty. Contact the Tiernan Customer Service Department to obtain qualified service
personnel.

The following are some of the conditions that indicate the equipment needs servicing:
e The power cord or plug has been damaged.
e An object has fallen into the SE4000.
e Liquid has been spilled into the SE4000, or it has been exposed to rain or water.
e The unit has been dropped or the cover has been damaged.

The SE4000 does not operate normally, or it shows a marked change in performance.

Perform Safety Checks

Upon completion of any service or repairs to the SE4000, ask the service technician to perform
safety checks to verify that the system is in safe operating condition.
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SE4000 MPEG-2 Contribution Encoder Overview

Overview 1

The SE4000 is a rugged, compact MPEG-2 encoder designed for newsgathering and
professional broadcast applications. Video input may be analog, PAL or NTSC, or serial digital
525/625. Two stereo audio inputs may be either analog or AES/EBU. Video encoding may be
4:2:0 in accordance with MPEG-2 Main Profile @ Mail Level or optional 4:2:2 Studio Profile @
Main Level. The compressed digital output is a DVB® MPEG-2 or ATSC-compliant transport
stream. Audio compression may be MPEG, AC-3 2.0, or uncompressed pass-through.

The SE4000 compresses the incoming video with the latest adaptive field-frame MPEG-2
algorithm. The video compression is performed with I, B, and P frames using bi-directional
predictive coding and motion estimation. The two stereo or four mono audio channels are
compressed using either MPEG or AC-3 2.0 audio encoding standard. The two auxiliary data
channels support both synchronous and asynchronous serial formats.

A push button front panel with an illuminated LCD and bright LED indicators provides control and
system status. The optional integrated DVB®, QPSK, 8PSK, 16QAM satellite modulator is
controlled by one-touch buttons for carrier on/off and modulate. Additionally, remote control is
available using ASCIl or SNMP commands via the EIA-232 remote control and Ethernet ports.
The SE4000’s rugged chassis is a 1U high (4.45 cm), 19” width rack-mount unit providing full rear
panel cabling. The main power switch is conveniently located on the front panel.

1.0 Features
The SE4000 consists of the following standard feature set:

¢ Advanced video compression chip-set which encodes the input video following either
4:2:0 Main Profile @ Mail Level or optional 4:2:2 Studio Profile @ Main Level standards.

¢ A high-quality horizon decimation filter for intermediate horizontal resolutions.

e Supports compressed audio rates of 64 to 384 Kbps and four different audio channel
compression methods.

e MPEG or AC-3 2.0 coding.

o Accepts two high-speed, independently programmable auxiliary data channels.

Automatic configuration of video and audio rates to match the available transmission

bandwidth for optimum performance.

Dedicated modulator control buttons are provided on the front panel for one-touch control.

Optional BISS conditional access.

Extensive VBI data support of DVB teletext.

Front panel lockout to prevent accidental configuration changes.

At-a-glance status monitoring via a tri-colored Status LED indicator.

Status hot key enables the user to toggle between fault lists and other front panel menus.

Remote control via Ethernet or EIA-232 providing all configuration, monitor, and control

functions

o Built-in self-tests and extensive self-diagnostics to assist with system checkout and

problem solving.

Non-volatile, field-programmable memory.

User configuration sets that can store and recall commonly used parameters sets

Auto-ranging, auto-sensing power supply

Rugged chassis construction

01-0934-401-E 1-1
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1.1 Video

The SE4000 uses an advanced video compression ship-set which encodes the input video
following either the 4:2:0 Main Profile @ Main Level or the optional 4:2:2 Studio @ Main Level,
according to MPEG-2 standards (ISO/IEC 13818-2).

The SE4000 supports the following compressed video rates:

¢ MPEG-2 4:2:0 Main Profile @ Main Level: 1 to 15 Mbps
o MPEG-2 4:2:2 Studio Profile @ Main Level (optional): 2.5 to 50 Mbps, which provides
superior quality compressed images at high data rates.

The video encoder features a low latency mode for interactive applications and a Tiernan
proprietary, high-quality horizontal resampling filter for intermediate horizontal resolutions.

1.2 Audio

Two stereo or four mono audio channels are compressed using MPEG or AC-3 2.0 audio
encoding standards.

The SE4000 supports compressed audio output rates of 64 to 384 Kbps and four different audio
channel compression methods.

1.3 Auxiliary Data

One channel of synchronous data up to 20 Mbps (RS-422) and one channel of asynchronous
data up to 115 Kbps (RS-232) are supported by the SE4000.

1.4 Conditional Access

The SE4000 optionally supports BISS, Modes 1 and E, as well as Tiernan’s proprietary
conditional access schemes.

1.5 VBI (Vertical Blanking Interval)
Extensive VBI data support is provided via the SE4000. Supported formats include:

Proprietary passage of NTSC line 21 closed-caption.

ATSC closed captioning.

DVB Teletext for World System Teletext (WST) on PAL.

DVB 4:2:2 expanded windows carries WSS, VPS, VITC, CC, AMOL, XDS, etc.

1.6 Modulator
The SE4000 has a built-in DVB®-compatibIe QPSK, 8PSK and 16QAM modulator with a 70 MHz,

140 MHz, and direct L-Band output carrier capable of supporting up to 45 Msps. An L-Band
monitor output is provided for direct IRD connection.

1.7 Modulator Control Buttons

The SE4000 provides dedicated modulator control buttons on the front panel. These are
designed to bring carriers up onto satellites in a fast and efficient manner.
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1.8 ASI Output

An ASI output is also available for connection to an external multiplexer or modulator.

The SE4000 accepts all commonly used video and audio input formats and provides an MPEG-2
DVB compliant transport stream in addition to a DVB®-compatibIe QPSK modulator with a 70
MHz, 140 MHz, and direct L-Band output.

Within the data rate limitations of the channel, the SE4000 can be reconfigured for different video
resolutions, video optimization, and audio compressed bit rates to get the best video
performance. Higher compressed bit rates result in better-decoded video quality.

For high reliability applications, the SE4000 provides exceptional MTBF performance with its
extensive digital processing and proprietary FPGA circuits. In addition, the SE4000 can
automatically configure the video and audio rates in order to match the available transmission
bandwidth for optimum performance.

1.9 Monitor and Control Functions
The SE4000 monitor and control functions include:

e Fault Relay with passive normally open and normally closed contacts.

e Front panel operator control utilizing an easy-to-use, intuitive menu and backlit push
buttons.

e Remote control using either an Ethernet or RS-232 interface.

1.10 Front Panel

The SE4000 front panel interface allows you to scroll through a standard set of menus to easily
set your operating parameters. All configuration and monitoring functions can be efficiently
performed using the front panel.

At-a-glance system status can be quickly determined by checking the tri-colored front panel
status LED:

e Green: indicates that the unit is receiving AC power and that there are no faults.
e Yellow: indicates that the unit has a current fault.
e Red: indicates that the unit has a hard fault.

If the Status LED indicates that there is a fault, the Status hot key enables you to go directly to
the current faults list with the press of a button.

1.11 Remote Control
A remote unit, such as a computer terminal, is easily connected to either the EIA-232 remote

control port or Ethernet port allowing the SE4000 to be configured, monitored, and controlled
using character-based ASCII protocol or SNMP.

1.12 Programmable Memory

The SE4000 is a field-deployable unit with non-volatile, field-programmable memory that ensures
retention of configuration parameters during power outages, power off, and transportation. The
SE4000 maintains the last user configuration in flash memory.
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1.13 Configuration Sets

The SE4000 has a number of default configurations that can be restored as well as numerous
user-defined configuration sets that can be saved and restored.

1.14 Construction

The SE4000 is a small, rugged, 1RU (4.45 cm/1.75”) high, 19” wide rack-mount chassis with an
international, auto-sensing, AC power supply.
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Introduction 2

This chapter provides step-by-step procedures for installing and cabling the SE4000.

A\ WARNING!!

Do Not Remove the SE4000 Top Cover! The SE4000 is powered by an
exposed, switching AC power supply, which presents an electric shock
hazard when the top cover is removed. Personal injury or damage to the
equipment can occur when the top cover is removed. None of the
procedures in this manual require the removal of the SE4000 top cover.

A\ CAUTION!!

Before beginning your installation, read the Safety Precautions as they
contain important safety information and other instructions required to
install the SE4000.

2.0 Placement

The SE4000 can be installed on a tabletop or in a rack. Use the following guidelines to determine
the appropriate installation:

e If the equipment must be moved frequently, install the SE4000 on a tabletop or other flat
surface.

e If the equipment is going to be installed permanently, install the SE4000 in a rack using
rack mount brackets.

Whichever installation is used, always position the equipment to allow easy access to the rear
panel and provide adequate ventilation.

To properly install the SE4000, follow the instructions provided in the appendix on tabletop and
rack mount installation instructions.

2.0.1 Ventilation
The SE4000 must be positioned to receive adequate ventilation at all times. The cooling fan pulls

air in through the side vents, circulates the air, and exhausts it out the side vents. The minimum
airflow clearance required on both sides of the chassis is three (3) inches.
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2.1 Powering On The SE4000

The rear panel AC power supply interface includes a fuse holder, and an IEC 320 power cord
receptacle. The typical SE4000 configuration requires 70 Watts.

An auto-sensing, auto-ranging AC switching power supply powers the SE4000 unit. The supply
accepts 100 to 240 VAC nominal input voltage levels cycling at 50 to 60 Hz. A 1 Amp fuse on the
rear panel protects the power supply from excessive current.

The On/Off (1/0) power switch is located on the front panel.

2.1.1 AC Power Cords

The SE4000 shipping kit includes two AC power cords, one for North American applications,
specifically the United States and Canada, and the other for international applications.

A\ CAUTION!!

AC wiring must be done in accordance with governmental standards and
codes in effect at the SE4000 installation site. Refer to the Safety
Precautions for additional information.

2.1.2 North American Applications

One cord has an IEC- compatible female plug on one end and a North American male plug on the
other. This cord is UL and CSA approved up to 125 VAC at 10 A. This cord is ready to use with
no user wiring required.

2.1.3 International Applications

The international cord has an IEC-compatible female plug on one end and three stripped and
tinned bare wires on the other end. This cord is approved by many international safety agencies,
including VDE, up to 250 VAC at 6 A.

2.1.4 Connecting to a Power Source

To connect to an AC power source, follow these steps:

1. Select an AC power cord. If an international power cord is selected, attach a
connector in accordance with local regulations and laws.

2. Ensure the SE4000 power switch is in the Off, or O position.

3. Connect the female plug of the AC power cord to the AC power receptacle on the
SE4000 rear panel.

4. Connect the male plug of the AC power cord to an external AC power
conditioning surge suppressor.

5. Connect the AC power conditioning surge suppressor to an AC outlet.
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A\ CAUTION!!

Corrupted AC input power can interrupt SE4000 operations and cause
permanent damage to the unit. You should purchase and install a
commercially available, external AC power conditioning surge
suppressor to protect the SE4000 against power spikes and line
transients..

2.1.5 Power-up Sequence

Once the cabling and interconnections for the SE4000 are completed, the unit may be powered
up. The SE4000 power switch is a rocker switch located on the front panel. The power switch is
labeled 1/0 where the 1 represents the On position and the 0 represents the Off position.

To power up the SE4000, press the power switch to the On, or 1 position. The power-on cycle
takes approximately 20 seconds, as the unit performs extensive self-diagnostics in this time
period.

During the powered- up cycle, the SE4000 displays SE4000 St andard Definition
Encoder Initializing...,various messages may scroll across the LCD display, and the tri-
colored Status LED illuminates and may flash.

After the unit is initialized, the LCD displays the SE4000 Main Menu.

SE4000
[Quickset] Service Output  Status

When beginning the initial SE4000 installation and configuration, the
modulator output (Mod State) should be turned off until ready to begin
satellite transmissions.
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2.2 Rear Panel Connections

All SE4000 external connections are located on the rear panel, as shown in the following
illustration.

Right Analog A Right Analog B Service Aux Data Async  Monitor 120/250VAC/50-60 Hz

70/140 IF
L-Band Output

50 6

Remote

Left Analog A | Left Analog B Aux Data Sync

SE4000

PP | N ey "
SDI Video In ‘
ASI Out B Ethernet
Comp Video In ASI| Out A
Digital Audio B Fault Relay
Digital Audio A

2.3 Video Ports

The SE4000 provides connections for both analog and digital video.

2.3.1 Analog Video In

Analog Video In is a female BNC connector with 75Q impedance, accepting a NTSC or PAL
composite analog video input that is 1.0 Vp-p nominal level. The analog composite video input
must be compliant with SMPTE 170M NTC, ITU-R BT.470, or PAL-I/B/D. The connector shell is
connected to signal ground.

Connect the video input cable to the Analog Video In connector on the rear panel.
2.4 Audio Ports
2.4.1 Analog Audio

The SE4000 has the following sets of analog audio input ports:

¢ Analog Audio A Right and Left.
¢ Analog Audio B Right and Left.

The ports can be configured for two stereo or four
independent analog mono channels.

Each port has a male XLR connector with high
impedance (>10 kQ) termination.

XLR Male

|
¢

Note: Four XLR Female to Female Adapter Connectors are included in the shipping kit.
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The pin assignments for all the analog audio ports
are listed in the following table:

Audio Port Pin Assignments
Pins Signal
1 Gnd
2 +
3 -

2.4.2 Digital Audio Ports

The SE4000 has the following two digital audio input ports:

e Audio Input A.
¢ Audio Input B.

Each port has a female BNC connector with a 75Q nominal termination. The ports accept

AES/EBU serial digital input that is compliant with ANSIAES3-1992 (ANSI S4.40-1992)
recommendations. The ports are typically configured for two stereo channels.

2.5 Data Ports
2.5.1 Synchronous Port

The synchronous port accepts RS-422 input at 1 Kbps to 20 Mbps. The auxiliary data
synchronous port pin assignment is listed in the following table:

Aux Data Port Pin Assignments: Synchronous - RS-422
Pins Signal Direction Definition

1 Unused - -

2 ST+ Out Send Timing

3 SD+ In Transmit Data

4 TT- In Terminal Timing

5 GND - Ground

6 ST- Out Send Timing

7 Unused - -

8 SD- In Transmit Data

9 TT+ In Terminal Timing
Shell GND - Ground-
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2.5.2 Configuring the DTE and SE4000 Clock Interfaces

After you have cabled the data termination equipment (DTE) to the SE4000, you must determine
the most effective SE4000 and DTE clock source arrangements. There are three different ways to
configure the clock interface for the SE4000 and the DTE:

o Clock Interface Configuration 1 is the most reliable clock source arrangement. This
configuration requires the DTE to provide a clock (TT) synchronous with the data (SD) to
the SE4000.

e Clock Interface Configuration 2 is the second most reliable clock source arrangement.
This configuration is used when the DTE cannot turn around the ST, but has an internal
clock source that can be provided as TT to the SE4000.

Clock Interface Configuration 3 is the least reliable clock source arrangement - it should only be
used if the first two clock configurations cannot be used. In this configuration the SE4000 is
configured to use ST to latch the data.

2.5.2.1 Clock Interface Configuration 1

The most reliable auxiliary data channel clock source configuration requires the DTE to provide a
clock (TT) synchronous with the data (SD) to the SE4000. This scenario allows the SE4000 to
latch the data using a clock that has traveled the same path as the data, which ensures that both
the clock and the data are received in phase at the SE4000.

The following block diagram shows the clock configuration for a DTE configured to turn around
the ST clock source, and a SE4000 auxiliary data channel configured for an external clock
source.

Notice in the illustration that the switch for the SE4000 auxiliary data channel clock source is
configured for external even though the SE4000 is providing ST to the DTE.

DTE SE4000
Data SD SD
Data }——-I Timing Data J| = Latching Data To TTM
ST Ext. Source
Int. Source S Clock TT Piypea I b

—

-t —

Int. Source

Ext. Source Clock ST <1t I Internal Clock ST |

In this configuration, the SE4000 provides clock (ST) to the DTE. The switch for the DTE clock
source is configured to accept the external clock (ST) provided by the SE4000. The DTE uses the
ST to time the data, sends the data to the SE4000 on SD, and returns the ST to the SE4000 on
TT. The SE4000 uses TT to latch the data.

The SE4000 auxiliary data channel must be configured for an external clock source to accept TT
from the DTE.
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2.5.2.2 Clock Interface Configuration 2

If the DTE cannot turn around the ST, but has an internal clock source that can be provided as TT
to the SE4000, use this option to configure the auxiliary data channel.

The following block diagram shows the clock configuration for a DTE providing an internal clock
source as TT to the SE4000.

DTE SE4000
l Data |——I Timing Dati} Dataisd =0 Latching Data To TTM
Ext. Source
Int. Source Clock TT TII™™""671

Swich” 9_
Int. Source

| ST Ilntemal Clock ST|

o Clock ST

In this configuration, the DTE clock is set to internal and the SE4000 auxiliary data channel clock
source is set to external. The DTE uses its internal clock source to time the data, sends the data
to the SE4000 on SD, and sends its internal clock to the SE4000 as TT. The SE4000 uses TT to
latch the data. The SE4000 auxiliary data channel must be configured for an external clock
source.

2.5.2.3 Clock Interface Configuration 3

If the DTE cannot turn around the ST, and does not have an internal clock source that can be
provided as TT to the SE4000, configure the SE4000 to use the ST to latch the data. However,
this scenario is not recommended and should be considered only if neither of the other two-clock
source configurations can be used.

The following block diagram shows the clock configuration for a DTE configured for an external
clock and a SE4000 auxiliary data channel configured for an internal clock.

DTE SE4000

Data SD
Data J——rTiming Data Ir u
ST

ToTIM

Clock ST STA Internal Clock ST

In this scenario, both the DTE and the SE4000 use ST, but the ST is provided to the DTE on one
path and to the SE4000 on a different path. Depending upon the length of cable between the
DTE and the SE4000, the clock may be received out of phase at the SE4000. The longer the
cable, the further out of phase the clock will be.
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A\ CAUTION!!

If the internal clock is used to latch the data, the length of cable between
the DTE and the SE4000 must be limited to one meter (3 feet).
Additionally, the auxiliary data rate must be limited to not more than
64 Kbps. If the cable length exceeds one meter, or if it is attempted to
process data at rates above 64 Kbps, the auxiliary data may be corrupted.

2.5.3 Asynchronous Configuration

In asynchronous configurations, ports are configured to accept RS-232 input at rates of 1200 bps
to 115000 bps.

2.5.3.1 RS-232

The DB-9 connector allows a standard RS-232 DCE connection. The auxiliary data asynchronous
port pin assignments for RS-232 are listed in the following table:

Aux Data Port Pin Assignments: Asynchronous - RS-232
Pins Signal Direction Definition
1 Unused - -
2 Unused - -
3 TD In Transmit Data
4 Unused - -
5 GND - Ground
6 Unused - -
7 RTS In Ready to Send
8 CTS Out Clear to Send
9 Unused - -

2.6 Remote Control Ports

A remote unit can be connected through either of two ports located on the SE4000:

¢ RS-232
e Ethernet Control

2.6.1 RS-232 Control Port

The RS-232 port is a DB-9 female connector. The port is configured as a DTE
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2.6.1.1 DCE Configuration

The pinouts for the RS-232 port configured as DCE are listed in the following table:

RS-232 Port Pin Assignments: DTE

Pins Signal Direction Definition
1 Unused - -
2 TXD Out Transmit Data
3 RXD In Receive Data
4 DSR In Data Set Ready
5 GND - Ground
6 DTR Out Data Terminal Ready
7 CTS In Clear to Send
8 RTS Out Request to Send
9 RI In Ring Indicator

2.6.2 Connecting to the RS-232 Control Port
To connect a remote unit to the SE4000 through the RS-232 control port, a cable is needed that
is the appropriate length for the application. The cable must be made to the following
specifications:

e RS-232 electrical.

e DB-9 female connector on one end.

¢ An appropriate connector for the remote unit on the other end.

A standard direct connect DB-9 male to DB-9 female cable is included in the shipping kit.

Using the direct connect cable provided with the SE4000, attach one end to a remote unit and the
other end to the RS-232 control port.

2.6.3 Ethernet Control Port

The Ethernet control port is an RJ-45 connector. Remote control using this port requires the
following:

e Tiernan Network Management Software (NMS) program or alternate SNMP controller.
e Category 5 UTP patch cable (not supplied).

2.6.3.1 Connecting to a Network Using the Ethernet Port

The SE4000 can be connected to a LAN using the Ethernet port, which enables monitoring and
control the SE4000 through a remote unit not directly connected to the SE4000.
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When connecting the SE4000 to a LAN using Ethernet, contact your
Information System department to coordinate installation and setup.

Perform the following steps to connect to the network using the Ethernet port:

1. Connect a Category 5 cable with RJ-45 connectors (standard Ethernet cable) between
the SE4000 Ethernet port and a LAN hub.

2. Assign the device a unique IP address, if necessary.

The SE4000 default IP address is 0.0.0.0. Contact your Information Systems department
for a valid IP address.

To change the IP address using the front panel:

a. Select Control>Network>IP Addr

b. Using the keypad, enter the IP address in the format xxx.xxx.xxx.xxx where xxx
is a decimal number between 0 and 999.

C. Press the Enter button

To change the IP address using a remote unit, issue the following command

MC | P XXX, XXX, XXX, XXX
where XXX is a decimal number between 0 and 999.

3. Assign additional network information, if necessary. Depending on the configuration of
the LAN, you may need to enter additional parameters including:

o Ethernet IP address mask (IP subnet mask).
. Ethernet IP gateway.
4, From a personal computer connected to the LAN, try to ping the SE4000. At the

command prompt of the personal computer, type ping <SE4000 IP address> where
<SE4000 IP address> is the address assigned in step 2.

If a reply is received, the SE4000 is correctly configured.

For information on establishing remote communications or on Ethernet commands, refer to the
chapter on using a remote unit.
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2.6.4 Fault Relay

The Fault Relay is an RJ-11 connector. The fault relay is used in a redundant configuration. In
this configuration input is fed from distribution amplifiers into each of two SE4000s. A Tiernan
redundancy switch monitors the output through the Fault Relay. If the primary SE4000 faults, the
secondary SE4000 automatically takes over operation.

A relay fault condition is defined as:

e A unit power failure.
e Unit power switch turned off.
e Unitis unplugged.

e A unit hardware failure.

The fault condition is indicated by contact closure between pins one (1) and three (3) and open
contacts between pins one (1) and six (6). The non-fault condition is indicated by contact closure
between pins one (1) and six (6) and open contacts between pins one (1) and three (3).

The illustration indicates the physical locations of pins 1 and 6 within the fault relay port, as
viewed from the rear panel.

When the fault relay detects a fault condition, the fault relay trips, and the Status LED located on
the SE4000 front panel illuminates red.

Pin 1 Pin6

The SE4000 multiplexer outputs an ASI transport stream with a variable rate of 1 to 80 Mbps.
This transport stream is the combination of the video, audio, and auxiliary data streams in an
MPEG-2 compliant transport stream. The transport stream is always available at the ASI output
ports even if a modulator is installed and operating

2.7 Transport Connection Ports

2.7.1 ASI Out Primary

ASI Out Primary is a female BNC connector with 75Q impedance. The port outputs a DVB-
compliant ASI transport stream at rates between 1 and 80 Mbps.

ASI Out Primary is used for normal operation and is typically cabled to the Mod ASI In connector
with a short (14”) coaxial cable.
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2.7.2 ASI Out Secondary

ASI Out Secondary is a female BNC connector with 75Q impedance. The port outputs a copy of
the primary transport out.

ASI Out Secondary port can be used to output the transport stream of one SE4000 to the
multiplexer of the SE4000 for MPTS operation. In this configuration, this port is cabled to the Mux
ASI In port of the SE4000 in the MPTS chain.

2.8 Modulator Output to Upconverter

The internal modulator outputs a modulated IF signal, which is connected to an upconverter.
Connections are made through the Tx If Out port. This port is a female BNC connector that
outputs a 70 MHz, 140 MHz, or L-Band DVB-compliant, QPSK, 8PSK, or 16QAM modulated,
FEC encoded IF signal at symbol rates from 1 to 45 Msps.

Before attaching cables from the modulator output to the upconverter,
verify that the modulator power is off until ready to begin satellite
transmissions.

To cable the modulator output to an upconverter, connect the output of the internal modulator
from Tx IF Out to an IF-to-RF upconverter.

There is also an L-Band Monitor port available for direct monitoring connection to an IRD.
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Using the Front Panel 3

This chapter describes the following SE4000 front panel information:

Components
Commands, including navigating, setting and changing parameters
Menus, options, and parameters

3.0 Front Panel Components

The front panel enables you to easily and efficiently configure and monitor the SE4000.

SE4000

MPEG-2 ENCODER

eH—D ODODC @ e
S5 NulbE if GsESEERLNEEEED iai S50 ™ & OSEO® & o
TIERNAN & O O®OO S

The front panel consists of:

LCD - displays menus, parameters, information, and messages

Enter button — used to select a menu item, issue a command, or set a parameter

Exit button — used to scroll up to a previous menu level or leave a parameter without
changing it's option

Left and Right buttons — used to scroll within the current menu level, or to scroll through a
list of parameters

Up and Down buttons — used to scroll through parameter options and increase and
decrease parameter values

Alphanumeric keypad — used to enter alphabetic and numeric parameter values

Status button — hot key which toggles between the current front panel menu and the
current faults list

Status LED — tri-color LED alerts you to status and fault conditions

Modulator control buttons and LEDs — these two buttons affect the power and form of the
output IF transmit carrier from the encoder:

Carrier — enables carrier wave at nominal power

Mod — enables modulated carrier at nominal power

01-0934-401-E 3-1



Using the Front Panel SE4000 MPEG-2 Contribution Encoder

3.1 SE4000 Menu Structure

The following illustration shows the SE4000 menu structure:

Menu Submenus Parameters
Quickset DvB <DVB Description>
_E USRCFG1 —————— — <USRCFG1 Description>
USRCFG2...24 ————— <USRCFG2...24>
Service — Video Input Video Input - AGC - Format - Format Control

—— Encoder — Enable - PID - Bitrate - Aspect Ratio - Horizontal
Resolution - Chroma - Latency (optimize) - PTS Delay
- GOP Length - GOP Structure
VBI VBI Mode - VBI Quantisation - VBI Endline
- Audio —r—— Audio A — Enable - PID - Source - Bitrate - Compression Format -
Sample Rate - Delay - SDI Channel Pair - Output
Resolution - Channel Format - Language - Error
Protection - Packets/PES - Copyright - MPEG Original
- MPEG Emphasis
L Audio B — Enable - PID - Source - Bitrate - Compression Format -
Sample Rate - Delay - SDI Channel Pair - Output
Resolution - Channel Format - Language - Error
Protection - Packets/PES - Copyright - MPEG Original
- MPEG Emphasis
- Data Sync Enable - PID - Data Rate - Clock Source
- Async — Enable - PID - Baud Rate - Data Width - Parity - Stop
Bits - Fiow Control

L Tables —1——— PIDS —— Video PID - Audio B PID - Audio A PID - User Data B
PID - User Data A PID - PMT PID - PCR PID - Teletext
PID - PGCA PID
L MISC — Table Standard - ATSC Name - Major Channel - Minor

Channel - Program Number (service 1D) - Provider -
SDT Name - Transport Stream ID

NIT Code Rate - Modulation Type - NIT Network Name -
NIT Net ID - Polarity - Satellite Frequency -Satellite
Position - Symbol Rate - Westflag -Carrier Frequency

Output Data Rate Autocalc - Modulator Enable - Modulator
Enable Status - Modulator Type - Carrier Type - Data
Rate -Code Rate - Symbol Rate -Transmit Power -
Rate Control -Carrier Frequency - Spectrum Inversion -

Rolloff
Status Current List
E History List - Clear
Relay List - Clear
Control Serial Baud Rate - Data Bits - Stop Bits - Parity - Flow
Control
Network MAC Address - IP Address - IP Mask - IP Gateway
Data Time Date - Time - UTC Offset
Variant 4:2:2 Chroma Key - 40_140 Frequency Range Key - L-
Band Key - 8PSK Key - 16QAM Key
CA CA Select - PGCA Key - PGCA PID - Add PGCA

Decoder - Delete PGCA Decoder - Authorize PGCA
Decoder - BISS Key - BISS ID

Version Version - SE4000 Serial Number
FP Lock Front Panel Lock - Password
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3.2 Navigating Through the Menus

The front panel LCD display and buttons were designed maximize speed and efficiency of
navigation through the SE4000 menu structure.

3.3 LCD Display

The flowing figure shows a sample SE4000 menu on the front panel:

SE4000/SERVICE/VIDEO/INPUT 2001 >

VIDEO INPUT = SDI

3.4 LCD Symbols

Listed below are the important symbols that appear on the LCD Display:
e Brackets|[]

Arrows (— <)

Asterisk (*)

Equal Sign (=)

Colon ()

3.4.1 Brackets

As the menus, parameters, and options are navigated, the brackets indicate which item is
currently selected.

3.4.2 Arrows

A right arrow will often display on the LCD Display as the SE4000 parameters are navigated.
This arrow indicates that there are additional items available in that parameter list.

3.4.3 Asterisk

While the SE4000 is executing a command or setting a parameter option, an asterisk (*) appears
on the LCD Display, indicating that the SE4000 is processing information. When the asterisk
disappears, the process is complete.

3.4.4 Equal Sign

Most parameters, though not all, can be modified in order to configure the SE4000. Configurable
parameters are followed by an equal sign, denoting that the parameter can be modified.

3.4.5 Colon

There are some parameters that are either automatically set for the system or that are query-only
parameters. A colon follows these type of parameters. When a colon follows a parameter, that
parameter can be viewed but not changed.
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3.5 LCD Text Formats

All menus, parameter options, and system information are displayed on the front panel LCD.

3.5.1 Menus

All menus are displayed in the following format:

SE4000/SERVICE/VIDEO/INPUT 20 >

VIDEO INPUT = SDI

The first line identifies the current menu level. This example shows the Service menu.

The second line identifies the selected menu option.

The 2/7 indicates that you are currently on the second item of seven available choices.
The arrow, when displayed, signifies that there are additional menu options available at
that level.

3.5.2 Parameter Options

All parameter options are displayed in the following format:

SE4000/SERVICE/VIDEO/INPUT 20 >

VIDEO INPUT = [SDI]

The first line identifies the current menu level, in this example, the video input menu.
The second line displays the parameter, Video input. The current setting, SDI, is
surrounded by brackets.

Only one option can be displayed on the LCD at one time. For more options, the Up and
Down buttons would be used to scroll through the list of options.

The equal sign (=) denotes that this parameter can be modified. If this parameter was
followed by a colon (:) the parameter would be view-only.

The arrow indicates that there are additional Video Input parameters.

To move to another parameter, the right and left buttons would be used to scroll through the list of
parameters.

3-4
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3.5.3 Information

Information, such as current faults, faults in the history log, and system messages are displayed
as ASCII text strings as shown in the following example:

SE4000/STATUS/CURRENT 1/3 >

AUDIO ENCODER AUDB SRATE MISMATCH

o The first line identifies the current menu level, in this example, the current faults (status)
menu.

e The second line indicates the current faults, in this example, there are three current
faults.

To view the other current faults, up and down buttons would be used to scroll through the list of
faults.

3.6 Screen Saver

When the SE4000 has detected no front panel activity for more than five minutes, the screen
saver is activated. The screen saver displays the following information for the service currently
being processed.

SE4000 STATUS SUMMARY >

TBD

To exit screen saver mode and return to normal front panel operations, press the Exit button.

A\ CAUTION!!

The Enter button should not be used to exit screen saver mode, as this
button may issue new commands to the SE4000.

The following front panel buttons are used to move through menus in order to issue commands
and view status and fault information:

Right and Left Buttons
Up and Down Buttons
Enter Button

Numeric Keypad

Exit Button

Status Button
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3.7 Right and Left Buttons

The Right and Left buttons are used to scroll through menu items, or through a list of parameters.
These buttons movement through the menu structure in the following manner:

At a menu level these buttons move the selection brackets [ ] and scroll right and left, (forward
and backwards), respectively, through all available menu items at that current level. The
following graphic illustrates how the right button functions at a menu level.

SE4000/STATUS >

[CURRENT] HISTORY RELAY

e To navigate from one menu line to another, use the left and right buttons. For example, to
move from the current to the history menu, press the right button.

SE4000/STATUS >

CURRENT [HISTORY] RELAY

e In a parameter list, the up and down left buttons scroll through the parameter list. When
the last parameter is reached, the SE4000 scrolls through the list again.

SE4000/0UTPUT >

DATARATE AUTOCALCULATION = AUTO

e Using both the up and down buttons enables a parameter list to be scrolled through in
either a forward or backward motion.

e If the required parameter is accidentally scanned past, use the appropriate up or down
button to go back to the required parameter.

e When entering alphanumeric characters, the left button is used to delete characters.

3.8 Enter Button
The Enter button is used to:

e Select the menu item displayed in brackets [ ] on the LCD.
e Issue a command.
e Set a new parameter option.

To select a menu item, use the Left/Right buttons until the brackets encompass the menu item,
then press the Enter button. The Enter button moves you to the selected submenu.

To issue a command, such as the clear history log command, press the Enter button to execute
the command.
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To set a parameter option, such as a new video frame rate, use the Up/Down buttons until the
brackets encompass the option (the option should be flashing) then press the Enter button. The
SE4000 is configured with the new parameter value and the new value is stored in nonvolatile
memory.

3.9 Exit Button
The Exit button moves you through the menu structure in the following manner:
e At a menu level, the Exit button moves you up one menu level.
e In a parameter list, the Exit button moves you up to the previous menu level.
e When selecting a parameter option, the Exit button leaves the parameter without changing
it, and moves up to the previous menu level.
The exit button is also used to exit screen saver mode.

3.10 Up and Down Buttons

Once a parameter is displayed, use the Up and Down buttons to scroll through all available
options until the brackets encompass the required option.

The Up and Down buttons will also increase and decrease the numeric value, if they are pressed
before any keys on the keypad are pressed.

3.11 Alphanumeric Keypad

The alphanumeric keypad is used to enter both alphabetic and numeric parameter values. To
correct any alphanumeric characters, use the left arrow to delete the characters.

3.11.1 Alphabetic Entries

When entering values in an alphanumeric field, the following alphabetic and numeric characters
are displayed when a key is pressed:

Alphabetic Entries

Pins Signal

201

ABC2

DEF3

GHI14

JKL5

MNOG

PQRS7

TUVS

WXYZ9

S|l |loo|N ol wW[IN|~

<space>0 ‘ +
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The first press of a number key displays the first character in the set; sequential presses of the
same key advance through the character set, in a circular fashion. The cursor is advanced by
either pressing another number key, or by pressing the right arrow key. For example: To enter
the word ALL that has two of the same character in a row, the following keys would be pressed:

2 selects A
555 selects L
— advances the cursor so the next letter can be selected

555 selects L

A space can be entered by either a single press of the “0” key, or by two or more presses of the
right cursor key. For example, to enter the words LA Default the following keys would be pressed:

555 selects L

2 selects A

0 selects space

3 selects D

— advances the cursor so the next letter can be selected
33 selects E

— advances the cursor so the next letter can be selected
333 selects F

2 selects A

88 selects U
555 selects L
8 selects T
Enter to issue the command

3.11.2 Numeric Entries

When entering values in numeric field, the required numeric value is simply typed using the
keypad and press Enter.

The default value that is initially displayed disappears upon the first numeric key press. Once a
numeric key is pressed, the Up and Down buttons are nonfunctional; they resume their normal
functions once the Enter or Exit buttons are pressed.

To delete an alphanumeric character, use the left arrow key.

To enter a negative value, press the minus key (-) on the keypad; this toggles the value between
negative and positive.
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3.11.3 Status Button

The Status button is a hot key, which enables immediate viewing of any faults currently occurring
on the SE4000 and then toggling back to the front panel menu on which work was being done.

When leaving the current faults using the Status button hot key, you are
returned to the menu level at which you were working, not to the
parameter level.

3.5 Issuing Commands

To issue a command from the front panel, perform the following steps:

1. Navigate through the menus to the required command or parameter using the navigation
buttons.
2. Change the parameter option as required:

e Scroll through the options using the Up or Down buttons. Ensure that the required
option is selected with the brackets [ ].

e |f the option requires a numeric value to be entered, enter the value using either the
Up and Down buttons to increment the value or the numeric keypad to type in the
value.

[ ]

3. Issue the command by pressing the Enter key. An asterisk will display and then
disappear when the system is finished processing the request. The parameter, with its
updated value, is then displayed in brackets and does not flash.

o |f the Enter button is not pressed, the option is not changed.
o While the SE4000 is setting the parameter to the new value, the front panel is

temporarily disabled.
N
E NOTE

When the SE4000 configuration is changed using the front panel, the
changes are automatically stored in non-volatile memory. The SE4000
automatically restores to the saved configuration whenever the unit is
reset or powered up.
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3.6 Correcting Mistakes

3.6.1 Selecting Options

If an option is selected and the Enter button has not been pressed, use the Up or Down buttons
to scroll to the correct option.

3.6.2 Using the Keypad

If a value is entered via the keypad and the Enter button has not been pressed, the following may
be done:

e Left button to delete the numbers and then enter the correct value.
e Exit button which returns you to the previous menu level.

3.6.3 Leaving a Parameter

If the Enter button has not been pressed, a parameter can be left without modifying it by pressing
either the:

o Exit button which returns you to the previous menu level
o Left or Right buttons which take you to the next parameter

In either situation, the SE4000 will ignore any values entered and return the parameter to its
original setting.

3.6.4 After Pressing the Enter Button

If you accidentally issue an incorrect parameter value to the SE4000, you can correct the error
by:

1. Selecting the correct option using the Up and Down buttons. The parameter will begin to
flash.
2. Pressing the Enter button to set the correct option.

Example: The following example describes how to move through menus and select options. In
this example the SE4000 video will be enabled.

1. From the main menu select Service and press Enter.

SE4000/SERVICE >

[VIDEO] AUDIO DATA TABLES
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2. Select Video.

SE4000/SERVICE/VIDEO >

[INPUT] ENCODER VBI

3. Select encoder. Press the Right button to move the brackets to Encoder. Press Enter.
SE4000/SERVICE/VIDEO/ENCODER 1/3 >
ENABLE = ON
4. The enable menu displays. Use the up and down buttons to select On. Then press enter
to select.
SE4000/SERVICE/VIDEO/ENCODER 1/3 >
ENABLE = ON

3.7 Modulator Control Buttons

The two modulator control buttons, located at the far right of the front panel, affect the power and
form of the output IF transmit carrier from the encoder. Each button has an associated LED
indicator. Only one of the LEDs is illuminated at a time. These buttons cause the output carrier
to be one of the following:

o Off
e Carrier on - full-power CW (constant wave)
e Modulate on - full-power modulated

A blinking LED indicates that the button is busy implementing its command. When the command
is executed the LED stops blinking. Command execution takes 5 to 10 seconds to complete.
Each time you press the button, even if the LED is blinking, the command is executed.

The purpose of the buttons is to allow fast and simple operation of the encoder when a DSNG
operator is coming up on a satellite or taking down a link.
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Pressing the modulator control buttons causes the SE4000 to toggle the modulator as follows:

Current Key Press | Resulting Modulator
Modulator State
State
Off Mod Modulate On
Carrier Off
Carrier On Mod Modulate On
Carrier Off
Modulator On Mod All Off
Off Carrier Modulate Off
Carrier On
Carrier On Carrier All Off
Modulate On Carrier Modulate Off
Carrier On

3.8 Front Panel Menu Summary

The following table lists detailed descriptions of the SE4000 front panel commands. The
commands are organized in the order in which they appear on the front panel. Included are:

Menu level to which the command is attached.

Front panel command.

Command function.

Available options for that command or the response format if the command is query-only.

Front Panel Menu Summary

Command | Function | Options/Response Format

Main Menu - consists of the following submenus:

e QuickSet - used to quickly and easily re-initialize the encoder using predefined factory default
configuration settings or user-defined configuration settings.

e Service - used to setup and configure the video, VBI, audio, data, and PCR services

e  Output - used to configure and monitor the SE4000 internal modulator

e Status — Used to quickly query either the current or status or the fault history log.

e CA - Conditional Access menu is used to setup the SE4000 for conditional access and to create
and modify a list of authorized decoders

e  Control - allows you to configure and manage the SE4000 hardware.

e Version — Displays the Software version number and unit serial number

e FP LOCK — Provides a method of “locking out the front panel to read-only mode.

Main>QuickSet Consists of 24 Quickset choices, which allow quick and easy saving and
Menu recalling of user-defined configurations sets, management of the user-defined
list, and then re-initialize the SE4000 using either the user-defined configuration
sets or predefined factory default configuration settings. These configuration
sets are not altered by reset, power cycling, or factory DVB default setting of the

encoder.
DVB Initializes the SE4000 to the e DVB (default)
factory default configuration e This configurationcan not be modified by the
parameters. user.
Empty 1 - 23 Saves the current site-specific Up to 24 user-defined configuration sets may be
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Front Panel Menu Summary

Command

Function

Options/Response Format

configuration in non-volatile
(flash) memory under the
selected user configuration label.

saved. Configuration sets must be saved to
existing user-defined labels. If there are no user
labels defined, <empty list> is displayed.
User-defined labels are set using the
Config>Quickset>New feature.

Config>Service
#>Video>Input

Used to configure the SE4000 video input section.
Note: for embedded audio, Config>Service # >Video>Input Source must be set to
digital, Config>Service # >Audio must be set to digital, and Config>Service #
>Audio>Source must be set to SDI.

Input Source

Sets the encoder input video
source.

e SDI - Digital

e analog (default)

Note: for embedded audio, Config>Service #
>Video>Input Source must be set to digital;
Config>Service # >Audio must be set to digital, and
Config>Service #> Audio>Source must be set to
SDI.

AGC Sets Analog video AGC on or off | e On (default)
— only available when Analog o Off
input is selected
Format Query-only. Displays the analog | e 525
video format. o 625
e no vi deo if there is no video input
Format Ctrl Sets the video format mode e auto — unit automatically senses incoming video

when the input source is set to
analog.

signal format and configures the video mode to
match (default).

PAL — 625 line PAL-N mode.

NTSC - 525 line NTSC mode.

e NTSC 0SU — no pedestals NTSC 0SU mode.

01-0934-401-E
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Front Panel Menu Summary

Command Function | Options/Response Format
Config>Service Used to configure the SE4000 video encoding parameters.
#>Video>Enco

der
Enable Setting determines whether or e on —video is included in the output transport
not video is included in the stream (default).
output transport stream. e off — video is not include in the output transport
stream.
PID Query only. Displays the video | Default — 33 (21h)

PID number included in the
output transport stream.

Bit Rate Sets the output compressed If chroma set to 4:2:0: 1.0 to 15.0 Mbps
video bit rate for optimum video | if chroma set to 4:2:2: 2.5 to 50.0 Mbps
performance.

e If the Tx Strm>Rate Calc is
set to auto, this command is
query only.
e [f the Tx Strm>Rate Calc is
set to manual, the user sets
the data rate.

Aspect Ratio Sets the picture aspect ratio e 4x3 (default)
which is the ratio of the frame e 16x9
width to the frame height.

Horizontal Selects the picture resizing that | 720, 704, 544, 480, 352
Resolution the SE4000 performs prior to default: 720
video encoding.
Additional Information: As shown in the following table, the number of lines depends
upon whether the video format is set to NTSC or PAL.

Resolution Encoding
OptionNTSC Mode  PAL-l Mode Type
AFF352 352 pixels by 480 lines 352 pixels by 576 lines MPEG - 2
AFF480 480 pixels by 480 lines 480 pixels by 576 lines MPEG -2
AFF544 544 pixels by 480 lines 544 pixels by 576 lines MPEG -2
AFF704 704 pixels by 480 lines 704 pixels by 576 lines MPEG -2
AFF720 720 pixels by 480 lines 720 pixels by 576 lines MPEG -2
(default) (full resolution video)
Chroma Sets the chrominance 4:2:0, 4:2:2 optional

compression algorithm.
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Front Panel Menu Summary

Command Function Options/Response Format
Latency Sets the selected optimization e quality — optimizes the video performance
mode without regard for throughput delay time.
Note: The custom parameter is Quality mode is appropriate for action video
for experienced users only. scenes such as sports material (default).
Changing custom optimization | e low-buffer — compensates for undersized
features requires advanced decoder buffers.
knowledge of MPEG e |ow-delay — reduces the throughput time
compression theory and required to process a signal from the encoder
encoder commands, and, if set input, through the compression process, and to
incorrectly, the video the decoder output. In low delay mode, the
performance maybe adversely overall delay through a SE4000 to an IRD is
affected. It is recommended 180 ms + 40 ms. In low delay mode, the
that users consult with the compressed audio bit rate is automatically set to
Radyne ComStream customer 256 Kbps. Low delay mode is appropriate for
Service Department before real time news interviews.
using the custom e edit — video compression uses only one frame
configuration. (no prediction) which makes it easier to edit the
compressed bit stream. Edit requires a higher
data rate to achieve the video performance of
quality mode.

e custom — allows the user to set site-specific
video compression parameters, such as GOP
structure and VBV size. These parameters
must be initially set through a remote terminal
and then saved using the remote CM SAVE
command. Once saved through a remote
terminal, this custom setup will persist until the
video optimize setting is changed.

The custom parameter is for experienced users
only. Changing custom optimization features
requires advanced knowledge of MPEG
compression theory and encoder commands,
and, if set incorrectly, the video performance
maybe adversely affected. It is recommended
that users consult with the Radyne ComStream
customer Service Department before using a
custom configuration.

PTS Delay Sets the video delay +1000 to —1000 ms adjustable in 1 ms increments
GOP Length Displays the GOP length — in GOP (Group of pictures) variants allow for

custom mode sets the GOP
length

adjustment of encoding parameters to optimize for
various uses. (see the latency settings above).
Custom GOP parameter settings may not work with
all IRDs and may adversely affect Encoder
bandwidth efficiency.

GOP Structure

Displays the GOP Structure — in
custom mode sets the GOP
Structure.

GOP parameters should only be changed by
advanced users in special circumstances.
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Front Panel Menu Summary

Command Function Options/Response Format
Config>Service Used to configure the encoder to transmit teletext data.
# >Video>VBI Note: Teletext should not be enable with other VBI encoding formats, as teletext
overwrites all other VBI data.
Note: For additional information on Teletext, refer to the appendix on VBI Data
Transmission.
VBI Mode Enable and selects the VBI e Off — Disables all VBI functions
functions and format e Tiernan CC - Configures the encoder to transmit
Tiernan closed captioning information. The
Tiernan CC transmission described in this
document is Radyne ComStream proprietary. Only
Tiernan decoders accommodate the Tiernan CC
feature described in this document:
Note: Tiernan CC should not be implemented in
PAL mode, as the closed caption information
will be decoded and placed on line 22 of the
video.
e ATSC CC - Configures the encoder to transmit
ATSC closed captioning information.
e 4:2:2 Expand - Configures the encoder to
transmit either 16 or 32 lines of VBI information
VBI Configures the encoder to e Off — disables expanded windows mode
Quantization transmit either 16 or 32 lines of (default).
VBI information e 16-line — enables 16-line expanded windows
mode.
e 32-line — enables 16-line expanded windows
mode.
VBI Endline Sets the last line of encoded VBI | @« TBD

when 4:2:2 expanded windows is
enabled

Teletext Enable

Configures the encoder to
transmit teletext information.

e off — does not encode any teletext information
(default).

e all — encodes the entire VBI teletext area; i.e.,
allocates bit-rate to include maximum number of
teletext lines.

e auto — automatically allocates bit-rate to include
only the number of detected teletext lines.

Teletext Data ID

Setting determines EBU data
included in the teletext. Values
from 0x10 to 0x1F reflect the
EBU data

0 to 255
Default: 1

Teletext Data
Unit ID

Defines if there are EBU teletext
sub-lines included in the data.

Data Unit ID has range from 0 to 255. Values are:

e 2 = EBU teletext non-subtitle data is not
included (default).

e 3 = EBU teletext subtitle data is included.

Note: Data Unit ID must be set to 2 or 3 for

proper decoder operation.
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Front Panel Menu Summary

Command Function | Options/Response Format
Config>Service | Used to configure the SE4000 audio. Once the audio transmission is selected
# >Audio as Digital or Analog, the audio channel (or slot) to configure is configured.
(A or B) Audio Channels A or B can be configured as either Analog, Digital or
Embedded.

Note: for embedded audio, Config>Service # >Video>Input Source must be set
toSDI; Config>Service # >Audio must be set to digital, and Config>Service #
>Audio>Source must be set to SDI.

Enable Setting determines whether or e on — audio from that channel is included in
not audio is included in the the output transport stream (default).
output transport stream. e off — audio from that channel is not include in
the output transport stream.
default:

o if digital audio: off
e if analog audio: on

PID Query-only; displays the audio Default- Audio A 36 (24h)
PID number included in the Default- Audio B 37 (25h)
output transport stream.

Source Sets the source of the audio. e |[f digital audio: AESEBU, SDI (embedded
audio).

e If analog audio: analog.

Note: for embedded audio, Config>Service #

>Video>Input Source must be set to digital;

Config>Service # >Audio must be set to

digital, and Config>Service # >Audio>Source

must be set to SDI.

Bit Rate Sets the audio compression bit | e If compression set to MPEG or ATSC: 64,
rate 128, 192, 256, 384 Kbps
Additional Information: Selecting | ® If compression set to none: 1 to 4096000 bps
a high audio compressed bit rate | default: 256 Kbps
will produce a high-quality audio
signal at the output audio device;
however, a high audio
compressed bit rate reduces the
total transport stream bit rate
available for the video signal. An
audio compressed bit rate should
be selected that meets the audio
requirements while allowing
sufficient bandwidth to meet the
video requirements.

Compression Sets the output compression MPEG, AC3 2.0, AC3 Pass through,
Format format for the audio stream. uncompressed pass through
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Front Panel Menu Summary

Command Function Options/Response Format
Sample Rate Determines how often the 32,441, 48 kHz
SE4000 samples the analog default: 48 kHz
waveform during the audio
analog to digital conversion
process.
Additional Information: Selecting
a high audio sample rate will
produce a high-quality audio
signal at the output audio device;

however, a high audio sample

rate reduces the total transport

stream bit rate available for the

video signal. An audio sample
rate should be selected that

meets the audio requirements

while allowing sufficient
bandwidth to meet the video
requirements.
Delay Sets the compressed audio bit -300 to 300 milliseconds
stream buffer delay, which default: zero (0) msec
controls the time delay between | e Positive numbers cause the decoder to delay
the audio and video. the audio output with respect to the video (i.e.
lag).

e Negative numbers cause the decoder to
advance the audio output with respect to the
video (i.e. lead).

e Zero (0) represents nominal alignment between
video and audio output from the decoder (i.e. lip
sync). In addition, a zero lip sync value
assumes that the video and audio has lip sync
at the input of the encoder.

SDI Channel Selects one of the eight 1 through 8
Pair embedded audio channel pairs default: 1
associated with the digital audio
input
Note: SDI Audio Chnl Pair is
only available when digital
audio channels are selected.
Output Query-only; displays the number 16-bit, 20-bit, 24-bit
Resolution of bits per audio sample.
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Front Panel Menu Summary

Command

Function

Options/Response Format

Channel Format

Sets the audio compression
format which determines how the
left and right channels of the
audio input source are
compressed.

e Stereo — left and right audio channels are
compressed separately into two output
waveforms. Stereo uses more bandwidth than
mono; however, if the input audio source is
stereo, the stereo effect will appear at the
output audio device.

e Dual Mono — the left and right audio channels
are compressed separately into two output
waveforms. This option uses more bandwidth
than mono, however, use this option when the
left and right audio channel inputs represent
separate and independent audio signals.

e Joint Stereo — the left and right audio channels
are compressed jointly into two output
waveforms. This option uses more bandwidth
than mono but less than the stereo and dual
mono options. Use this option when the left and
right audio channel inputs are highly correlated
(i.e., left and right stereo channels of one audio
program source). The SE4000 uses the
similarities between the two channels to save
bandwidth without losing the stereo effect at the
output audio device.

e Mono — during audio compression the SE4000
ignores the right audio channel input and
produces a single output waveform based on
the left channel input. This option saves
bandwidth; however, if the input audio source is
stereo, the stereo effect at the output audio
device will be lost.

default: stereo

Language

Sets the audio language
descriptor for the selected

English, French, German, ltalian, Japanese,
Korean, Portuguese, Serbian, Spanish, Chinese,

service. Danish, and Dutch.
Error protection On/Off
Packet/PES Read only Default = 1
Copyright On/Off
MPEG original On/Off
MPEG e None
emphasis e CCITTJ.A7
e 50 15 us
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Front Panel Menu Summary
Command Function | Options/Response Format
Main>Service # Used to configure the SE4000 auxiliary data. The Data menu has two data
>Data channels, A and B. Both data channels have identical parameters and options
that are used to configure the auxiliary data ports.
Enable Determines whether or not e on — auxiliary data is included in the output
auxiliary data is included in the transport stream.
output transport stream. e off — disables the port and does not include
auxiliary data in the output transport stream
(default).
PID Query-only, displays the data Default Async data- 42 (2Ah)
PID number included in the Default Sync data — 43 (2Bh)
output transport stream.
Baud Sets the baud rate for the 1200, 2400, 4800, 9600, 19200, 38400 bps
asynchronous auxiliary data default: 38400 bps
channel
Note: Baud is only available
for the Asynchronous data
channel.
Data Width Sets the character length for the 7,8
asynchronous auxiliary data default: 8
channel
Note: Data Bits is only
available for the
Asynchronous data channel.
Parity Sets the parity for the none, even, odd
asynchronous auxiliary data default: none
channel.
Note: Parity is only available
for the Asynchronous data
channel.
Stop Bits Sets the number of stop bits for 1,2
the asynchronous auxiliary data default: 1
channel.
Note: Stop Bits is only available
for the Asynchronous data
channel..
Flow Control Sets the flow control for the None
asynchronous auxiliary data Hard
channel.
Note: Flow Control is only
available for the
Asynchronous data channel..
Data Rate Sets the number of data bits for 1 to 4096000 bps
the synchronous auxiliary data default: 1024000 bps
channel Additional Information: The data rate for the
Note: Data Rate is only auxiliary data channel reduces the total transport
available for the synchronous stream bit rate available for the video signal;
data channel. therefore, an auxiliary data rate should be selected
that meets but does not exceed the site-specific
operational requirements.
3-20
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Front Panel Menu Summary

Command Function Options/Response Format
Clock Source Sets the clock source for the ° internal — uses ST to latch the data
synchronous auxiliary data (default)
channel ° external — uses TT to latch the data

Note: Clock Source is only
available for the synchronous
data channel.

Additional Information: Clock Source allows you to select either an Internal (ST) or an
External (TT) clock to latch the input auxiliary data (SD). There are three different ways
to configure the clock sources for the SE4000 and a DTE. The following table lists
these different configurations along with the circumstances under which each is used.

n The first option will produce the most reliable auxiliary data.

n You should use the last option only if you are unable to configure your DTE for
either of the first two options.

Circumstance For Use SE4000 Data SE4000 Clock DTE Clock DTE Clock
Clock Source Used to Source Sent to

Configuration Latch Data Configuration SE4000on TT

Option 1: DTE is able to Internal TT External ST

turn around ST and provide

ST back to the SE4000

as TT.

Option 2: DTE is not able to External TT Internal Internal
turn around ST, but has an

internal clock that can be

provided to the SE4000

as TT.

Option 3: DTE is not able to Internal ST External None
turn around ST and does

not have an internal clock

to provide to the SE4000

as TT.

For more information on configuring the auxiliary data channel clock source, refer to the
chapter on installing the SE4000.

Config>Service Used to set the program clock reference parameters.
# >Tables

PIDS Query-only, displays the PID
number.

Video
Audio A
Audio B
Async Data
Sync Data
PMT

PCR

MISC Query-only, displays table
parameters

Table Standard (DVB or None)
Program Number

Provider

SDT Name

TX Stream ID

Code RateVideo
Mod Type
Network Name
Network ID
Polarity

Sat Freq

Sat Pos

Sym Rate
Westflag

NIT Query-only, displays the NIT
table parameters.

01-0934-401-E 3-21



Using the Front Panel

SE4000 MPEG-2 Contribution Encoder

Front Panel Menu Summary

Command

Function Options/Response Format

Config>Output

Used to configure and monitor the SE4000 internal modulator and the ASI transport
stream output. When the initial SE4000 installation and configuration is begun, the
modulator output (Mod State) should be turned off until ready to begin satellite
transmissions.

Data Rate Auto

Controls video bit rate calculation | e Auto — Video bit rate is automatically set to the

Calc algorithm maximum rate available (default)
e Manual — Video bit rate is manually set under the
video menu.
Modulator Setting enables or disables the | e On - modulator is enabled (default)
Enable internal modulator. e Off - modulator is disabled.
Modulator Displays the present enable e On - modulator is enabled (default)
[ ]

Enable Status

status Off - modulator is disabled.

Note: The modulator may be set
Enabled, but automatically

disabled due to a fault condition

or a rate mismatch.

Modulation Type Sets the modulation scheme. e QPSK (default)
e 8PSK (optional)
e 16QAM (optional)
Carrier Type Sets the modulation poutput into | ¢ Norm (default)
pure carrier mode e CW — Pure carrier mode
Data Rate Sets the data rate for the output | e If modulator is disabled: 1 to 80 Mbps default:
transport stream or the 8.448 Mbps.
modulator data rate. e If modulator is enabled: 1 to 80 Mbps (to 30 Msps).
Additional Information: The data rate that is entered using this parameter determines the
transport output of the SE4000 when the modulator is enabled.
Code Rate Sets the code rate for forward 1/2, 213, 3/4, 5/6, 7/8
error correction (FEC) of the default: 5/6
modulated signal.
Additional Information: The rate selected indicates the number of error correcting bits that
will be added to the data stream. For example, if you select the 5/6 rate, for every 5 bits
that are input to the FEC encoder, the FEC encoder outputs 6 bits.
The relationship between the selected code rate and the data stream prior to modulation,
and an indication of the degree of error correction provided by each code rate is shown
below.
Viterbi Code Rate Transport Stream Data Rate Error Correction
1/2Increases by a factor of 2 (100% increase)Maximum
2/3Increases by a factor of 1.5 (50% increase)Very High
3/4Increases by a factor of 1.33 (33% increase)High
5/6Increases by a factor of 1.2 (20% increase)Moderate
7/8Increases by a factor of 1.14 (14% increase)Low
Sym Rate Sets the current transmission SymRate
symbol rate sets the current transmission symbol rate
1.0 to 20.0 Msps
default: 5.500187 Msps
Additional Information: The symbol rate is the number of symbols required to transmit the
data stream over a satellite link using quadrature phase shift keying (QPSK).
The symbol rate is automatically calculated based on the modulator input transport stream
data rate, the Viterbi code rate, and other fixed parameters that add overhead to the data
stream.
If the displayed symbol rate exceeds the allowable satellite bandwidth, the data will be
corrupted during transmission.
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Front Panel Menu Summary

Command Function Options/Response Format
Modulation Sets the output transmit power of -25.0 to -5.0 dBm
Power the SE4000 modulator. default: -5.0 dBm

Rate Control

Sets whether the modulator
output is calculated based on
data rate or symbol rate.

Auto — Either Data Rate or Symbol Rate may be
entered — the other parameter is automatically
calculated.

Symbol Rate — Symbol rate in entered — Data Rate
is calculated and is read only.

Data Rate — Data rate in entered — Symbol Rate is
calculated and is read only.

Carrier Freq

Sets the modulator carrier
frequency.

52.0 to 88.0 MHz, 104 to 176 MHz, 950 to 2050 MHz.

default: 70.0 MHz

Additional Information: The acceptable frequency range is implemented with a band pass
filter that filters out all frequencies below 52000000 Hz and above 88000000 Hz (similar
for 140 MHz range and L-Band).

When selecting a carrier frequency, take into account the satellite bandwidth required for
transmission. If a carrier frequency is selected is too close to either end of the valid range,
the modulated carrier may be clipped by the pass band filter. For information on
calculating the satellite bandwidth, refer to the Main>Output>Sym Rate parameter.

Spectrum
Inversion

Used to instruct the modulator to
invert, or not invert, the
modulated IF output spectrum.
Inverting the IF output spectrum
eliminates spectral inversion in
the RF chain caused by selecting
lower side-band images of an
upconverted carrier.

normal — modulated IF output is not inverted
(default)
inverted — modulator inverts the IF output spectrum

Rolloff

Sets the baseband filter rolloff
factor of the internal modulator.
This parameter must match the

demodulator filter rolloff

.35 (default) normally used for DVB compliant
demodulators

.20

.25

ASI Packet Size

Sets the ASI output.

188 byte packet
204 byte packet
204 byte packet with Reed-Solomon encoding

Main>Status

Current

Lists the current faults

Current faults are those presently faulted

History

Contains a log of historical faults

LIST - Due to memory limitations, the first 50 faults
occurring after a clear are saved along with the last
50 faults that have occurred

Clear — Completely clears the fault log. Erases all
fault history. Note: Does not clear fault relay.

Relay

Controls and displays the fault
relay status

Clear — Completely clears the fault log. Erases all
fault history.

01-0934-401-E

3-23




Using the Front Panel

SE4000 MPEG-2 Contribution Encoder

Front Panel Menu Summary

Command Function | Options/Response Format
Control>Serial Used to configure the remote control port.
Baud Rate Sets the asynchronous interface 1200, 2400, 4800, 9600, 19200, 38400 bps
baud rate for the remote port. default: 38400 bps
Data Bits Sets the number of data bits for 7,8
the remote port. default: 8
Stop Bits Sets the number of stop bits for 1,2
the remote control port. default: 1
Parity none, even, odd
default: none
Flow Control Sets the remote control port flow o soft: software XON/XOFF (default)

control.

e hard: hardware RTS/CTS

Control>Netwo

set to enter the

network address of the SE4000.

rk
MAC address Query-only, displays the SE4000 text string
network address.
IP Address Sets the IP address. user defined
default: 0.0.0.0
IP Mask Query-only, displays the IP text string
mask. default: 225.225.0.0
This parameter can be set using
a remote terminal and the
appropriate remote command.
Gateway Query-only, displays the IP text string

router address.
This parameter can be set using
a remote terminal and the
appropriate remote command.

default: 0.0.0.0

ControlClock> Used to set the date and time.
DateTime
Date Sets the date. dd/mm/yyyy
If the date is entered incorrectly, default: 00.00.0000
or an out-of-range value is
entered, the SE4000 will display
and continue to use the
previously set date.
Time Sets the time hh.mm.ss

The hours are in a 24-hour
format and must be set from 00
to 23, where 00 is midnight and
23 is 11 PM. Both minutes and
seconds can be set from 00 to

59.

default: 00:00:00

Control>Varian
t

Used to enter software keys to allow for field upgrades (for example — 4:2:2,
8PSK, and 16QAM are currently available as key driven field upgrades via front

panel key entry).

° 4:2:2 Chroma Key

° 40_140 freq. Range Key
° L band Key

° 8PSK Key

° 16QAM Key

3-24
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Command

Function | Options/Response Format

Main>CA menu

Conditional access (CA) is a method for securing and scrambling transmission
streams so that only those decoders which are authorized to do so can receive
the transmitted streams. The SE4000 provides two methods for conditional
access:

e BISS - Basic Interoperable Scrambling System, an industry-standard,
conditional access scheme used to secure and scramble DSNG broadcasts
while allowing full operability between various vendor’s DSNG equipment.

e PGCA - a Tiernan-proprietary conditional access scheme used to secure and
scramble transmission streams within the Tiernan family of products.

Note: For additional information on BISS or PGCA configuration, refer to the

appendix on Conditional Access.

Config>CA>Set Allows selection of the following: a service, the type of conditional access
up scrambling method to be enabled, and to define the conditional access key.
Service Displays the individual services -
that can be enabled or disabled
for conditional access.
If only one service is available,
the service parameter is query-
only, as this one service is
automatically selected.
Config>CA>Set Used to set the type of conditional access scrambling method for a selected
up>Service>Sc service and to define the conditional access key.
ramble
None No scrambling is enabled.
PGCA Enables and disables PGCA ata | ¢ PGCA key — sets the PGCA scrambling key to a

system level. When selected,
this setting ensures that only
those Tiernan decoders listed in
the PGCA database and enabled
at an individual level can receive
the broadcast signals.
Non-Tiernan IRDs cannot be
authorized by PGCA; therefore
only authorized Tiernan IRDs
can decode a service that has
been protected through PGCA.

specified algorithmic table. Parameters are 0 to
255.

e PGCA message PID — Query-only, displays the
PID for the program map table (PMT).

BISS Mode 1 Enables BISS Mode 1 for the BISS key: sets the BISS scrambling key, which is a
selected service. With BISS 12-digit scrambling key, for the selected service.
Mode 1, all components of the
transmission stream are
scrambled by a fixed control
word (CW).
Main>CA> The three PGCA configuration menus allow modification of the PGCA database,
PGCAcfg enable and disable individual Tiernan IRDs for PGCA, and review the PGCA
database.
For additional information on adding, deleting and authorizing individual
decoders, refer to the appendix on Conditional Access.
Add IRD Adds a Tiernan decoder to the To determine the Tiernan decoder’s MAC address,
PGCA database. refer to the appropriate Tiernan user guide which
Note: Non-Tiernan IRDs accompanied that product.
cannot be added to the
decoder database.
Lst IRD Used to enable and disable Displays a list of all Tiernan decoders entered in

the PGCA database. Each decoder's MAC
address, and its enabled/disabled status is also
displayed.
To enable and disable an IRD, use the minus key
on the alphanumeric keypad to toggle between the

individual IRDs for conditional
access.
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Command Function Options/Response Format
On (enable) and Off (disable) parameters for the
selected IRD.
Del IRD Deletes a Tiernan decoder from Displays a list of Tiernan decoders and their MAC
the conditional access database. addresses.
Front Panel Menu Summary
Command Function | Options/Response Format
Version Menu Used to display the version of firmware and hardware currently in use on the
SE4000.
Version Queries the version of firmware Firmware version labels.
currently in use on the SE4000.
Control>FP Used to lock and unlock the front panel.
Lock
State Sets the state of the front panel. e |ocked — disables the front panel; the front panel
can only be used to view status and
configuration parameters.

e unlocked — the front panel is unlocked and can
be used to enter and change configuration
parameters (default).

Password Unlocks the front panel. Used in | 7384 (default)

conjunction with the state
command; password is only
displayed when the front panel is
set to locked.

Note: ensure that the front panel displays 7384,
not alphabetic characters when using the
default password to unlock the front panel.
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3.9 SE4000 Procedures

This section provides detailed steps for performing various SE4000 tasks.

Before beginning initial SE4000 installation and configuration, the
modulator output (Mod State) should be turned off until ready to begin
satellite transmissions.

3.10 Configuration Sets

3.10.1 Restoring a Default Factory Configuration

To restore a default configuration and set the table types:

1. From the main menu, select Config. The Configuration menu appears.

2. Select Presets. The Preset menu displays.

3. Select Restore. The Restore menu displays.

4, Use the Up or Down buttons to select the appropriate option and press Enter. The

system will perform its initialization process and reconfigure the SE4000 with the selected

parameters.

The reconfiguration process may take up to two minutes. When the system has
completed its configuration process, the LCD returns to the main menu.

The operating parameters in use at the time the restore process is
executed are overwritten and will be lost if not previously saved as a
configuration set.
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3.10.2 Creating a New User Configuration

To create a new user-defined configuration label:

1.

2.

Select Config from the main menu. The Configuration menu displays.
Select Presets. The Preset menu appears.

Select New. The New Preset menu and its option Enter Name = 0 displays. The zero
is replaced with the first alphanumeric key press.

Using the alphanumeric keypad, enter a name for the configuration set. The name can
be up to 15 characters in length. For alphanumeric characters, use numbers similar to a
standard phone keypad. For example, to enter a “B”, press the 2 button until a B is
displayed, then the right shift button.

Press Enter. The new level is added to the configuration list and the system returns to
the Presets menu.

To save a configuration set under this label, follow the steps under Saving a User
Configuration Under an Existing Label.

The configuration process may take a minute. When the system has completed its
configuration process, the LCD returns to the ATM Access DVB MPEG-2 Contribution
Encoder menu.

3.10.3 Saving a User Configuration Under an Existing Label

To save a user-defined configuration set under an existing label:

1.

Configure the SE4000 with the required parameters.

2. Once all the parameters are correctly set, select Config from the main menu. The
Configuration menu displays.
3. Select Presets. The Preset menu displays.
4. Select Save. The Save menu displays.
5. Use the Up or Down buttons to scroll through the list and select the correct configuration
label.
6. Press Enter. The Configuration process may take up to two minutes. When the system
has completed its configuration process, the asterisk will disappear.
% O
The operating parameters in use at the time the restore process is
executed are overwritten and will be lost if not previously saved as a
configuration set.
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3.10.4 Deleting a User Configuration Label

To delete a user-defined configuration set:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Presets. The Preset menu displays.

3. Select Delete. The Delete menu displays.

4. Scroll through the list and select the label that will be deleted.

5. Press Enter. The label is deleted from the configuration list and the system returns to the

Presets menu.

3.10.5 Renaming a User Configuration Label

To rename a user-defined configuration set:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Presets. The Preset menu displays.

3. Select Rename. The Rename menu displays.

4, Scroll through the list and select the label that will be renamed.

5. Press Enter. The name of the label to be renamed displays and a zero appears in the

label entry field.

6. Using the alphanumeric keypad, enter a name for the configuration set. The name can
be up to 15 characters in length.

7. Press Enter. The new label is added to the configuration list and the system returns to
the Rename menu.

3.11 Front Panel Lock/Unlock
3.11.1 Locking the Front Panel

To lock the front panel:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Control. The Control menu displays.

3. Select FP Lock. The status St at e = Unl ocked displays.

4, Press the Up button once. St at e = Locked displays.

5. Press Enter. St at e = Locked displays indicating that the front panel is now locked.
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3.11.2 Unlocking the Front Panel

To unlock the front panel:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Control. The Control menu displays.

3. Select FP Lock. The status St at e = Locked displays.

4, Press the Left or Right button once. Password = 0 displays.

5. Using the front panel keypad, type in the password and press Enter. The default
password is 7384.

6. The front panel displays St at e = Unl ocked indicating that the front panel is now
unlocked.

If the wrong password is entered, the SE4000 displays Password = 0. If
this occurs, use the front panel keypad to type in the correct password
and press Enter.

3.12 Date and Time
3.12.1 Setting the Date

To set the date:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Control. The Control menu displays.

3. Select Clock. The Date parameter displays.

4, Use the keypad to type in the correct date in the format nmf dd/ yyyy. The SE4000

automatically enters the “/”.
5. Press the Enter button.

If the date is entered incorrectly, or an out-of-range value is entered, the SE4000 will display and
continue to use the previously set date.
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3.12.2 Setting the Time

The time is in a 24-hour format and must be set from 00 to 23, where 00 is midnight and 23 is 11
PM. For example, for 8 AM the hours would be set to 08, and for 8 PM the hours would be set to
20. Both minutes and seconds can be set from 00 to 59. To set the time:

1. From the main menu, select Config. The Configuration menu displays.

2. Select Control. The Control menu displays.

3. Select Clock. The Date parameter displays.

4. Scroll to the Time parameter using the right or left buttons.

5. Use the keypad to type in the correct hour, minutes, and seconds in the format

hh: mm ss. The SE4000 automatically enters the colons “”.
6. Press the Enter button.
3.13 System Reset

To reset the SE4000:

1. From the main menu, select Config. The Configuration menu displays.
2. Select Control. The Control menu displays.

3. Select Reset.

4. Press the Enter key.

The SE4000 is reset to the last configuration set; all programmable logic and firmware is
reloaded; the unit is restarted; and the fault history log is cleared.

3.14 Embedded Audio Configuration
3.14.1 Configuring the Encoder for Embedded Audio

To configure the encoder for embedded audio, the following parameters must be set:
o Config>Service # >Video>Input Source must be set to digital

e Config>Service # >Audio must be set to digital
e Config>Service # >Audio>Source must be set to D1

3.15 Embedded Audio Configuration (BISS/PGCA)

For information on configuring the SE4000 for BISS or PGCA conditional access, refer to the
appendix on conditional access.

3.16 VBI: Teletext, Closed Captions, and Expanded Windows

For information on configuring the SE4000 for teletext, closed captions, or expanded windows
VBI operations, refer to the appendix on VBI data transmission.
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Using a Remote Unit

In addition to the front panel, a remote unit can be used to configure and monitor the SE4000.
The chapter presents the following information for remote command operation:

Configuring remote software parameters
An overview of remote communications
Instructions for issuing remote commands
Error messages

Remote command listing

For remote cabling information, refer to the chapter on installation.

Any parameter changes made using a remote unit are not automatically
stored in non-volatile memory. When the SE4000 configuration is
changed using a remote unit, an operational test should be performed to
verify that the system is operating correctly. The new configuration
should then be saved by issuing the CM SAVE command.

If the SE4000 is reset prior to issuing the CM SAVE command, any
changes made using the remote unit will not be restored.

4.0 Configuring the Remote Control Software Parameters

After the remote unit is cabled to the SE4000, perform the following steps to complete the
installation:

1. Configure the communications software parameters of your remote unit to match the
following SE4000 remote port factory default settings:

RS-232 signal

Baud rate = 38400 bps
Character length = 8
Parity = none

Number of stop bits = 1
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Unless the remote settings are changed and the changes saved in non-volatile (flash) memory,
the SE4000 restores these default communications settings whenever the SE4000 is reset or
powered-up.

2. Press the Enter key on the remote keyboard several times to generate a prompt (>) on
the remote display. Once a prompt appears on the remote display, successful
communication has been established between the SE4000 and the remote unit.

Once communications are established, the remote port parameters can be changed to a
faster operating speed.

If a prompt cannot be generated on the remote unit, follow these troubleshooting steps:

e Ensure that the remote unit and the SE4000 are turned on and plugged into an active
AC outlet.

o Verify that the baud rate and parity of the remote unit communications package
match the default factory setting of the SE4000 remote interface. Factory settings are
38400 baud, 8 data, no parity.

o Verify that the cable between the terminal, the SE4000, and the Null Modem Adapter
are properly connected.

o Ensure that the DTE/DCE switch is set to the DTE position.

For assistance, contact the Radyne ComStream Customer Support Department.
4.1 Ethernet Port Telnet

After the SE4000 has been cabled to a network through the SE4000 Ethernet port, perform the
following steps to establish remote communications using Windows Telnet:

More sophisticated applications are available that allow you to view
commands and responses more easily.

1. From a remote unit, launch Telnet by typing TELNET at the command prompt.
To access the command prompt, select the MS-DOS Prompt.

2. From the Connect menu, select Remote System. The Remote System dialog box
appears.

3. At the Host Name or IP Address option, type the SE4000 IP address. For the procedure
used to assign an IP Address, refer to the installation chapter.

4. For Port Type enter 21846 or 0x5556 (hex).

5. For Terminal Type, accept the default.
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6. Click the Connect button. There should now be connection.
7. If connection is not successful, troubleshoot the installation and setup:

e Ensure that the SE4000 is turned on and plugged into an active AC outlet.
o Verify that the cable between the terminal and the SE4000 is properly connected.
o In Telnet, verify that the correct IP address and port type have been selected.

e Check with the Information Systems to determine if problems exist with the LAN.

For assistance, contact the Radyne ComStream Customer Support Department.

4.1 Ethernet Port Browser Window

The SE4000 contains an easy to use Browser configuration web-like interface. To configure the
SE4000 through the browser interface, follow the instructions below.

1. From the front panel, configure the IP address to an unused address on your local
network. Directions for setting the IP address can be found in the front panel section of
this manual. See your IT department for more information if your are not sure of an
available address.

2. Connect the Etherent port of the SE4000 to a hub or switch on your local network.

3. Open your Web browser on any networked PC. Enter the IP address of the SE4000
where the Web address normally would be. The SE4000 browser interface screen should
appear.

4.2 Remote Communications Overview

The SE4000 can be configured, monitored, and controlled from a remote unit. Unlike front panel
operations, the remote unit has no selection menus; instead, the remote terminal is used to type
specific commands and parameters to communicate with the SE4000.

All SE4000 commands can be issued from a remote unit that is connected to the SE4000 remote
port. The remote unit can be any remote unit capable of asynchronous communications,
including a personal computer or ASCII terminal.

4.2.1 Command Types
The remote unit accepts two different types of commands:

e Execute commands direct the SE4000 to perform a specified action, such as changing a
configuration parameter.

e Query commands direct the SE4000 to display the current setting of a specific parameter
or to display current status information.
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4.2.2 Command Elements

All commands consists of a command mnemonic, which is followed by a space, and the
command instruction.

mnemonic instruction
- e—_——

Command = {
MC BAUD

The SE4000 uses the following command mnemonics to group various commands:
e TBD

Execute commands have an additional parameter which follows the command instruction.

mnemonic instruction parameter

Command = { v v v 1
MC BAUD 1200

4.3 Issuing Remote Commands

To issue a command from a remote unit, type the command at the remote prompt (>) with the
appropriate parameter, and then press the ENTER key. The following syntax is used:

<command> <parameter>
where:

e <command> consists of its mnemonic and the instruction; ensure that the command is
typed correctly and includes spaces and underscore (_) and period (.) characters as
appropriate

e There must be one space between the command and the parameter. A space is typed by
pressing the Space Bar key.

e <paranet er > is the value pertaining to the command. Parameters can be numeric or
alphanumeric. No spaces should be typed after the parameter; doing so will result in an
error.

The SE4000 performs the required function and displays the prompt (>) when it is ready to accept
another command.

For example, to set the remote port baud rate to 1200 bps, issue the command MC BAUD 1200
and press Enter. In this example:

e The command mnemonic is MC followed by a space
e The command instruction is BAUD followed by a space
e The parameteris 1200.
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Query commands are issued by typing the command, without a parameter, and pressing Enter.
The SE4000 responds to the query by displaying information on the remote display.

For example, to query the remote port baud rate, issue the command
Enter. In this example:

MC BAUD and press

e The command mnemonic is MC followed by a space

e The command instruction is BAUD followed by a space

e There is no parameter since this is a query command
The SE4000 responds by displaying the baud rate on the remote unit.
4.3.1 Typing Remote Commands

Remote commands are not case sensitive. Commands may be entered in lower case, upper
case, or a combination of both.

4.3.2 Entering Parameter Values

Some command parameters must be enter as a numeric value, which is represented by the
pound sign <#>. If more than one pound sign is shown for a given parameter <###>, a number
must be entered for each pound sign. When a command is issued containing a numeric value,
do not type in the (#) nor the bracket <> signs. Enter only the numerical value for the parameter.

4.4 Error Messages

If the SE4000 is not able to execute a command, an error message will be returned, indicating the
command was not completed. SE4000 error messages, along with the action required to resolve

the error, are listed in the following table.

Error Messages

Error Message

Explanation

Action Required

ERROR:AMBIGUOUS_LOCAL _
INSTANCE

A designator, other than a slot
designator, is required in order to
set or query the command.

For example, all audio
commands require a port
designator in order to correctly
process a command.

Issue the command using the
correct syntax, format, and
parameter.

Ensure that the appropriate
designators are included in the
command string.

ERROR:AMBIGUOUS_ SLOT

A slot designator is required in
order to set or query the
command.

For example, all audio and
auxiliary data commands require
a slot designator.

Issue the command using the
correct syntax, format, and
parameter.

Ensure that the appropriate
designators are included in the
command string.

ERROR:BAD_NUMBER_FORM
AT

The parameter number format is
incorrect.

For example, a hexadecimal
value was entered when a
decimal value is required.

Issue the command using the
correct parameter format.

ERROR:BAD_RC_INSTANCE

The command mnemonic cannot
be matched to a card installed in
the product..

Use the ‘?” command to view the
current card types.

Issue the command using the
proper syntax and format.

ERROR:BAD_RESOURCE_
CONTROLLER_TYPE.

The command mnemonic is
incorrect..

Use the ‘?” command to view the
current command mnemonics.
Issue the command using the
proper syntax and format.
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ERROR:COMMIT_ERROR

While attempting to set a
command, the SE4000 may have
entered an inconsistent state and
may have an integrity error.

Reset the command to a known
valid state. Then re-issue the new
command. If the command still
results in an error message, check
the configuration of the unit and
repeat the command.

If the SE4000 still does not execute
the command, reset the unit and
attempt the command again.

If the command cannot be
executed, contact the Radyne
ComStream Customer Service
Department.

ERROR:CONFIGURABLE_NOT
_QUERYABLE

The command cannot be
queried. The command may be
set-only or an action.

Review the lists of commands to
ensure that a valid command was
issued.

ERROR:CONFIGURABLE_NOT
_SETTABLE

The command cannot be set.
The command may be query-
only.

Review the lists of commands to
ensure that a valid command was
issued.

ERROR:EXPECTED_END_OF_
LINE

The command line contains too
much information.

The command may have been
issued with extra characters or a
space after the parameter.

Issue the command using the
correct syntax, format, and
parameter.

ERROR:INVALID_MNEMONIC

The issued command does not
match any valid SE4000
command.

The command may have been
issued with extra characters, a
missing underscore, a missing
space, a space after the
parameter, or in an improper
order.

Issue the command using the
proper syntax and format.

ERROR:INVALID_VALUE

The SE4000 rejected a request
to change a configurable value
based upon its own logic.

This value is also returned to
indicate that the change was
attempted, detected to be in
error, and then successfully
reversed (this response is only
valid if the attribute “Valid Values
Depend on State” or equivalent
flag is set).

Issue the command using the
correct parameter.

ERROR:STRING_TOO_LONG

The parameter’s length has been
exceeded.

Issue the command using the
correct parameter.

ERROR:TOO_LARGE

The parameter’s numeric value is
too large.

Issue the command using the
correct parameter.

ERROR:TOO_SMALL

The parameter’s numeric value is
too small.

Issue the command using the
correct parameter.

In addition to the actions listed in the error messages table, you can also enter the following
question mark (?) commands to receive additional information when errors are encountered or

additional information is needed

Remote Question Mark (?) Commands

Response

?

Lists all available command mnemonics associated with the
current version of code installed on the SE4000.

<mnemonic>.<designator> ?

Lists all commands associated with that mnemonic.
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For example: AE.A?

<mnemonic>.<designators> <instruction> ? | Lists information available for that particular command,
For example: AE.A BRP? including all valid parameters.

4.5 Remote Command Descriptions

All standard SE4000 remote commands are listed in alphabetical order in the following tables,
which provide the following information:

e Remote commands and any command designators
e Parameter values or value range
e Factory default value

Description of the command, including parameter definitions, the front panel command
equivalent, and the SNMP command equivalent

Command designators and parameter values may be shown within
brackets < >; these brackets are not typed when issuing commands.

SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
AE.<port> BR 64, 80, 96, 256 Kbps | Sets the audio compressed bit rate.
112, 128, 160, Note: Selecting a high audio compressed bit
<port>is A or B 192, 224, 256, rate will produce a high-quality audio signal
320, 384 Kbps at the output audio device; however, a high

audio compressed bit rate reduces the total
transport stream bit rate available for the
video signal. Select an audio compressed bit
rate that meets the audio requirements while
allowing sufficient bandwidth to meet the
video requirements.

Front panel command equivalent:
Main>Service>Audio>Data Rate

01-0934-401-E 4-7
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
AE.<port> CHFMT Dual, Mono, Stereo Compressed audio format ; determines how the
Stereo, Jstereo SE4000 will compress the audio channels.

e Dual — left and right audio channels are
compressed separately into two output
waveforms. Use dual when the left and right
audio channel inputs represent separate and
independent audio signals.

e Mono — during audio compression the right
audio channel input is ignored and a single
output waveform is produced based on the left
channel input. Mono uses half the bit rate of
dual; however, if the input audio source is
stereo, the stereo effect at the output audio
device will be lost.

e Stereo — left and right audio channels are
compressed separately into two output
waveforms. Stereo uses more bandwidth than
mono; however, if the input audio source is
stereo, the stereo effect will appear at the
output audio device.

e Jstereo — the left and right audio channels are
compressed jointly into two output waveforms.
Jstereo uses more bandwidth than mono but
less than stereo and dual. Use Jstereo when
the left and right audio channel inputs are
highly correlated (i.e., left and right stereo
channels of one audio program source). The
similarities between the two channels are
used, saving bandwidth without losing the
stereo effect at the output device.

Front panel command equivalent:
Config>Service>Audio>Format

AE.<port> MPEG2, AC3, MPEG2 Sets the output compression format for the audio
COMPRESS AC3PASS, stream.
UNCOMP Front panel command equivalent:
Config>Service>Audio>Compression
AE.<port> 1t0o 8 1 Selects one of the eight embedded audio channel
SDI_CH_PAIR pairs associated with the digital audio input

Note: SDI Audio Chnl Pair is only available
when digital audio channels are selected.
Front panel command equivalent:
Config>Service>Audio>SDI Audio Chnl Pair
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
AE.<port> DELAY -1000 to +1000 0 (zero) Compressed audio stream time delay; enter a
msec. numeric value to adjust the audio presentation time
stamp; affects the synchronization between the
audio and video.
Positive numbers cause the decoder to delay the
audio output with respect to the video (i.e. lag).
Negative numbers cause the decoder to advance
the audio output with respect to the video (i.e.
lead). Zero (0) represents nominal alignment
between video and audio output from the decoder
(i.e. lip sync). In addition, a zero value assumes
that the video and audio has lip sync at the input of
the encoder.
Note: Depending on bit rate and delay set, it
may be possible to set delay to inoperable
values.
Front panel command equivalent:
Config>Service>Audio>Delay
AE.<port> ENABLE Off, On If digital Enables or disables the audio channel in the
audio: Off | transport stream. Parameters are:
If analog e Off = audio is not included in the transport
audio: On stream
e On = audio is included in the transport stream.
Front panel command equivalent:
Config>Service>Audio>Enable
AE.<port> ENG, JPN, ENG Sets the audio language descriptor for a selected
LANGUAGE CHI, KOR, audio channel. Parameters are:
DAN, POR, e ENG (English) e JPN (Japanese)
DUT, RUS, e CHI (Chinese) e KOR (Korean)
GER, SPA, e DAN (Danish) e POR (Portuguese)
ITA, FRE, e DUT (Dutch) e RUS (Russian)
UND e GER (German) o SPA (Spanish)
e ITA (ltalian) o FRE (French)
e UND (undetermined)
Front panel command equivalent:
Config>Service>Audio>Language
AE.<port> SRATE 32,441, 48 48 Ksps Audio sample rate: determines how often the
Ksps SE4000 samples the analog waveform during the
audio analog to digital conversion process.
This command is query-only for digital audio input
ports; it is both set and query for analog audio input
ports.
Front panel command equivalent:
Config>Service>Audio>Sample Rate
AE.<port> SRC Analog, SDI, AESEBU
AESEBU
AE.<port> OUTRES 20-bit, 24-bit Read- Only available In Digital input mode, this is a read-
only only parameter.
AE.<port> ON/OFF ON Error protection
ER_PROTECT
AE.<port> ON/OFF ON Copyright flag in stream
COPYRIGHT
AE.<port> ORIG ON/OFF ON MPEG original flag set in stream
AE.<port> MPEG None, NONE MPEG emphasis
_EMPH 50_15_us,
CCITTJ.17

01-0934-401-E
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
AE.<port> user_ext ON/OFF OFF User extensive processing enabled or disabled
AE.<port> 1-14 1 Some decoders require more than one audio
PES_BLOCKS packet per PES packet. This is provided as an
interoperability mode. Normally no used.
All AC3 parameters
are only valid and
settable in AC3
compression mode
or AC3 pass-through
mode
AE.<port> CM, ME, VI, CM AC3 Bitstream descriptor
AC3BSTRM HI,D,C,E,VO CM= Complet Main
ME = Music Effects
VI = Visually Impaired
HI = Hearing Impaired
D = Dialogue
C = Commentary
E = Emergency
VO = Voice Over
AE.<port> AC3COD 1/0, 2/0 2/0 AC3 Coding type
AE.<port> NOTIND, NOTIND | Ac3 Surround descriptor
AC3SURR NOTSUR, NOTIND = Not Indicated
SUR NOTSUR = Not Surround
SUR = Surround
AE.<port> AC3INFO OFF,ON OFF
AE.<port> -1--31 -27 AC3 Normalization level
AC3NORM
AE.<port> FILMSTD, FILMSTD | FILMSTD = Film Standard
AC3PRES FILMLIGHT, FILMLIGHT = Film Light
MUSSTD, MUSSTD = Music Standard
MUSLGHT, MUSLGHT = Music Light
SPEECH SPEECH
AE.<port> 0-31 25 AC3 Mixing Level
AC3mixlev
AE.<port> NI, SM, LG SM AC3 Room size descriptor
AC3ROOM
AE.<port> ON, OFF ON AC3 DC Filter enable
AC3DCFIL
AE.<port> AC3LPFIL ON, OFF ON AC3 Low Pass Filter enable
AE.<port> ON, OFF OFF AC3 Protection Filter enable
AC3PRFIL
AE.<port> 32, 16L, 16R 32 AC3 Pass- through Bit mode
AC3BMOD 32 bit
16 bit left
16bit right
AE.<port> 0-7 0 AC3 Stream Number
AC3STRMN
AE.<port> ON, OFF ON AC3 Preamble enable
AC3PREAM

AE <port> STATUS

A Complete status report concerning the
associated channel

AE.<port> TEST

Debug commands to be used in assocaiation with
Radyne Comstream technical personnel.
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SE4000 Remote Command Descriptions

Remote Command

Parameter
Range

Factory
Default

Description

AXD.A BAUD

1200, 2400,
4800, 9600,
19200, 38400
bps

38400 bps

Sets the asynchronous serial auxiliary data baud
rate.

Front panel command equivalent:
Config>Service>Data>Baud

AXD.B DR

1200 to
20,000,000
bps

1024000
bps

Sets the data rate for the synchronous auxiliary
data channel.

Note: The data rate for the auxiliary data
channel reduces the total transport stream bit
rate available for the video signal; therefore, an
auxiliary data rate should be selected that
meets but does not exceed the site-specific
operational requirements.

Front panel command equivalent:
Config>Service>Data>Data Rate

AXD.<port> EN

Off, On

Off

Enables or disables the auxiliary data channel in
the transport stream. Parameters are:
e Off = auxiliary data is not included in the
transport stream
e On = auxiliary data is included in the transport
stream.
Front panel command equivalent:
Config>Service>Data>Enable

AXD.A PARITY

Sets the parity bit for asynchronous serial
communication. Parameters are:

N = none, O = odd, E = even.

Front panel command equivalent:
Config>Service>Data>Parity

AXD.B SRC

INT, EXT

INT

Sets the clock source for the synchronous auxiliary
data channel; parameters are:

o INT = internal, uses ST to latch the data.

e EXT = external, uses TT to

latch the data.

AXD SRC is only available when AXD Mode is set
to sync.
Front panel command equivalent:
Config>Service>Data>Clock Source

AXD.A STOP

1,2

Sets the number of stop bits for the asynchronous
serial protocol.

Front panel command equivalent:
Config>Service>Data>Stop Bits

AXD.A WIDTH

7,8

Sets the number of data bits for asynchronous
serial data.

Front panel command equivalent:
Config>Service>Data>Data Bits

AXD.AFC

NONE, HARD

None

Sets the flow control for asynchronous serial data.
Front panel command equivalent:
Config>Service>Data>flow control

CM DELETE
<string>

Where string
specifies a
user-defined
label.

Deletes the specified user-defined configuration.

CM DUMP

Displays the complete list of parameters in the
SE4000. A sample Configuration dump is shown at
the end of this guide. This process takes several
seconds to display the entire configuration
dump.

CM LIST

Query-only. Displays a list of all current
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
configuration labels.
Front panel command equivalent: none
SE4000 Remote Command Descriptions
Remote Command Parameter Factory Description
Range Default
CM RENAME <old Where <old - Renames an existing label
label>;<new label> label> Fwont panel command equivalent:
specifies the Config>Presets>Rename
current user-
defined label
and <new
label> defines
the new label
name.
CM RESTORE Where string DVB Recalls one of the factory- or user-defined
<string>1 specifies a configuration sets from memory and saves it in
user-defined flash memory as the current configuration (i.e.,
label or factory power-up or reset restores the configuration set).
defined label of For example, to restore or load the configuration
DVB, ATSC. set labeled SD MCPC, issue the command CM
LOAD CD MCPC
Note: When the SE4000 is set to the DVB
default setting, the remote port baud rate is set
to 38400 bps. If the remote unit is set to
communicate with the SE4000 at a baud rate
other than 38400 bps, immediately after the
DVB default command is issued, the remote
unit will not be able to communicate with the
SE4000. To resolve this issue, the equivalent
parameter in the software settings of the
remote unit must be changed to 38400 bps.
However, the remote unit software settings
must not be changed before issuing the DVB
default command to the SE4000, as the remote
unit will not be able to communicate with the
SE4000.
Front panel command equivalent:
Config>Presets>Restore
CM SAVE' - - Saves the current configuration to flash memory.
Front panel command equivalent: none
CM SAVE_CFG Where string - Saves the current configuration settings to the
<string>1 specifies a specified user-defined label. The user label must
user-defined be created using the CM CREATE command prior
label. to storing the configuration settings.
For example, to store the unit’s current
configuration settings to the existing user
configuration label SD MCPC, issue the command:
CM SAVE_CFG SD MCPC.
Caution: Any configuration parameters
previously saved under a specified label are
overwritten and lost when a new configuration
set is saved to the same location.
Front panel command equivalent:
Config>Presets>Save
FM CURR_LIST - - Query only command, displays all current faults.
Front panel command equivalent: Status>Current
FM CLR_HIST - - Clears the fault history log.
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SE4000 Remote Command Descriptions

Remote Command

Parameter
Range

Factory
Default

Description

Note: Clearing the fault history log does
not clear the fault relay.
Front panel command equivalent:
Status>History>Clear

SE4000

Remote Command Descriptions

Remote Command

Parameter
Range

Factory
Default

Description

FM HIST_LIST

Query-only command; displays the fault
history log with time stamps.

For a complete description of the fault history
log, refer to the chapter on troubleshooting.

Front panel command equivalent:
Status>History>List

FM RELAY_CLR

Clears the fault relay.

Note: Clearing the fault relay does not clear
the fault history log.
Front panel command equivalent:
Status>Relay>Clear

FM RLY_LIST

Query-only command; displays a list of faults which
trigger the fault relay.

Front panel command equivalent:
Status>Relay>List

FM SAVE

ON, OFF

OFF

Enabling FM Save causes all faults to be written to
flash memory. This is very useful when
troubleshooting.

FM TYPES

Provides a complete list of all faults defined in the
unit. Included is a description and activation status.

FM EN_FLT

See Troubleshooting section for detailed
explanation

FM EN_FLT

See Troubleshooting section for detailed
explanation

MC BAUD

1200,2400,
4800, 9600,
19200, 38400
bps

38400 bps

Sets the asynchronous interface baud rate for the
RS-232 remote control port configuration.

Note: The SE4000 and remote terminal baud
rates must match in order for the remote
terminal and SE4000 to communicate. Once the
MC RS232_BAUD rate command is issued, the
equivalent parameter in the remote unit
software settings must be set to match the new
baud rate. However, the remote unit software
settings must not be changed before issuing
the DVB default command to the SE4000, as the
remote unit will not be able to communicate
with the SE4000.

Front panel command equivalent:
Config>Comm>Serial>Baud

MC DATA

7,8

Sets the number of data bits for the RS-232 remote
control port configuration.

CM LIST

Front panel command equivalent:
Config>Comm>Serial>Data Bits

MC DATE
dd/mm/yyyy

numeric value
in the format:

Sets the SE4000 internal date. The date is set in
mm/dd/yyyy format where:

01-0934-401-E
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
mm/dd/yyyy e mm = month from 01 to 12

e dd = day of the month from 01 to 31

® yyyy = current year
For example, to set the date to June 21, 2003,
issue the command MC DATE 06/21/2003
Note: The SE4000 real- time clock does have a
battery backup source. If the unit loses power,
is turned off, or reset, the real-time clock is set
to the current (correct) day and time.
Front panel command equivalent:
Config>Control>Clock>Date

MC FLOW Soft, Hard Soft Sets the remote control port flow control.
Parameters are:

o Soft = Software XON/XOFF

e Hard = Hardware RTS/CTS.
Front panel command equivalent:
Config>Comm>Serial>Flow
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Remote Command Parameter Factory Description
Range Default
MC FPLOCK Locked Unlocked Used to query or set the state of the front panel.
If queried, responses are: unlocked = the front
panel is unlocked, operators can use the front
panel to configure, monitor, and control SE4000
operations; locked = front panel is locked and is
only available to monitor SE4000 operations.
If used to set the state of the front panel, only a
LOCKED parameter may be issued. The front
panel or the MC FPPASSWD must be used to
unlock the unit. For additional information on
locking and unlocking the front panel, refer to the
chapter on the front panel.
Front panel command equivalent:
Config>Control>FP Lock>State
MC FPPASSWD 7384 Unlocks the SE4000 front panel
MC GATEWAY Where #is a 0.0.0.0 Sets the designated gateway in an IP network.
#HRH decimal Front panel command equivalent:
number from 0 Config>Comm>Network>IP Router
to 255
MC MAC - - Displays the unit’'s Medium Access Control (MAC),
or network, address. The format for the returned
value is #:#:#:##:# where # represents a
hexadecimal number.
Front panel command equivalent:
Config>Comm>Network>TMA
MC SN - Displays the unit Serial Number
MC IP ##.#.# Where # is a 0.0.0.0 Sets the IP address.
decimal Front panel command equivalent:
number from 0 Config>Comm>Network>IP Addr
to 255
MC MASK #.#.#.# Where #isa | 225.225.0. | Sets the IP mask.
decimal 0 Front panel command equivalent:
number from 0 Config>Comm>Network>IP Mask
to 255
MC PARITY N, O, E N Sets the parity for the RS-232 remote control port

configuration. Parameters are:

o N = No parity

e O = Odd parity

e E = Even parity
Front panel command equivalent:
Config>Comm>Serial>Parity

01-0934-401-E
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default

MC RE - - Resets the SE4000, reloads all programmable logic
and firmware, and restarts the system. All
parameters return to the last settings stored in flash
memory or the last changes made using the front
panel. The SE4000 restores configuration settings
as follows:

e All changes made using the front panel are
automatically stored in flash memory. When
the SE4000 is reset, any changes made
using the front panel are restored.

e Changes made using a remote unit are not
automatically stored in flash memory. If the
SE4000 is reset before issuing the CM SAVE
command, changes made using a remote unit
are not restored. Instead, the last changes
saved to flash memory are restored.

e |f the SE4000 configuration is changed using
a remote unit, an operational test should be
performed to verify system operations. Then
the new configuration should be saved by
issuing the CM SAVE command. Once the
configuration is saved, the SE4000
automatically restores the saved settings
when the unit is reset or powered up.

Note: The SE4000 real- time clock includes a
battery backup source. If the unit loses power,
is turned off, or reset, the real-time clock
reverts to the current day and time. This
backup power will only last for approximately
one week.

Front panel command equivalent:
Config>Control>Reset

MC STOP 1,2 1 Sets the number of stop bits for the RS-232 remote
control port.

Front panel command equivalent:
Config>Comm>Serial>Stop Bits

MC TIME hh:mm:ss Numeric value - Sets the SE4000 internal real-time clock. The time
in the format: is set in hh:mm:ss format where:
hh:mm:ss e hh = hours, in a 24-hour format, from 00 to

23, where 00 is midnight and 23 is 11 PM

e mm = minutes from 00 to 59

e ss = seconds from 00 to 59
For example, to set the time to 10:20:59 AM, issue
the command MC TIME 10:20:59. To set the time
to 10:20:59 PM, issue the command MC TIME
22:20:59.
Note: The SE4000 real- time clock does have a
battery backup source. If the unit loses power,
is turned off, or reset, the real-time clock is set
to the current (correct) day and time.
Front panel command equivalent:
Config>Control>Clock>Time

MC VERSION - - Displays the firmware version of the master
controller card.
Front panel command equivalent: none

MC UPDATE Software update — refer to software upgrade
instructions provided with your new software
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Remote Command

Parameter
Range

Factory
Default

Description

package.

SE4000

Remote Command Descriptions

Remote Command

Parameter
Range

Factory
Default

Description

MOD CAR_TYPE

NORM, CW

NORM

Norm — Normal modulation
CW — Pure CW carrier

MOD CODE_RATE

1/2, 2/3, 3/4,
5/6, 7/8

5/6

Viterbi code rate; sets the code rate for forward
error correction (FEC) of the modulated signal.
The rate selected indicates the number of error
correction bits that will be added to the data
stream. For example, if you select the 5/6 rate, for
every 5 bits that are input to the FEC encoder, the
FEC encoder outputs 6 bits.

Viterbi forward error correction increases the
transmitted symbol rate by increasing the number
of bits in the data stream.

Front panel command equivalent:
Config>Output>Code Rate

MOD DATA_RATE

1,000,000 to
108,000,000
bps

8448000

Data rate; used to set the modulator input transport
stream data rate.

The data rate you enter is a function of the symbol
rate and the code rate.

The data rate may be entered directly by issuing a
MOD DR command or may be computed based
upon the symbol rate you enter. Specifically, the
data rate is equal to the Symbol Rate x 2 x 188/204
x V, where V = the Viterbi code rate.

Front panel command equivalent: none

MOD SPEC_INV

Inverted,
Normal

Normal

Spectrum Inversion; used to set the modulator so
that the modulated IF spectrum is inverted.
Parameters are:
e Inverted = the modulated IF spectrum is
inverted.
e Normal = the modulated IF spectrum is not
inverted.
Front panel command equivalent:
Config>Output>Spect Invert

01-0934-401-E
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Remote Command Parameter Factory Description
Range Default
MOD SYM_RATE MOD SR - Used to enter the modulator symbol rate. The
1000000 to symbol rate is the number of symbols required to
20000000 sps transmit the data stream over a satellite link using
quadrature phase shift keying (QPSK). The
symbol rate is a function of the data rate and the
code rate, including any overhead. The symbol
rate may be entered directly by issuing a MOD_SR
command or will be automatically computed based
upon the entered data rate and code rate. The
symbol rate is equal to the Data Rate x 1/2 x
204/188 x 1/V, where V = the Viterbi code rate.
When the code rate is entered, the data rate
remains unchanged, however, the symbol rate is
recomputed.
If the displayed symbol rate exceeds the allowable
satellite bandwidth, the data will be corrupted
during transmission. To determine the satellite
bandwidth required to transmit the displayed
symbol rate, use the following equation:
symbol rate x 1.35 = required satellite bandwidth
(measured in Hz)
Front panel command equivalent:
Config>Output>SymRate
MOD CF 52000000 to 70000000 | Used to set the modulator carrier frequency. The
88000000 Hz, Hz acceptable range of options is implemented with a
104 MHz to pass band filter that filters out all frequencies below
176 MHz, 950 and above the range. When selecting a carrier
MHz to 2050 frequency, you must take into account the satellite
MHz in 1 Hz bandwidth required for transmission. If you select a
increments carrier frequency that is too close to either end of
the valid range, data may be clipped by the pass
band filter. For information on calculating the
satellite bandwidth, see the MOD SR command.
Front panel command equivalent:
Config>Output>Tx Freq
MOD POW -2500t0 0 -500 dBm | Modulator power set in hundredths of dBms.
dBmin 0.1 dB -2500 = -25.00 dBm
increments
MOD ENABLE ON/OFF
MOD MOD_TYPE DVB_QPSK, DVB_QPS
8PSK, 16QAM K
MOD TERR_TYPE NONE, DVB_188 | Sets the framing mode for the ASI output stream
DVB188,
DVB204
MOD RATE_CTRL SYMBOL_RATE, | SYMBOL_ | Sets the “master rate setting mechanism for the
DATA_RATE, RATE modulator
NONE SYMBOL_RATE = symbol rate is settable — data
rate is calculated and read only
DATA_RATE = Data rate is settable — symbol rate
is calculated and read only
AUTO = Both data rate and symbol rate are
settable and the other is calculated
MOD 20, 25, 35 35 Modulator roll off factor

MOD_ROLLOFF

35 =0.35 DVB standard
20=0.20
25=0.25

MOD STATUS

Provides a list of current modulator faults.
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Remote Command

Parameter
Range

Factory
Default

Description

OUT OUT_RATE

1,000,000 to
216,000,000

8448000

Sets the transport output rate

OUT ENABLE

ON/OFF

ON

Enables or disables the ASI output

OUT PACKET_SIZE

188, 204PAD,
204ENC

188

Sets the ASI output mode

188 = 188 byte mpeg packets

204PAD = 188 byte packets plus 16 stuffing bytes
204ENC = 188 byte packets plus 16 bytes Reed-
Solomon encoded

OUT PCR_ENABLE

ON/OFF

Enables PCR data in the transport stream

OUT PCR_DELAY

-1000 to 1000

Sets additional PCR delay — normally should be
kept at 0.

OUT PCR_RATE

0TO 100

30

Sets the number of PCR packets per second

OUT BITRT_CTRL

Auto, Manual

Auto

Video bit rate selection. Parameters are:
Auto = automatically calculates the correct
compressed video bit rate given other configured
parameters. When in the Auto mode, you cannot
change the video bit rate parameter using the
VE.<port> BR command;
Manual = allows you to manually set the
compressed video bit rate.
Note: When MC BITRT_CTL is set to Auto, the
video bit rate setting is inversely proportional
to the audio and user data bit rates; that is:

e if the audio and user data bit rates are
high, a smaller portion of the transport
stream bit rate can be allotted to the video
bit rate

e if the audio and user data bit rates are low,
a larger portion of the transport stream bit
rate can be allotted to the video bit rate

STATUS

Displays a complete status dump. Alternate
command syntax “ST”. A sample Status dump is
shown at the end of this guide.

TAB ATSC_NAME
<string>

<string>

Sets the ATSC name; up to 8 characters may be
used.
Front panel command equivalent: none

TAB AUD_A PID
<#>

Where # is a
valid PID

Sets the Audio A PID to be included in the output
transport stream. Zero is the default PID.
Front panel command equivalent: none

TAB AUD_B_PID
<{#>

Where #is a
valid PID

Sets the Audio B PID to be included in the output
transport stream. Zero is the default PID.
Front panel command equivalent: none

TAB CARRIER_HZ

0-2000000000
in Hz

56631000
0 Hz

Sets the carrier frequency when ATSC table types
are enabled.
Front panel command equivalent: none

TAB MINORCH

110 99

2

Sets the minor channel in the ATSC tables.
Front panel command equivalent:
Config>Service>Setup>Minor Channel

TAB MAJORCH

1t0 99

30

Sets the major channel in the ATSC tables.
Front panel command equivalent:
Config>Service>Setup>Minor Channel

TAB NIT_CC

11, 172, 2/3,
3/4, 5/6, 7/8

5/6

Sets the current FEC Convolution Code Rate
entered in the NIT.
Front panel command equivalent: none

TAB NIT_MOD

QPSK

Sets the NIT modulation type.

01-0934-401-E
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
Front panel command equivalent: none
SE4000 Remote Command Descriptions
Remote Command Parameter Factory Description
Range Default
TAB NIT_NAME <string> MPEG-2 | Used to enter the network name, up to 115
Encoder | characters may be used.
Front panel command equivalent: none
TAB NIT_NETID 0 to 65535 0 Used to enter the Network ID in the NIT.
(decimal) Front panel command equivalent: none
TAB NIT_POL Hor, Vert, Left, Vert Sets the transmitted signal polarization.
Right Parameters are:
e Hor =linear- horizontal polarization
e Ver = linear- vertical polarization
e Left = circular- left polarization
e Right = circular- right polarization
Front panel command equivalent: none
TAB SATFREQ 000.00000 to | 011.75725 | Sets the satellite frequency in GHz.
<{HHE #HHEEE> 999.99999 Front panel command equivalent: none
TAB NIT_SATPOS 000.0° to 019.2° Sets the satellite orbital position in degrees.
<#HH#.#> 999.9° Front panel command equivalent: none
TAB NIT_SR HHE HHHE - Sets the NIT transmitted symbol rate (in sps).
<{HH #HHHE> Front panel command equivalent: none
TAB NIT_WSTFLG East, West West Sets the satellite orbital position. Parameters are:
e East = satellite orbital position is East
e West = satellite orbital position is West.
Front panel command equivalent: none
TAB PCR_PID <#> Where # is a 0 Sets the PCR PID to be included in the output
valid PID. transport stream. Zero is the default PID.
Front panel command equivalent: none
TAB PMT_PID <#> Where # is a 0 Sets the Program Map Table (PMT) PID to be
valid PID. included in the output transport stream. Zero is the
default PID.
Front panel command equivalent: none
TAB PROGNUM 1 to 223 (DVB) 1 (DVB) Controls the program number for the PAT.
210223 2 (ATSC) | Changing the PAT program number automatically
(ATSC) sets the PMT to the same program number and
sets the EIT and SDT service ID to match the
program number.
Front panel command equivalent:
Config>Service>Setup>Service ID
TAB PROVIDER <string> Unnamed | Used to enter the service provider name; name can
<string> be up to 115 characters in length.
Front panel command equivalent:
Config>Service>Setup>Provider
TAB SDT_NAME <string> Service 1 | Used to enter the service name; name can be up to
<string> (DVB) 115 characters in length.
Ch2 Front panel command equivalent:
(ATSC) Config>Service>Setup>Name
TAB TSID 0 to 65535 1 Sets the transport stream ID for the PAT Transport
Stream ID automatically changes the EIT, NIT, and
SDT Transport Stream IDs to the same ID.
Front panel command equivalent: none
TAB TYPE None, MPEG, DVB Controls the type of PSI/SI tables to be provided.
DVB, ATSC Works in conjunction with the CM Load Def

command.
Front panel command equivalent: Config>Tx
Strm>Table Type
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
TAB USR_A_PID Where # is a 0 Sets the Data A PID to be included in the output
<#> valid PID. transport stream. Zero is the default PID.
Front panel command equivalent: none
SE4000 Remote Command Descriptions
Remote Command Parameter Factory Description
Range Default
TAB USR_B_PID Where # is a 0 Sets the Data B PID to be included in the output
<#> valid PID. transport stream. Zero is the default PID.
Front panel command equivalent: none
TAB VID_PID <#> Where #is a 0 Sets the video PID to be included in the output
valid PID. transport stream. Zero is the default PID.
Front panel command equivalent: none
TAB PGCA_PID Where #is a 0 Sets the PID assigned to PGCA (TCA)
valid PID
TCA ADD <string> Where string is - Adds a decoder to the conditional access
the database. The string can be up to 90
alphanumeric alphanumeric characters in length and must
label in the include a name, the @ sign, and the decoder’s
format MAC address in the format name@mac address.
name@MAC The string cannot contain any spaces. The name
address parameter can be up to 15 characters in length.

To determine the decoder's MAC address, refer to
the appropriate Tiernan user guide which
accompanied that product.

Note: Decoders are automatically authorized
when they are added to the list.

Note: Non-Tiernan IRDs cannot be added to the
decoder database.

Front panel command equivalent:
Config>CA>PGCAcfg>Add IRD

TCA AUTH <label>

Where label is
the
alphanumeric
string specified
in the TCA Add

Authorizes a Tiernan decoder to receive broadcast
signals.

Note: Non-Tiernan IRDs cannot be authorized.
Front panel command equivalent:
Config>CA>PGCAcfg>Lst IRD

command.
TCACLR - - Clears the active subscriber list.
Front panel command equivalent: none
TCA DEAUTH Where label is - De-authorizes a Tiernan decoder so that it cannot
<label> the receive broadcast signals.
alphanumeric Front panel command equivalent:
string specified Config>CA>PGCAcfg>Lst IRD
in the TCA Add
command.
TCA DELETE Where label is - Deletes a Tiernan decoder from the conditional
<label> the access database.

alphanumeric

string specified

in the TCA Add
command.

Front panel command equivalent:
Config>CA>PGCAcfg>Del IRD
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
TCA ENABLE Off, On Off Enables and disables PGCA at a system level.

Parameters are:

e on — enables PGCA,; this setting ensures that
only those Tiernan decoders listed in the
PGCA database and authorized at an
individual level can receive the broadcast
signals.

e off — disables PGCA, all decoders, whether
authorized or not, can receive the broadcast
signal.

Note: PGCA is a proprietary conditional access
method used by Tiernan equipment that
provides basic signal protection and the ability
to authorize individual Tiernan IRDs. Non-
Tiernan IRDs cannot be authorized by PGCA;
therefore only authorized Tiernan IRDs can
decode a service that has been protected
through PGCA.

Note: For additional information on system-
level PGCA, or on adding, deleting and
authorizing individual decoders, refer to the
appendix on Conditional Access.

Note: PGCA cannot be enabled if BISS is
enabled.

Front panel command equivalent:
Config>CA>Setup>Service>Scramble> PGCA

TCALIST - - Displays a list of all Tiernan decoders registered in
the PGCA database. The list includes the
decoder’s label, MAC address, and if the decoder
is authorized.

Front panel command equivalent:
Config>CA>PGCAcfg>Lst IRD

TCA MASK 0to FF 0 Sets the PGCA scrambling key to a specified
algorithmic table.

Front panel command equivalent:
Config>CA>Setup>Service>Scramble>

PGCA>PGCA Key
TCA UR 1to 60 15 TCA update rate; specifies how often, in seconds,
seconds seconds | PGCA information is transmitted.

Front panel command equivalent: none

TCA BISS_EN ON, OFF OFF Enables BISS conditional access. Only available if
the BISS feature has been purchased.

TCA BISS HW Provides a readout of the BISS hardware revision.

TCA BISS_1KEY Used for entry of the BISS mode 1 key. Key may
be any numeric entry up to 12 characters in length.

TCA BISS_EKEY Used for entry of the BISS mode E key. Key may
be any numeric entry up to 16 characters in length.

TCA BISS_EID Used for entry of the BISS mode E Identifier. ID
may be any numeric entry up to 14 characters in
length.

TCA MODE NONE, PGCA, NONE Sets the scrambling mode.

BISS 1, BISS
E
VAR <feature> 422 _feature, On the SE4000, various features are available as
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
<key> 70_140_feature, keyed software upgrades. To purchase a software
LBAND_feature, upgrade contact Customer service. A software Key
186PQS:Mfiat“’e' will be provided. Entering the key enables the
_feature feature.
VI.A FORMAT 525_lines Read only | Displays the format of the detected analog video
(NTSC) input.
625_lines
(PAL)
NO_VIDEO
SE4000 Remote Command Descriptions
Remote Command Parameter Factory Description
Range Default
VI.A FMTCTL PAL_N, NTSC, AUTO Sets t he analog video input format detection.
NTSC_0SU, Auto = automatically detect video input.
AUTO PAL_N = Set for PAL only
NTSC_0SU = NTSC mode with no pedestal
NTSC = Normal NTSC
VI.LA AGC ON/OFF ON Sets Video input AGC on or off.
VI.A STATUS Status readout.
VI.B FORMAT 525 lines Read only | Displays the format of the detected DIGITAL video
(NTSC) input.
625 _lines
(PAL)
NO_VIDEO
VI.B FMTCTL PAL_N, NTSC, AUTO Sets t he analog video input format detection.
AUTO Auto = automatically detect video input.
PAL_N = Set for PAL only
NTSC = Set for NTSC only
VI.B STATUS Status readout.
VE ASP_RATIO 4x3, 16x9 4x3 Sets the picture aspect ratio.
Front panel command equivalent:
Config>Service>Video>Aspect Ratio
VE BR 0.8t050.0 - Sets the output compressed video bit rate. This
Mbps command is query-only when the MC
BITRATE_CTL command is set to Auto.
Front panel command equivalent:
Config>Service>Video>Data Rate
VE CHROMA 420,422, 420 Queries the chroma encoding format.
4 2 2 TIERN 4 2 2 TIERNAN is a special mode that allows for
AN interoperaton with certain early Tiernan IRD’s.
Front panel command equivalent:
Config>Service>Video>Chroma
VE ENABLE ON/OFF ON Enables or disables the video encoding engine
VE SRC ANALOG, SDI, SDI Setting determines the source of video into the
TESTPAT75%, encoding engine. Parameters are:
TESTPAT100 Analog
%, SDI = Digital
TESTPATBLU The four test patterns are internally generated for
E, ease of troubleshooting and test.
TESTPATMG 75% = color bars
NTA 100% = color bars
BLUE = Blue field
MGNTA = Magenta field
VE HRES 352, 480, 544, 720 Sets the horizontal pixel resolution; the SE4000
704, 720, 640, uses this parameter, as well as the video format
SIF parameter, NTSC or PAL, to resize the picture prior
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SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default

to video encoding. For all parameters except SIF
the number of lines per frame are: NTSC = 480;
PAL = 576.
SIF Mode:

NTSC (352 x 240)

PAL (352 x 288)
Front panel command equivalent:
Config>Service>Video>Resolution

SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
VE LATENCY Quality, Quality Sets the video compression optimization.
Low_Delay, Parameters are:
Low_Buff, Edit, e Quality = optimizes the video performance
Custom without regard for throughput delay time.

Quality mode is appropriate for action video
scenes such as sports material.

e Low_Delay = reduces the throughput time
required to process a signal from the encoder
input, through the compression process, and
to the decoder output. In low delay mode, the
overall delay through a TE60 to an IRD is 360
ms +20 ms. In low delay mode, the
compressed audio bit rate is automatically set
to 256 Kbps. Low delay mode is appropriate
for real time news interviews.

e Low_Buff = allows for small buffers.

e Edit = video compression uses only one
frame (no prediction) which makes it easier to
edit the compressed bit stream. Edit requires
a higher data rate to achieve the video
performance of quality mode.

e Custom = allows you to set site-specific video
compression parameters, such as GOP
structure and VBV size. These parameters
must be initially set through a remote terminal
and then saved using the remote CM SAVE
command. Once saved, this custom setup will
persist until the video optimize setting is
changed.

The custom parameter is for experienced users
only. If this option set incorrectly, the video
performance maybe adversely affected. Itis
recommended that users consult with Tiernan
Customer Service before using the custom
configuration.

Front panel command equivalent:
Config>Service>Video>Optimize

VE GOP_LENGTH 1-126 12 Sets GOP length in custom GOP mode

GOP = (Group of Pictures)

NOTE: GOP adjusting parameters will greatly
affect coding efficiency and picture quality.
Only advanced users should adjust GOP
parameters. Setting GOP LENGTH to a non
even multiple of the GOP will result in poor
video encoding performance

VE GOP I, IP, IPB, IP2B IP2B Sets GOP configuration in custom GOP mode
| = | frame only

4-24 01-0934-401-E



SE4000 MPEG-2 Contribution Encoder

Using a Remote Unit

SE4000 Remote Command Descriptions

Remote Command Parameter Factory Description
Range Default
IP =1and P frame only — 12 frame IP GOP is
IPPPPPPPPPPP
IPB = 12 frame IPB GOP is IBPBPBPBPBPB
IP2B = 12 frame GOP is IBBPBBPBBPBB
VE PTS_DELAY -1000 to 1000 0 Sets the PTS to PCR video delay.

NOTE: It is possible to set the delay larger than
the available buffer size.

VE STATUS Provides status info.
SE4000 Remote Command Descriptions
Remote Command Parameter Factory Description
Range Default
VBI ENABLE OFF, AUTO, OFF OFF = No VBI
ALL AUTO = Sets the VBI mode based on the received
video data.
ALL = Transmits all VBI lines
VBI MODE Off, Off Configures the encoder to transmit either 16 or 32
16_LINES PT, lines of VBI information or Tiernan proprietary
32_LINES PT, closed caption mode
TIERNAN_CC e Off — disables expanded windows mode.
e 16_lines — enables 16-line expanded
windows mode.
e 32_line — enables 16-line expanded windows
mode.
. TIERNAN_CC - Line 21 encoded
Tiernan mode
DATA_ID 0-255 16
DATA _UNIT_ID 23 2
TT_TIME_STAMP ENABLED, DISABLE | Enables time stamping of teletext data packets.
DISABLED D
TT_MON_FREQ NOP, 50ms
5MS,10MS,
20MS, 40MS,
50MS, 100MS,
200MS,
500MS, 1SEC,
2SEC, 3SEC,
10SEC,
20SEC,
30SEC,
60SEC,5SEC,
15SEC
VBI VBI_QUANT 1-31 1 Sets the Quantization (number of pixels per data
bit) for VBI. Setting higher quantization levels will
provide lower bandwidth utilization at the expense
of decreased VBI data resolution.
NOTE: This parameter is for advanced users
only.
VBI VBI_END 6-23 21 Sets the last VBI encoded line.

NOTE: This parameter is for advanced users
only.

01-0934-401-E
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SE4000 Remote Command Descriptions

Remote Command

Parameter
Range

Factory
Default

Description

" The SE4000 contains a bank of flash memory that is used to store firmware, software, and hardware
configuration files as well as unit configuration parameters. Parameter changes made using the front
panel are automatically stored in flash memory. When the SE4000 is reset, any changes made using
the front panel are restored. Any parameter changes made using a remote unit are not automatically
stored in flash memory. If the SE4000 is reset prior to issuing the CM SAVE command, any changes
made using the remote unit will not be restored. Instead, the SE4000 restores the last changes saved
to flash memory. When the SE4000 configuration is changed using a remote unit, an operational test
should be performed to verify that the system is operating correctly. Then the new configuration
should be saved by issuing the CM SAVE command. Once the configuration is saved, the SE4000
automatically restores saved settings when the unit is reset or powered up.

2 Command only valid when MUX CM is set to Redund.

® Refer to the MUX RED_ STATE command for additional information.

Tiernan standard product NMS backward compatability

For compatibility with NMS designs based around the Tiernan TE6000 modular products, the

SE4000 will accept slot numbers in mnemonics. For example:

AE A BR 256000 sets the Audio A bit rate to 256000. The SE4000 will accept AE.1.A BR 256000

as an alternative. The slot number is accepted but ignored.
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Configuration examples:
Here is a sample power up initialization screen:

>mc re

System is resetting...
SE4000 SDTV MPEG Encoder
Software Version: 1.0302
Date of Make: 12/23/2003
Time of Make: 14:38:39

Initializing Master Controller ...Done.
Investigating Optional Feature authorization

Initializing Modulator ...Done.
Initializing Audio Encoder ...Done.
Initializing Video Encoder ...Done.

System initialization completing...
SE4000 initialization complete.

>

...Done.

Here is a sample of a configuration dump using the CM DUMP command

>cm dump

MC BAUD 38400

MC DATA 8

MC FLOW HARD

MC PARITY N

MC STOP 1

MC MAC FE:FF:FF:FF:FF:FF
MC SN Yyyyyyyyy

MC Ip 239.239.239.239
MC MASK 239.239.239.239
MC GATEWAY 239.239.239.239
MC DATE 20 Nov. 2003
MC TIME 00:08:18

MC VERSION 1.0302

MC RE write-only
MC UPDATE write-only
MC FPLOCK UNLOCKED
AE.A SRC AESEBU

AE.A ENABLE ON

AE.A COMPRESS MPEG

AE.A OUTRES 24BIT

AE.A SRATE 48

AE.A CHFMT STEREO

AE.A BR 256

AE.A DELAY 0

AE.A ER PROTECT ON

AE.A COPYRIGHT OFF

AE.A MPEG_ORIG OFF

AE.A MPEG_EMPH NONE

AE.A USER EXT OFF

AE.A SDI_CH_PAIR 2

AE.A LANGUAGE ENG

AE.A PES BLOCKS 1

ouT OUT RATE 8448000

ouT ENABLE ON

OouT PACKET_ SIZE 188

ouT PCR ENABLE ON

ouT PCR _DELAY 0

ouT PCR_RATE 30

ouT BITRT CTL AUTO

TAB TYPE DVB

TAB PROGNUM 2

TAB TSID 1

TAB NIT CC 5/6

01-0934-401-E
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TAB NIT MOD QPSK

TAB NIT NETID 65535

TAB NIT NAME MPEG-2 Encoder

TAB NIT SATPOS 019.2

TAB NIT POL VERT

TAB SATFREQ 011.75725

TAB NIT SR 005.5002

TAB NIT WSTFLG WEST

TAB PROVIDER Unnamed

TAB SDT_NAME Service 2

TAB ATSC_NAME is UNAVAILABLE in the current state of the system. -
Only applicable for ATSC tables

TAB MAJORCH is UNAVAILABLE in the current state of the system. -
Only applicable for ATSC tables

TAB MINORCH is UNAVAILABLE in the current state of the system. -
Only applicable for ATSC tables

TAB CARRIER HZ is UNAVAILABLE in the current state of the system. -
Only applicable for ATSC tables

TAB VID PID 33 (0x0021)

TAB AUD A PID 36 (0x0024)

TAB AUD B PID 37 (0x0025)

TAB PCR_PID 33 (0x0021)

TAB USR_A PID 42 (0x002a)

TAB USR B _PID 43 (0x002b)

TAB PMT PID 32 (0x0020)

VI.A FORMAT 525 LINE VIDEO INPUT
VI.A FMTCTL AUTO

VI.A AGC ON

VI.B FORMAT 525 LINE VIDEO INPUT
VI.B FMTCTL AUTO

VE BR 7466330

VE HRES 720

VE CHROMA 420

VE GOP_ LENGTH 12

VE SRC SDI

VE GOP IP2B

VE PTS DELAY 0

VE LATENCY QUALITY

VE ENABLE ON

VE ASP_RATIO 4X3

AXD.B EN OFF

AXD.B SRC INT

AXD.B DR 1024000

AXD.A BAUD 38400

AXD.A STOP 1

AXD.A PARITY N

AXD.A EN OFF

AXD.A FC NONE

AXD.A WIDTH 8

FM FP_RELAY 0

TCA BISS_EN failed to retrive - Error
TCA BISS HW failed to retrive - Error
CM SAVE write-only

CM RENAME write-only

CM DELETE write-only

CM SAVE _CFG write-only

CM RESTORE write-only

CM LIST Issue command for detail
CM MODIFY write-only

CM DUMP Issue command for detail
VBI MODE OFF

VBI VBI_ QUANT 1
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VBI VBI_ END 21

MOD ENABLE OFF

MOD MOD TYPE DVB QPSK

MOD SYM RATE 5500187

MOD DATA_RATE 8447999

MOD CODE_RATE 5/6

MOD CF 70000000

MOD POW -500

MOD SPEC_INV NORMAL

MOD STATUS Minor Tx Alarm

MOD CAR TYPE NORM

MOD TERR TYPE DVB188

MOD RATE_CTRL SYMBOL_RATE

MOD MOD_ROLLOFF 35

VAR 422 FEATURE Chroma 4:2:2 feature is now avaiable

VAR 70_140_ FEATURE feature not available. Enter code to enable
VAR LBAND FEATURE feature not available. Enter code to enable
VAR 8PSK_FEATURE feature not available. Enter code to enable
VAR 16QAM FEATURE feature not available. Enter code to enable
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Here is a sample of a Status dump using the STATUS or ST command:

>statusAUD6022 Audio A Status
Audio FPGA Version: Oxlc
DSP Software Version: 1.3

CS8420 Active: Yes

Information From CS8420 Receiver:

AUD6022

Analog Video Operational Status

Subcode CRC Error: No
Channel Status CRC Error: No
PLL Unlock: No
Data Invalid: No
Confidence Error: No
Bi-Phase Error: No
Parity CRC Error: No
Channel Status Bytes: 0x8140

Bitrate: 256000

PES FIFO threshold: 6752

PES FIFO Level: 7264

PES FIFO Max Level: 7632

STC Latch hi med lo: 0 56845 41209

Information From DSP:
AES Data: Detected
AES Input: Locked
AES Data: Valid
AES Confidence: No Error
AES Bi-Phase: No Error
AES Parity: No Error
AES Preemphasis: Not Detected
AES Mode: consumer

AES Resolution:

AES Sample Rate:

Audio B Status
Audio FPGA Version:
DSP Software Version:

CS8420 Active: Yes

Not Indicated
48K

Oxlc
1.3

Information From CS8420 Receiver:
Subcode CRC Error: No
Channel Status CRC Error: No

PLL Unlock: No
Data Invalid: No
Confidence Error: No
Bi-Phase Error: No
Parity CRC Error: No
Channel Status Bytes: 0x8140
Bitrate: 256000
PES FIFO threshold: 6752
PES FIFO Level: 6850
PES FIFO Max Level: 7632
STC Latch hi med lo: 0 56845 41209
Information From DSP:
AES Data: Detected
AES Input: Locked
AES Data: Valid
AES Confidence: No Error
AES Bi-Phase: No Error

AES Parity:

AES Preemphasis:

AES Mode:
AES Resolution:

AES Sample Rate:

No Error

Not Detected
consumer

Not Indicated
48K

Main analog video input is not present.

0x0000

0x0000

4-30

01-0934-401-E



SE4000 MPEG-2 Contribution Encoder User Interfaces

AGC is on.

Digital Video Operational Status

Main SDI video input type NTSC is present.

Encoder Init: Initialized
Video Input: Present
Video Valid: Yes
VBV size: 1835008 bits
Throughput delay: 347
STC/PTS Status:

STC FIFO Level: 25

STC Value: 2160696

PTS Value: 1098903661

STC minus PTS: 0

ATSC Closed Captions are not present

Modulator Operational Status
No Alarm
>
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Configuring the SE4000 5

This chapter presents the following information:

Configuration prerequisites.

A high-level procedure used to configure a SE4000 using either the front panel or a
remote unit.

Detailed procedures for configuring a SE4000 to the default standards, using either
the front panel or a remote unit

Examples of common SE4000 configurations, including:

Configuraing a basic DSNG setup using the front panel.

5.0 SE4000 Configuration Procedure

Whether the front panel or a remote unit is used to configure the SE4000, perform the following
steps to configure the system:

1.

2.

Make a list of the operational requirements.
Compare the requirements to the corresponding SE4000 default parameter settings

Determine which SE4000 default parameters must be changed for the operational
requirements.

Record the new SE4000 parameter values and the corresponding front panel or remote
commands required to change those parameters.

Configure the SE4000 to the default configuration.
Configure the SE4000 with any new parameters.

Ensure that any decoders are correctly configured to operate with the SE4000 parameter

settings.
E NOTE

All SE4000 configuration changes issued from the front panel are
automatically save to non-volatile memory. Unlike front panel operations,
SE4000 parameter changes made from a remote unit are not
automatically saved to non-volatile memory. If configuration changes are
made from a remote unit, issue the command CM SAVE to save the
configuration to non-volatile memory. Multiple configurations can be
saved using the Quickset commands.
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5.1 Setting the Default Configuration

The SE4000 is configured with a set of default, DVB-compliant parameters before it is shipped
from the factory. This DVB configuration consists of a standard set of operating parameters that
allow the user to quickly and easily begin operations. When configured to the DVB default
settings, the SE4000:

Encodes both audio channels and the video channel at the default DVB rate.
Compresses the channels.
Includes the channels with a standard set of table information in the internal transport stream.
Does not include either of the Aux data channels in the transport stream.
Adds modulator settings
Modulation: QPSK
Code Rate: 5/6
Data Rate: 8448000
Frequency: 70Mhz or ??7? if the modulator is L-band only.

The SE4000 should be operated using either the DVB or ATSC default configuration unless site-
specific operations require a change to the default settings. If a change is required, modify only
those parameters meeting operational requirements.

When beginning operations using either the DVB or ATSC default configuration, ensure that the
decoder is also initialized to the appropriate defaults. If the SE4000 operating parameters are
modified, ensure that the decoder parameters are also modified to match the new SE4000
parameters.

Setting the SE4000 to the default DVB configuration will return it to the factory delivered
configuration with the exception that any user custom configurations are preserved.

5.1.1 Using the Front Panel to Set the Default Factory Configuration

To initialize the SE4000 to the default configuration using the front panel, perform the following
steps.

1. From the main menu, select QuickSet.

SE4000 >

[QUICKSET] SERVICE OUTPUT STATUS

2. The Quickset selection menu appears. Select DVB.

SE4000/QUICKSET >

[DVB ] Emptyl Empty2 Empty3
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3. A message appears to confirm the selection. This helps to prevent accidental re-
configuration. Press Enter to continue.

SE4000/QUICKSET/DVB >

Press Enter to restore DVB Config.

4, A “last chance to turn back” menu appears. Press Enter to continue.

SE4000/QUICKSET/DVB >

(ENTER) = Restore Config, (EXIT) = abort

5. Various screens will appear indicating that the unit is re-configuring and then resetting.
The process takes less than 1 minute. Once the basic SE4000 power on screen appears,
the unit is ready for operation or configuration.

SE4000 >

[QUICKSET] SERVICE OUTPUT STATUS

5.1.2 Using a Remote Unit to Set the Default Configuration

To initialize the SE4000 to the default configuration using a remote unit issue the following
command: CM RESTORE <st ri ng>, where <st ri ng> is the default parameter such as DVB or

ATSC.
=

When the SE4000 is set to the default setting, the remote port baud rate is
set to 38400 bps. If the remote unit is set to communicate with the
SE4000 at a baud rate other than 38400 bps, immediately after the default
command is issued, the remote unit will not be able to communicate with
the SE4000. To resolve this issue, the equivalent parameter in the
software settings of the remote unit must be changed to 38400 bps.
However, the remote unit software settings must not be changed before
issuing the default command to the SE4000, as the remote unit will not be
able to communicate with the SE4000.

NOTE
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5.2.2 Configuring a Simple SCPC Setup Using the Remote Unit

This example configures the SE4000 to a simple SCPC setup. Use this example as a guideline,
substituting site-specific parameter values as required.

Step 1

In this example, assume that the following is a list of your SE4000 operational parameters:
Input channels:

e Audio A: On
e Audio B: Off
e Video: On

Audio encoder parameters:

Source of input audio: analog left and right input.
Compressed output audio format: stereo

Audio compressed bit rate: 256 Kbps

Audio channel sample rate: 48 Ksps

Video encoder parameters:

Source of input video: SDI serial digital

Video format mode: PAL

Pixel and line sample resolution: 480 x 576 resolution video.
Output compressed video bit rate: auto-rate calculation.
Aux data parameters: No aux data required.

Multiplexer transport stream parameters:

e SCPC Operation: ASI output at 4 Mbps.
e PSI tables: minimal complete set.

Steps 2and 3
After comparing these operational requirements against the SE4000 DVB parameters, it is
determined that all of the parameters with required to set the audio and video encoders to the

basic SCPC configuration are DVB settings, with the exception of the following parameters:

e Video source.
¢ Video resolution
o Multiplexed transport rate

Step 4

To change these parameters, the following remote commands will be used:

Parameter Remote Command
Video source = D1 serial digital VE SRC DIGITAL
Video resolution = 480 x 576 VE HRES 480
Multiplexed transport rate = 4 Mbps OUT OUT_RATE 4000000
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Step 5

To configure the SE4000 for this example, the unit must first be initialized to the DVB default
settings.

1. Issue the DVB default command CM RESTORE DVB.
When the remote unit displays the system prompt (>), all of the SE4000 parameters have
been set to the DVB default settings.

2. if the baud rate settings of the communications package in the remote unit is not set to
38400 bps, the baud rate must be changed before continuing.

When the SE4000 is set to the default setting, the remote port baud rate is
set to 38400 bps. If the remote unit is set to communicate with the
SE4000 at a baud rate other than 38400 bps, immediately after the default
command is issued, the remote unit will not be able to communicate with
the SE4000. To resolve this issue, the equivalent parameter in the
software settings of the remote unit must be changed to 38400 bps.
However, the remote unit software settings must not be changed before
issuing the default command to the SE4000, as the remote unit will not be
able to communicate with the SE4000.

Step 6

Once the SE4000 is set to the DVB default settings, issue the following commands to change the
required parameters:

1. To set the source of the input video to D1 serial digital, issue the command VE SRC
DI G TAL. After the SE4000 sets the parameter, the system prompt is displayed.

2. To set the pixel and line sample resolution to 480, issue the command VE HRES 480.

3. The SE4000 is now configured to a simple SCPC setup. To save this configuration to
flash memory, issue the CM SAVE command.

Once the settings are saved, the SE4000 automatically restores to the simple SCPC setup
whenever the unit is reset or powered-up.

Step 7

Ensure that the decoder is correctly configured to operate with the SE4000 parameter settings.
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Troubleshooting

This chapter includes the following information:

e Fault reporting and monitoring, including the status LED and status button, viewing
current faults, and viewing the fault history and fault relay logs.

¢ Initialization self-test diagnostic functions.

e Summary listing all SE4000 faults.

e  Operational problems and their solutions.

6.0 Fault Reporting and Monitoring

The SE4000 has an internal microcontroller that continually performs real-time monitoring of
system conditions. When the unit detects a fault, the front panel Status LED is triggered, the fault
is then stored in the fault history log, and depending upon the type of fault, the fault may be
viewed by querying the current faults.

6.1 Status LED

At-a-glance system status can be quickly determined by checking the tri-colored Status LED
found on the front panel. The following color of the Status LED identifies the state of the SE4000:

e Green: the unit is operating correctly and has no current faults.

e Yellow: a current fault is detected.

¢ Red: internal hardware faults are detected, or the video or audio encoders are not
processing data.

If the Status LED illuminates yellow or red, the Status Button can be pressed, which will display
the current faults listing.

Refer to the Faults Summary List for a description of the faults and the actions to take to resolve

them.
E NOTE

SE4000 units may have LED indicators that are visible through holes in
the side and rear panel filler plates. These indicators are used by factory
technicians during the production process but are not used during
SE4000 operation. You should ignore these indicators.
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6.2 Current Faults
Current faults are reported real-time, which means that only conditions that are present at the

time of the query are displayed, regardless of what fault conditions have existed in the past. A
current fault exists when the Status LED is yellow.

6.2.1 Viewing Current Faults on the Front Panel
To view the current faults on the front panel LCD, perform the following steps:

1. From the main menu, select Status.

SE4000 >

QUICKSET SERVICE OUTPUT [STATUS]

2. The Status menu displays. Select Current.

SE4000/Status >

[Current ] History Relay

3. The Current Status menu displays. Only one fault is displayed on the LCD at one time. If
there is mpore than one fault detected, they can be viewed by pressing the up and down buttons.
In this case there are two faults detected and the first fault is displayed.

SE4000/Status/Current 12 >

Digital Video Loss of Input

4. Pressing the down arrow will display the other fault.

SE4000/Status/Current 22 >

Audio A AES Loss of Input

5. If there are no faults present in the SE4000, No Faults will be displayed.
SE4000/Status/Current >
No Faults
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All current faults are recorded in the fault history log; however, not all
faults that are detected by the SE4000 are shown on the current faults
log. To determine if other hardware or operational problems exist, the
fault history log must be viewed.

6.2.2 Viewing Current Faults Using a Remote Device

To view current faults using a remote unit, issue the FM CURR LI ST command. The SE4000
responds with either No Faults, if none are present, or one or more fault messages.

For example, to view current faults, issue the FM CURR_L| ST command. The remote unit
displays:

Current Faults (LIST) 16: 25: 43 08/ 21/ 2001

PHYS. A DS3 Red I ndi cat or
The query response shows:

e The type of information queried — current faults
e The time the query was issued — 16: 25: 43

e The day the query was issued — 08/ 21/ 2003

e Alisting of all current faults

Individual faults do not include a time tag since they were occurring at the time the query was
issued, in this example at 16:25:43 on 08/21/2003.

To determine the time that the fault initially occurred, you must query the fault history log. For
example, the red indicator could have occurred prior to 16:25:43 on this day.

6.3 Fault History Log

The fault history log is more than just a list of current faults that have occurred over a period of
time. The SE4000 can detect a variety of other hardware and operational faults that are not
reported as current faults. These faults are stored in the fault history log in addition to any current
faults that have occurred.

The SE4000 fault history log records up to 20 repeated occurrences of the same fault condition.
The SE4000 stops logging faults after they occur more than 20 times. The SE4000 saves all
faults in the fault history log until the fault history log is cleared by selecting Clear from the Faults
submenu or issuing the remote command FM LOG_CLR.
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6.3.1 Viewing Fault History Log on the Front Panel
To view the fault history log on the front panel, perform these steps.

1. From the main menu, select the Status menu.

SE4000 >

QUICKSET SERVICE OUTPUT [STATUS]

2. The Status menu displays. Select History.

SE4000/Status >

Current [ History] Relay

3. The History menu displays similarly to the current fault list.

SE4000/Status/History 12 >

Digital Video Loss of Input

4. Pressing the right arrow will enable the Fault History clear operation.

SE4000/Status/History >

Press Enter to Clear Fault History List

5. Press Enter to clear the Fault history log.

6-4 01-0934-401-E



SE4000 MPEG-2 Contribution Encoder Troubleshooting

6. To view all faults in the history log, use the up or down buttons. Faults stored in the fault
history log are displayed on the front panel LCD in ASCII string format and consist of:

e Atime tag.

e The name of the fault.

e For example, at 3:23 pm, the input source to the video encoder was interrupted. The
fault history log, when queried, would display:

o 15:23:17 VI.x Loss of input. Where:

e 15:23:17 isthe time tag.

e VI.x Loss of |nput isthe name of the fault.

6.3.2 Viewing the Fault History Log Using a Remote Unit

To view the fault history log with a remote unit, issue the FM LOG_LI ST command. The unit
responds with either No Faul t s if none are present, or one or more fault messages.

The remote unit displays the fault history log beginning with the time and day tag followed by the
fault descriptor.

For example, assume that the current day is August 21, 2003, at 4:25 pm. The status LED is
illuminated. The fault history log is queried. The FM LOG_LI ST command is issued. The remote
terminal displays the following information:

Fault Log at 16:25:43 08/21/2003

15:23:17 08/21/2003, VI.x Loss of Input
08: 57: 39 08/20/2003, VI.x Loss of Input

The query response shows:

The type of information queried: f aul t | og

The time the query was issued: 16: 25: 43

The day of the year the query was issued: 08/ 21/ 2001
A listing of all faults in the fault history log

6.4 Fault Relay Monitoring

The Form-C fault relay is a real-time indicator for specific fault conditions. The relay contacts are
passive.

A Form-C relay has a common contact (C) and two other contacts (A and B). Normally the
common contact is connected to A and not to B.

When the relay is indicating a fault condition, the common contact C is connected to B and not to
A. this relay indicated a fault condition when power has failed. A power failure, power switch
turned off, or an unplugged unit is defined as a fault condition.

When the fault relay detects a fault condition, the fault relay trips and the Status LED illuminates
red.
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Once a fault condition sets the fault relay and illuminate the status LED on the front panel, they
must be cleared manually by either:

e Selecting the front panel Status>Relay>Clear option.
e Issuing a remote FM RELAY_CLR command.

6.4.1 Viewing Fault Relay Log on the Front Panel

The Relay fault History works similarly to the History and Current menus. To view the fault history
log on the front panel, perform these steps.

1. From the main menu, select the Status menu.

SE4000 >

QUICKSET SERVICE OUTPUT [STATUS]

2. The Status menu displays. Select Relay.

SE4000/Status >

Current History [ Relay ]

3. The Fault Relay menu displays. You may scroll through the fault list displayed in a
similar manner to the fault history described above.

SE4000/Status/Relay >

Digital Video Loss of Input

4. The LCD displays the most recent faults. In order to clear rthe fault relay, you must press
the right arrow. The display will be as below.

SE4000/Status/Relay >

Press enter to Clear Fault Relay List

5. Pressing enter will reset the fault relay and clear all of the faults saved in the list. If no
faults exist, the LCD displays No Faul t .
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SE4000/Status/Relay >

No Faults

6.5 Initialization Self-Test Function

In addition to internal fault monitoring, the SE4000 microcontroller performs built-in-self-tests
(BIST) automatically during the initialization process. If a failure is detected, the LCD displays an
error message to alert the user to the problem. The error messages are displayed in the same
format as faults.

If the SE4000 did not display an error message during initialization, but is not operating properly,
perform the following diagnostic steps.

1. Verify that the SE4000 is configured correctly for your requirements.
2. If your system is configured properly, but still not operating correctly, issue the front panel

Qui ckSet >DVB>Ent er command or the CM RESTORE DVB remote command to reset
the SE4000 to the defaults.

3. Reset any site specific custom configuration parameters.

4. If the SE4000 is still not operating properly, query the current faults to determine if a
current fault exists. Correct all current faults.

5. Query and review the fault history log. Correct all faults, if possible.

6. Record the fault history.

If your SE4000 continues to fail, contact the Radyne ComStream Customer Support Department
for assistance.

6.6 Fault Summary

Most SE4000 faults are non-critical, informational faults. When faults occur, perform the following
steps:

1. If the unit is functioning normally, clear the faults and continue operations.
2. If the unit continues to fail:

e Reset the box to the defaults

e Configure the unit to site specific parameters.

o If the unit is still not operating properly, query the current faults to determine if a
current fault exists. Correct all current faults.

e Query and review the fault history log. Correct all faults, if possible.

e Clear all faults.

¢ Query the current faults and fault history log.

If the unit continues to fail, record the fault history and contact the Radyne ComStream Customer
Support Department for assistance.
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All SE4000 faults, whether current faults, faults listed in the fault history log, or faults that cause
the fault relay to trip, are listed in alphabetical order in the following table:

SE4000 Fault Summary

Description Fault Relay | Action Required
Trigger
Audio A Initialization Yes
Audio A AES/EBU Input Loss No Check the input connection
Audio A AES/EBU Invalid Input No Verify audio format
Audio A Sample Rate Mismatch No Verfiy sample rate settings
Audio A AC3 Input Loss No Check the input connection
Audio A AC3 Input Error No Check AC3 configuration
Audio A SDI Group does not Exist No Check SDI embedded audio configuration
Audio A SDI Pair does not Exist No Check SDI embedded audio configuration
Aduio A SDI FIFO Overflow Error No Check SDI embedded audio configuration
Audio A SDI FIFO Underflow No Check SDI embedded audio configuration
Audio A SDI DATA Count Count Error No Check SDI embedded audio configuration
Audio A PES FIFO Overflow Error No Power cycle the unit
Audio A PES FIFO Underflow No Power cycle the unit
Audio A DSP Compression Error No Power cycle the unit
Audio A DSP Stack Error Yes Power cycle the unit
Audio B Initialization Error Yes Power cycle the unit
Audio B AES/EBU Input Loss No Check the input connection
Auido B AES/EBU Invalid Input No Verify audio format
Audio B Sample Rate Mismatch No Verfiy sample rate settings
Audio B AC3 Input Loss No Check the input connection
Audio B AC3 Input Error No Check AC3 configuration
Audio B SDI Group does not Exist No Check SDI embedded audio configuration
Audio B SDI Pair does not Exist No Check SDI embedded audio configuration
Audio B SDI FIFO Overflow Error No Check SDI embedded audio configuration
Audio B SDI FIFO Underflow Error No Check SDI embedded audio configuration
Audio B SDI DATA Count Error No Check SDI embedded audio configuration
Audio B PES FIFO Overflow Error No Power cycle the unit
Audio B PES FIFO Underflow Error No Power cycle the unit
Audio B DSP Compression Error No Power cycle the unit
Audio B DSP Stack Error Yes Power cycle the unit
Modulator Initialization Error Yes Power cycle the unit
Modulator +5v Alarm Yes Power cycle the unit
Modulator +12v Alarm Yes Power cycle the unit
Modulator —12v Alarm Yes Power cycle the unit
Modulator Frame Sync No Power cycle the unit
Modulator Modulator Fifo No Power cycle the unit
Modulator Oversample Alarm No Power cycle the unit
Modulator FPGA Configuratin Yes Power cycle the unit
Modulator IF Synth Alarm Yes Power cycle the unit
Conditional Access Initialization Error No Power cycle the unit
Analog Video Initialization Error No Power cycle the unit
Analog Video Loss of Input No Verify input connection
Analog Video Timebase Error No Verify correct frame rate and format
Analog Video Format Mismatch No Verify correct frame rate and format
Analog Video Input Level Small No Verify input connection
Analog Video Input Level Large No Verify the input connection
Digital Video Initializaiton Error Yes Power cycle the unit
Digital Video Loss of Input No Verify the input connection
Digital Video SDI FIFO Underflow No Verify SDI signal integrity
Digital Video SDI FIFO Overflow No Verify SDI signal integrity
Digital Video SDI Sync Error No Verify SDI signal integrity
Digital Video SDI EDH Error No Verify SDI signal integrity
Digital Video Timebase Error No Verify SDI signal integrity
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Video Enc. Initialization Error Yes Power cycle the unit

Video Enc. Video timestamp drift No Power cycle the unit

Video Enc. ATSC CC No Verify Closed Captioning present in input
Teletext Internal FIFO Error No Verfiy teletext has correct configuration
Teletext LPC Error No Verfiy teletext has correct configuration
Teletext VBI Parity Error No Verfiy teletext has correct configuration
Teletext Hamming Error No Verfiy teletext has correct configuration
Teletext TVP Word Count No Verfiy teletext has correct configuration

6.7 Fault Summary

The following troubleshooting tips were designed to help diagnosing and correcting minor
operational problems in the unlikely event that there are difficulties encountered with the SE4000.
If all of suggested solutions are tried and the unit still fails, contact the Radyne ComStream
Customer Service Department.

Front Panel Symptoms

Problem: The front panel is not enabled, is in view-only mode, does not accept commands or button
pushes.

Solutions:  The front panel may be in lock-out mode. Unlock the front panel.

Problem: No video output from the decoder.

Solutions:  Verify that the video cabling to the encoder is correctly connected.
Verify that the cabling from the decoder to the monitor is correctly connected.
Ensure that the SE4000 is configured for the video input source that is being provided.

Problem: No audio output from the decoder.

Solutions:  Verify that the audio cabling to the encoder is correctly connected.
Verify that the cabling from the decoder to the audio monitor is correctly connected.
Ensure that the SE4000 is configured for the audio input source that is being provided.

Problem: No audio or video output from the decoder.

Solutions:  Data link problem between the encoder and decoder. This could be caused by excessive
satellite noise or other data corruption.

Problem: Green or black stripes across the middle of the video.

Solutions:  Noisy or “dirty” AC power. Change to a “clean” power source, or use an AC power filter or
power conditioner.
Ensure that the input source is in the proper format and conforms to specified input levels.

Remote Unit Monitor Symptoms
Problem: No sign-on message on the remote terminal after power-up.
Solutions:  Ensure that the remote unit and the SE4000 are turned on and plugged into an active AC

outlet.

Verify that the baud rate and parity of the remote unit communications package match the
factory setting of the SE4000 remote control interface. Factory settings are 38400 baud, 8
data, no parity, and 1 stop bit.

Verify that the cable between the terminal, the SE4000, and the Null Modem Adapter are
properly connected.
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6.8 Fault Management

The SE4000 contains a very sophisticated fault management system. The fault system may be
customized by the sophisticated user for their particular requirements. Every defined fault may be
individually enabled or disabled and every fault may be individually defined to affect or not affect
the fault realy. All faults have been pre-defined at the factory. The pre-defined fault masking will
suffice for most customers in most situations. Sophisticated fault mamangement is available for
the advanced user.

The commands associated with Fault management are listed below.

FM TYPES Provides a complete list of all faults defined in the
unit. Included is a description and activation status.
e See below for a sample of the Fault Types
display. Your specific display will vary
based on purchased options and software
revision.
e The Fault ID is a numeric code assigned
to the fault
e Activated — normally all faults are
activated. De-activating a fault will cause
that fault to be ignored.
e Triggers relay — describes whether or not
that particular fault drives the fault relay.
e  Description of the fault.

FMEN_FLT The user enters FM en_flt xx where xx is the Fault
ID to enable that fault

FM EN_FLT The user enters FM dis_flt xx where xx is the Fault
ID to disable that fault

>fm types

This are the Fault Types for the SE400:
Faultid , Activated?, Triggers Relay?, Description:

0 , Active , Ignores Relay , Begin of Fault List

1 , Active |, Triggers Relay, Audio A Initialization Error

2 , Active , Ignores Relay , Audio A AES/EBU Input Loss

3 , Active , Ignores Relay , Audio A AES/EBU Invalid Input

4 , Active , Ignores Relay , Audio A Sample Rate Mismatch

5 , Active , Ignores Relay , Audio A AC3 Input Loss

6 , Active , Ignores Relay , Audio A AC3 Input Error

7 , Active , Ignores Relay , Audio A SDI Group does not Exist
8 , Active , Ignores Relay , Audio A SDI Pair does not Exist

9 , Active , Ignores Relay , Audio A SDI FIFO Overflow Error
10 , Active , Ignores Relay , Audio A SDI FIFO Underflow Error
11 , Active , Ignores Relay , Audio A SDI DATA Count Error

12 , Active , Ignores Relay , Audio A PES FIFO Overflow Error
13 , Active , Ignores Relay , Audio A PES FIFO Underflow Error

14 , Active , Ignores Relay , Audio A DSP Compression Error
15 , Active |, Triggers Relay, Audio A DSP Stack Error
16 , Active , Triggers Relay, Audio B Initialization Error

17 , Active , Ignores Relay , Audio B AES/EBU Input Loss
18 , Active | Ignores Relay , Audio B AES/EBU Invalid Input
19 , Active | Ignores Relay , Audio B Sample Rate Mismatch
20 , Active , Ignores Relay , Audio B AC3 Input Loss
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21 , Active , Ignores Relay , Audio B AC3 Input Error

22 , Active , Ignores Relay , Audio B SDI Group does not Exist
23 , Active , Ignores Relay , Audio B SDI Pair does not Exist

24 , Active , Ignores Relay , Audio B SDI FIFO Overflow Error
25 , Active , Ignores Relay , Audio B SDI FIFO Underflow Error
26 , Active , Ignores Relay , Audio B SDI DATA Count Error

27 , Active | Ignores Relay , Audio B PES FIFO Overflow Error
28 , Active , Ignores Relay , Audio B PES FIFO Underflow Error
29 , Active , Ignores Relay , Audio B DSP Compression Error
30 , Active , Triggers Relay, Audio B DSP Stack Error

31 , Active |, Triggers Relay, Modulator Initialization Error

32 , Active , Triggers Relay, Modulator +5v Alarm

33 , Active , Triggers Relay, Modulator +12v Alarm

34 , Active |, Triggers Relay, Modulator -12v Alarm

35 , Active , Ignores Relay , Modulator Terrestrial Clock

36 , Active , Ignores Relay , Modulator Terrestrial Data

37 , Active | Ignores Relay , Modulator Frame Sync

38 , Active , Ignores Relay , Modulator Modulator Fifo

39 , Active | Ignores Relay , Modulator Oversample Alarm
40 , Active , Triggers Relay, Modulator FPGA Configuration
41 , Active , Triggers Relay, Modulator IF Synth Alarm

42 , Active , Ignores Relay , Conditonal Access Initialization Error
43 , Active | Ignores Relay , Analog Video Initialization Error
44 , Active , Ignores Relay , Analog Video Loss of Input

45 , Active | Ignores Relay , Analog Video Timebase Error
46 , Active | Ignores Relay , Analog Video Format Mismatch
47 , Active , Ignores Relay , Analog Video Input Level Small
48 , Active , Ignores Relay , Analog Video Input Level Large
49 , Active , Triggers Relay, Digital Video Initialization Error
50 , Active , Ignores Relay , Digital Video Loss of Input

51 , Active , Ignores Relay , Digital Video SDI FIFO Underflow

52 , Active , Ignores Relay , Digital Video SDI FIFO Overflow
53 , Active , Ignores Relay , Digital Video SDI Sync Error
54 , Active , Ignores Relay , Digital Video SDI EDH Error

55 , Active | Ignores Relay , Digital Video Timebase Error

56 , Active |, Triggers Relay, Video Enc. Initialization Error

57 , Active , Ignores Relay , Video Enc. Video timestamp drift

58 , Active | Ignores Relay , Video Enc. ATSC CC

59 , Active , Ignores Relay , Teletext Internal FIFO Error

60 , Active | Ignores Relay , Teletext LPC Error

61 , Active | Ignores Relay , Teletext VBI Parity Error

62 , Active | Ignores Relay , Teletext Hamming Error

63 , Active , Ignores Relay , Teletext TVP Word Count

64 , Active , Ignores Relay , Software Update Initiated Notification
65 , Active , Ignores Relay , Configuration Restore Initiated

66 , Active | Ignores Relay , User requested Manual system Reset
67 , Active , Ignores Relay , System Initialization complete Notificat
ion

68 , Active | Ignores Relay , User has changed Date/Time Notification
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Maintenance and Software Upgrades 7

7.0 Maintenance

SE4000 encoders require no periodic or preventive maintenance other than keeping the cooling
fan intake grills free of obstruction.

7.1 Field Software Upgrades

The SE4000 is controlled by a built-in microcontroller equipped with a non-volatile memory that is
used to store configuration settings, operational software, operational firmware, and field
programmable gate array (FPGA) configuration files.

Great care has been taken to provide for simple field software upgrade procedures in the
SE4000. Software upgrades are much simpler for the user than in previous Tiernan encoder
products.

For instructions on performing a field software upgrade, contact a Tiernan Product Support
engineer.
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Technical Specifications !

STANDARD FEATURES

Video Input e PAL (625 line) or NTSC (525 line) formats.
Analog e SMPTE 170M NTSC or ITU-R BT.470-6 PAL-
I/B/D, BNC connector.
Serial Digital e SMPTE 259M SDI @ 270 Mbps, BNC
connector.
Video Processing e MPEG-2 4:2:0 (Main Profile @ Main Level), 1.0
to 15.0 Mbps.

e Horizontal resolutions: 720, 704, 640, 544, 480
and 352 pixels/line.
e Vertical resolutions 240 or 480 lines (NTSC) or
288 or 576 lines (PAL).
¢ 4:3 and 16:9 configurable aspect ratio.
e TBC, AGC, and clamp for composite video
signal restoration.
Vertical Blanking Interval e Proprietary passing of NTSC line 21 closed-
captions (composite or SDI).
e ATSC closed-captions, per A/53 (composite or
SDI).
e DVB Teletext for World System Teletext on
PAL composite video.
Ultra-low latency: 150 ms (encode to decode).
Low latency: 200 ms (encode to decode).
Quality: 350 to 1000 ms (encode to decode).
Two stereo or four independent analog mono
channels on balanced XLR connectors.
e Two AES/EBU digital stereo pairs on 75 Ohm
BNC connectors.
Audio Processing e MPEG-1 Layer Il
e Two stereo channels or four independent mono
channels
e Sampling rates of 32, 44.1 and 48 Ksps
e Output rates from 64 to 384 Kbps.
Auxiliary Data ¢ One synchronous: 1 to 20 Mbps, resolution 1
bps, EIA-422, on female DB-9 connector.
e One asynchronous: 1200 to 115 Kbps, EIA-
232, on female DB-9 connector.

Latency

Audio Inputs

Control Tables e Internally generated DVB-compatible PSI/SI
tables.

Conditional Access e PGCA proprietary conditional access,
enable/disable IRDs from front panel or remote
control.
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Timing
Transport Output

Front Panel Control

Remote Control

Fault Monitoring
Software Upgrade

Physical

Power Supply

Operating Conditions

OPTIONAL FEATURES
Video Processing

Audio Input
Built-In Test

Modulator Output

Lip synchronization adjustment £500 ms.
MPEG-2, DVB-compliant transport stream.
Two DVB ASI outputs (75Q BNC connectors), 1
to 80 Mbps, in units of 1 bps.

Back-lit, full-travel push buttons; three special
purpose buttons: Carrier, Modulate, Status.
Recessed AC power switch on the front panel.
Backlit 2 x 40 LCD display.

24 user-programmable preset configurations.
EIA-232 on male DB-9 connector (DTE), ASCII
commands.

IEEE 802.3 10/100Base-T (Ethernet) on RJ-45
connector, ASCIl commands via Telnet.
Contact closure for alarm conditions on RJ-11
connector.

Compact flash, EIA-232 remote port, Ethernet
remote port.

1U high, rugged chassis suitable for mobile
operations, 19” rack-mount, 17.7” (45 cm) deep.
Weighs less than 5.5 kg (12 Ib)

Autoranging 90 to 240 VAC, 50/60 Hz, 70 W
typical consumption

-10° to +50°C, up to 95% humidity, non-
condensing.

Redundant fans with fault monitoring.

MPEG-2 4:2:2 (Studio Profile @ Main Level),
2.5 to 50 Mbps..

DVB 4:2:2 expanded windows carries WSS,
VPS, VITC, CC, AMOL, XDS, NABTS, and
others.

Field upgradeable from 4:2:0 to 4:2:2.

Spatial and temporal pre-filtering for
compression efficiency and noise reduction.
Two AES/EBU digital stereo pairs embedded in
SDI, 48 Ksps sample rate.

Internally generated audio test tone and video
test pattern.

DVB-compliant QPSK (optional 8PSK and
16QAM)

Symbol rate 1 - 30 Msps.

IF output 50 - 180 MHz , 0 to -25 dBm, 75Q
BNC.

L-Band output 950 - 1750 MHz, 0 to -25 dBm,
SMA connector (950 - 2050 MHz option).

IF or L-Band monitor output F-connector.
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Conditional Access o BISS (Basic Interoperable Scrambling System)
Modes 1, and E Contact closure for
programmable alarm conditions on an RJ-11
connector.
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VBI Data Transmission

The Tiernan SE4000 and the latest series of Tiernan decoders, such as the TDR60, can be
configured to transmit various types of Vertical Blanking Interval (VBI) data when it is present in
the input video.

The following encoders and decoders support one or more methods for transmitting VBI data:

e SE4000 software V1.61 and TE6000 — software V2.21 or later
e TDRG60 — software V4.10 or later

A standard NTSC TV signal consists of 525 horizontal lines, referred to as a frame. Each frame is
divided into two fields, each with 262 7% lines. The first 21 lines of each field are the VBI region;
the remaining lines contain the active video picture.

A standard PAL TV signal consists of 625 horizontal lines, referred to as a frame. Each frame is
divided into two fields, each with 312 %z lines. The first 22 lines of each field are the VBI region;
the remaining lines contain the active video picture.

For standard NTSC and PAL video encoding, the first 6 lines of the VBI region contain vertical
timing pulses. VBI data is not allowed on these lines, however the remaining lines in the VBI
region are available to carry any type of data.

B.0 MPEG and VBI

Typical forms of data included in the VBI of broadcast video transmissions are World System
Teletext (WST), VPS, WSS, NABTS, Closed Captions, XDS, AMOL, Vchip, and VITC. Originally,
the MPEG video compression scheme discarded all VBI information and included only the
compressed, active video portion of the picture for transmission. This caused all VBI data to be
lost when the video was digitally compressed for transmission using MPEG. Today, however,
enhancements to the original MPEG compression system have provided two methods for
including VBI data in digital-compressed MPEG streams:

e The first method is to extract the data from the baseband video input and insert that data
digitally into the transport stream as either a dedicated PES stream on a dedicated PID,
as in DVB-Teletext, or as an extended data field in the video frame header information as
in ATSC-CC.

e The second method is to shift, or expand, the active video portion of the picture to include
the VBI lines in the compressed picture frame, as in DVB 4:2:2 expanded windows.

For either of these methods to work, it is required that both the encoder and decoder are:

e Functionally capable of processing the required video.
e Correctly configured, either manually or via auto-sensing functionality, for the employed
VBI method.

All of the VBI schemes described in this document, with the exception of Tiernan Proprietary
Closed Captions, adhere to industry standards and formats, defined either by ATSC or DVB.
Tiernan equipment does inter-operate with all other vendor’s equipment that is found to be
compliant with these industry standards.
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Tiernan’s TE6000 and SE4000 encoders and the TDR60 decoder can process data contained in
the VBI region of a video signal according to the following methods and standards:

o DVB-Teletext: — DVB standard for transmission of World System Teletext (WST) included
on a composite analog PAL format video signal.

e ATSC-CC - ATSC standard for transmission of Line 21 closed captions included on a
composite analog NTSC format video signal.

e Tiernan-CC — A Tiernan proprietary scheme for transmission of Line 21 closed captions
included on a composite analog NTSC or component digital (525) format video signal.

e DVB 4:2:2 Expanded Windows — DVB standard for transmission of 16 or 32 lines of VBI
data included on a composite analog or component digital (SDI) format video signal. This
standard supports both PAL/625 and NTSC/525 format video standards.

B.1 System Configuration
This section describes system configuration for successful end-to-end processing of VBI data for
each VBI scheme. For a detailed description of the front panel or remote commands used to

implement the various VBI schemes, refer to the appropriate command sections found in this
manual.

B.1.1 DVB Teletext

Tiernan encoders and decoders process VBI teletext data within a video signal according to WST
standards. Teletext is supported on composite analog PAL format video signal only.

B.1.1.1 Hardware Requirements

All SE4000 Encoders support all VBI modes. TE6000 Encoders require a TVIP-6025 module.
The TDR60 decoder processes VBI data in its standard configuration.

B.1.1.2 Operational Considerations

VBI teletext should not be enable with other VBI encoding formats, as teletext overwrites all other
VBI data.

B.1.1.3 End-to-End Configuration

To configure the encoder and decoder for Teletext processing, follow these steps:

Encoder
1. Ensure that Teletext VBI data is included in the selected service video input signal.
2. Ensure that the video input source is set to auto or analog. Use the front panel command

Config>Service>Video>Input Source or the remote VI FMTCTL command.

3. Set the encoder to PAL mode. Issue the front panel command Config>Service>Video>
Format Ctrl=PAL or the remote VI FMTCTL PAL_N command.

4. Enable the encoder for Teletext processing. Issue the front panel command
Config>Service >VBI>Teletext>Enable=All or the remote. TT ENABLE ALL command.
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5. Set the data ID to 1. Issue the front panel command Config>Service>VBI>Teletext>Data
ID=1 or the remote TT DATA_ID 1 command.

6. Set the data unit ID to 2 or 3 as appropriate. Issue the front panel command
Config>Service>VBI>Teletext>Data Unit ID=# or the remote TT UNIT_ID # command
(where # = 2 or 3).

Decoder

7. Set the decoder VBI format control to manual. Issue the front panel command
VBI>Format>VBI Format Cntrl=Manual or the remote VBI CONTROL MANUAL
command.

8. Set the VBI format to off. Issue the front panel command VBI>Format>VBI Format= Off

or the remote VBI FORMAT OFF command.

To ensure the proper display of Teletext data, VBl Format must be set to
Off.

9. Enable Teletext mode. Issue the front panel command VBI>Teletext>Mode=0n or the
remote VBl TELETEXT MODE ON command.

10. Set the type of Teletext standard to be decoded, either the DVB standard or a vendor’s
proprietary standard. Issue the front panel command VBI>Teletext>Standard=type or the
remote VBl TELETEXT STANDARD TYPE command.

11. To specify a particular PID within the selected service that contains Teletext data. Issue

the front panel command VBI>Teletext>PID=PID number or the remote VBI TELETEXT
PID NUMBER command.

B.1.2 ATSC Closed Captions

Tiernan encoders and decoders support industry-standard ATSC EIA-608 closed captions. On
the encoder side, ATSC closed captions, the data found on line 21 is stripped out, placed in the
picture header, encoded and transmitted. At the decoder end, the data is processed and re-
inserted on line 21 for proper broadcasting.

ATSC closed captions are supported on a composite analog NTSC format video signal.

B.1.2.1 Operational Considerations

Ensure that VBI teletext is disabled when closed captions are enabled, as teletext overwrites all
other VBI data.

B.1.2.2 End-to-End Configuration
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To configure the encoder and decoder for ATSC closed captioning, follow these steps:
Encoder

1. Ensure that Teletext is disabled. Issue the front panel command
Config>Service>VBI>Teletext>Enable=off or the remote TT ENABLE OFF command.

2. Ensure that closed caption VBI data is included in the selected service video input signal.

3. Enable the encoder for ATSC closed captions. Issue the front panel command
Config>Service>VBI>CC=0n or the remote VE ATSC_CC ON command.

Decoder

4. The set-top box should automatically detect and process ATSC closed captions.

B.1.3 Tiernan Proprietary Closed Captions (Tiernan CC)

Using Tiernan proprietary closed captions, two lines of VBI information are encoded per frame
(one per field) at the expense of losing two lines of active video (one per field). The encoded
picture is simply shifted up one line to include the last line of VBI and to exclude the last line of
active video in each field.

This proprietary mode is intended as a method to transmit line 21 EIA-608 closed captions in an
NTSC system without incurring more bandwidth requirements.

Tiernan proprietary closed captions are supported on a composite analog NTSC or component
digital (525) format video signal.

B.1.3.1 Operational Considerations

Ensure that VBI teletext is disabled when closed captions are enabled, as teletext overwrites all
other VBI data.

B.1.3.2 End-to-End Configuration

To configure the encoder and decoder for Tiernan proprietary closed captioning, follow these
steps:

Encoder

1. Ensure that Teletext is disabled. Issue the front panel command
Config>Service>VBI>Teletext>Enable=off or the remote  TT ENABLE Off command.

2. Ensure that closed caption VBI data is included in the selected service video input signal.

3. Enable the encoder for Tiernan closed captions. Issue the front panel command
Config>Service>VBI>Tiernan CC=0n or the remote VE TCC ON command.
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Decoder

4. Ensure that Teletext mode is set to off. Issue the front panel command
VBI>Teletext>Mode=0ff or the remote VBI TELETEXT MODE OFF
command.

5. Set the decoder VBI format control to automatically detect the type of VBI data to decode.

Issue the front panel command VBI>Format>VBI Format Cntrl=Auto or the remote
VBI CONTROL AUTO command.

6. If your system requires you to manually set the type of VBI data to decode, follow these
steps:

a. Set the decoder VBI format control to manual. Issue the front panel command
VBI>Format>VBI Format Cntrl=Manual or the remote VBl CONTROL MANUAL
command.

b. Set the VBI format to Tiernan closed captions. Issue the front panel command

VBI>Format>VBI| Format=Tiernan CC or the remote VBI FORMAT TIERNANCC
command.

B.1.3.3 DVB 4:2:2 Expanded Windows, 16-Line and 32-Line

Tiernan encoders and decoders support both 16- and 32-line expanded windows operations. As
with normal video encoding, the first 6 lines of the VBI region contain timing set-up information.
Expanded Windows use the remaining lines in the VBI region, either 16 or 32 per frame (8 or 16
per field), to transmit data.

DVB 4:2:2 Expanded Windows is supported on a composite analog or component digital (SDI)
format video signal. This standard supports both PAL/625 and NTSC/525 format video standards,
and can transmit any of the following VBI services:

PAL mode: Teletext, PDC, WSS, and VPS

NTSC mode: ATSC Closed Captions, V-Chip, AMOL | and Il, and VITC

B.1.3.4 Operational Considerations

Ensure that both VBI teletext and closed captions are disable when either 16- or 32-line
expanded windows are enabled, as teletext and closed captions overwrite expanded windows
data.

Chroma must be set to 4:2:2 for proper expanded windows operations.

B.1.3.5 Hardware Requirements

The TDR60 decoder processes VBI data in its standard configuration.

B.1.3.6 End-to-End Configuration

To configure the encoder and decoder for DVB 4:2:2 Expanded Windows operation, follow these
steps:

Encoder
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1. Ensure that all other VBI schemes are disabled, including Teletext, ATSC closed
captions, and Tiernan closed captions.

2. Ensure that VBI data is included in the selected service video input signal.

3. Set chroma to 4:2:2 mode. Issue the front panel command
Config>Service>Video>Chroma=4:2:2 or the remote VE CHROMA 4_2 2 command.

4, Configures the encoder to transmit either 16 or 32 lines of VBI information. Issue the
front panel command Config>Service>VBI>Expand> VBI_Passthru=type or the
remote VE VBI_PASS type command, where type is set to 16_lines or 32_lines.

Decoder

5. Ensure that Teletext mode is set to off. Issue the front panel command
VBI>Teletext>Mode=0ff or the remote VBI TELETEXT MODE OFF command.

6. Set the decoder VBI format control to automatically detect the type of VBI data to decode.
Issue the front panel command VBI>Format>VBI Format Cntrl=Auto or the remote
VBI CONTROL AUTO command.

7. If your system requires you to manually set the type of VBI data to Expanded Windows,
follow these steps:

a. Set the decoder VBI format control to manual. Issue the front panel command
VBI>Format>VBI Format Cntrl=Manual or the remote VBl CONTROL MANUAL
command.

b. Set the VBI format to either 16- or 32-lines Expanded Windows.

From the front panel, issue the command VBI>Format>VBI Format=# where # is set to 16-line or
32-line.

From a remote terminal, issue the command VBl FORMAT # where # is set to lines16 or lines32.
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B.4 Decoder Command Listing

B.4.1 Front Panel Commands for Decoder Configuration

The following front panel commands are used to configure the decoder for VBI teletext.

TDR60 Decoder VBI Front Panel Menu

Menu>SubMenu | Description

| Parameters or Response Format

VBI>Teletext: used to set the teletext parameters.

inversion of teletext data.

Active Line Query only, displays the Displays either:
number of the first active line e No active lines.
of teletext received. The number of first active line received.

Mode Providing that teletext is e On - Teletext data is included in the video
available in the selected output stream.
service, the Mode function e  Off - Teletext data is not included in the video
allows the option of having output stream (default).
teletext data in the video Note: to ensure proper display of teletext,
output stream. VBI>Format>VBI Format must be set to Off.

PID Selects the teletext PIDs List of teletext PIDs available in the selected service.
available in the selected
service. The TDR60
automatically selects the fires
PID available in the selected
service.

Standard Sets the inversion or non- o DVB - sets DVB teletext standard (default).

e Proprietary - sets proprietary teletext standard.

VBI>Format: used to set the teletext parameters.

VBI Format Providing that the selected VBI
information is available in the
selected service. This
command determines if the
data will be included in the
video output stream.

Note: this command is
query-only when
VBI>Format>VBI Format

Cntrl is set to Auto.

e Off - VBl mode is disabled (default).

e Tiernan CC - Tiernan proprietary closed
caption information will be included.

e Lines 16 - Expanded windows lines-16
information will be included. For PAL modes,
this includes VBI information found in lines 15
to 22. In NTSC mode, this includes VBI
information in lines 14 to 21.

e Lines 32 - Expanded windows lines-32
information will be included. For PAL modes,
this includes VBI information found in lines 7 to
22. In NTSC mode, this includes VBI
information in lines 7 to 21.

VBI Format Cntrl | Setting determines if the
TDRG60 will automatically
detect incoming VBI data or if
the VBI format will be manually

configured by the operator.

e Auto - TDR60 automatically detects the format
of the incoming VBI information. When Auto is
selected, VBI>Format>VBI Format is query-
only.

e Manual - enables the operator to manually
configure the VBI format (default).
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B.4.2 Remote Commands for Decoder Configuration

The following front panel and remote commands are used to configure the decoder for VBI

teletext.
Remote Parameter Range Description
Command
Mnemonic
VBI CONTROL Auto, Manual Setting determines if the TDR60 will automatically
detect incoming VBI data or if the VBI format will be
manually configured by the operator.
e Auto - TDR60 automatically detects the format
of the incoming VBI information.
e Manual - enables the operator to manually
configure the VBI format (default).
VBI FORMAT Off, TiernanCC, Lines16, Provided that VBI information is available in the

Lines32

selected service, this command determines if the

data will be included in the video output stream.

Note: this command is query-only when VBI

FORMAT is set to AUTO.

e Off - VBl mode is disabled (default).

e Tiernan CC - Tiernan proprietary closed
caption information will be included.

e Lines 16 - Expanded windows lines-16
information will be included. For PAL modes,
this includes VBI information found in lines 15
to 22. In NTSC mode, this includes VBI
information in lines 14 to 21.

e Lines 32 - Expanded windows lines-32
information will be included. For PAL modes,
this includes VBI information found in lines 7 to
22. In NTSC mode, this includes VBI
information in lines 7 to 21.

VBI TELETEXT
LINES

Query-only, displays a list of the teletext lines
detected in the selected service or the message no
active lines when teletextis not present.
Available only when VD MODE is set to NTSC.
Front panel equivalent: VBI>Active Line

VBI TELETEXT
MODE

On, Off

Provided that teletext data is available in the
selected service, this function determines if teletext
data will be included in the output stream.

e  On - data will be included.

e  Off - data will not be included (default).
Teletext is only available when VD MODE is set to
PAL.

Note: this command is query-only when VBI
FORMAT is set to AUTO.

Front panel equivalent: VBI>Mode

VBI TELETEXT
PID

<available PIDs> or Off

Selects the teletext data PID from the selected
service. To query the available PIDs, enter the
command VBI TELETEXT PID?

Available only when VD MODE is set to PAL.
Front panel equivalent: VBI>PID

VBI TELETEXT

DVB, Proprietary

Sets the inversion or non-inversion of teletext data.

STANDARD e DVB - sets DVB teletext standard (default).
Proprietary - sets proprietary teletext standard.
Available only when VD MODE is set to PAL.
Front panel equivalent: VBI>Standard
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Conditional Access C

C.0 Conditional Access Overview

Conditional access (CA) is a method for securing and scrambling transmission streams so that
only those decoders which are authorized to do so can receive the transmitted streams.

The SE4000 provides two methods for conditional access:

e BISS - an industry-standard scheme which allows full conditional access operability
between various vendor's DSNG equipment

e PGCA — a Tiernan proprietary scheme providing conditional access within the Tiernan
family of products

C.1 BISS Overview

BISS, the Basic Interoperable Scrambling System, is an industry-standard, conditional access
scheme used to secure and scramble DSNG broadcasts while allowing full inter-operability
between various vendor's DSNG equipment.

The SE4000 currently supports BISS Mode 0, 1, and E scrambling. With Mode 1, all components

of the transmission stream are scrambled by a fixed control word (CW). The control word must be
manually entered into the encoder and decoder for BISS operations.

C.2 High-Level BISS Procedure

BISS is managed and enabled at an individual service level. To configure the SE4000 for BISS
operations, follow these steps:

1. Select the service for BISS conditional access.
2. Enable BISS for that service.
3. Enter the Scramble key.

C.3 Configuring BISS from the Front Panel

To configure the SE4000 for BISS operations, follow these steps:
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Select a Service

1. From the main menu, select Config>CA>Setup>Service. A list of all available services
displays.

If only one service is available, the service parameter is query-only, as this one service is
automatically selected.

2. Scroll through the list to select the service to be configured for BISS scrambling and
press Enter. The Scramble menu displays.

3. Ensure that the correct service name displays in the menu line. If the displayed service is
incorrect, return to Step 1.

Enable BISS for that Service

4, From the Scramble menu, select BISS Mode 1 and press Enter.

5. When the asterisk disappears, press the right arrow key to go to the BISS key parameter.
Enter the Scramble Key

6. Use the numeric keypad to enter the 12-digit key. Once all 12 digits are entered, the key
will begin to flash. Press Enter.

7. When the asterisk disappears, the BISS configuration settings are immediately
implemented for that service.

Continue to Enable and Disable Individual Services, as Required
8. Continue selecting services and enabling/disabling each as required.
SE4000 is Now Processing Data Using the Current BISS Configuration

9. BISS is now enabled and will continue to use the current BISS configuration until BISS is
disabled (turned off) or the BISS configuration is changed.

Disable BISS for an Individual Service

To disable BISS for a selected service, perform these steps:

1. From the main menu, select Config>CA>Setup>Service. A list of all available services
displays.
2. Scroll through the list to select the service to be configured for BISS scrambling and

press Enter. The Scramble menu displays. Ensure that the correct service name
displays in the menu line.

If the displayed service is incorrect, return to step 1.
3. From the Scramble menu, select None and press Enter.
4. Conditional access is now disabled for the selected service.

Even though BISS conditional access may be disabled for a service, the SE4000 retains the BISS
scramble key set for that service.
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C.4 Configuring BISS from a Remote Unit

Before beginning to configure the encoder for BISS conditional access, remote unit with a

communications program installed, such as ProComm must be present.

Connect to a Remote Unit

1.

2.

Ensure that the remote unit has a communications program installed, such as ProComm.
Connect an RS-232 cable from the PC COM port 1 to the SE4000 RS-232 port.

Start the ProComm software. Configure ProComm to communicate via COM port 1 at a
baud rate of 38400 bps.

Power on the encoder.

Wait for the main menu to display on the encoder’s front panel.

ProComm should display various messages and then end with the prompt >.

If the > prompt does not display, flip the DCE/DTE switch on the back of the SE4000 to

the other position. Press the Enter key on the keyboard several times. The > prompt
should display .

Configure BISS Parameters

1.

Review the current BISS configuration parameters for all active services. Type mux
prog_info and press Enter. The current conditional access settings for all services is
displayed. Information includes: program number, program name, previous scrambling
mode, current scrambling mode, and the key.

Enable BISS for a service. Type mux scram_en <service#> mode_1 and press Enter.
This command enables BISS scrambling mode 1 for the service number entered in the
<service#> parameter.

Enter the Scramble key for the selected service. Type mux scram_key <service#> <key>
and press Enter. This command sets the BISS scrambling key for the service number
entered in the <service#> parameter. The key is a 12-digit hexadecimal number.

Disable BISS for any services, as required. Type mux scram_en <service#> off and
press Enter.

Review the current BISS configuration parameters for all active services to ensure that all
BISS settings are correct. Type mux prog_info and press Enter.

Enable BISS at the system level. Type mux biss_en on and press Enter.

BISS cannot be enabled if PGCA is enabled.
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Save the Current BISS Configuration

7. Save the current BISS configuration to either:
e Flash memory using the CM Save command.
e A user-defined configuration set, using the cm create and cm save_cfg commands.

Any parameter changes, including conditional access changes, that are made using a remote unit
are not automatically stored in flash memory. When the SE4000 configuration is changed using a
remote unit, an operational test should be performed to verify that the system is operating
correctly. Then the new configuration should be saved by issuing the cm save command.

If the SE4000 is reset, or looses power prior to issuing the cm save command, any changes
made using the remote unit will not be restored. Instead, the SE4000 restores the last changes
saved to flash memory. Once the configuration is saved using the cm save command, the
SE4000 automatically restores the saved settings when the unit is reset or powered up.

To Disable BISS

For a Service

Type mux scram_en <service#> off and press Enter.
C.5 Tiernan PGCA Overview

At the System Level

Type mux biss_en off and press Enter.

PGCA (Privacy Guard Conditional Access) is a Tiernan-proprietary conditional access scrambling
system supported by all Tiernan DVB-compatible encoders and decoders.

PGCA is a fixed key scrambling system that is addressable. This means that the scrambling key
is included in the transport stream, along with the list of individual decoder addresses authorized
to descramble the transmission.

Using PGCA allows the uplink to control which decoders are authorized to receive the
transmission, and what key is used to scramble the stream. The decoders automatically receive
and process the authorization list. If they are authorized to receive the transmission, they extract
the key and use it to descramble the service. If they are not authorized, they do not descramble
or decode the service, and there is no output of video or audio from the decoder.

Although this is a fixed key system, the addressability and in-band transmission of all information
required to authorize and descramble the service is very powerful for controlling groups of IRDs
and the services they are allowed to receive, without compromising the security by distributing the
scrambling key in the clear to the decoders. The “fixed” key is programmable and can be
changed by the uplink encoder operator if desired.

Managing the key and the decoder authorization list is simple to do using the encoder front panel
menu or remote control commands. No control computer or special software is necessary.
PGCA is included in all Tiernan DVB-compliant encoders and decoders as a standard feature, so
there are no additional costs to use PGCA in a system.
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C.6 High-Level PGCA Overview

PGCA is managed at an individual IRD level and enabled at the system level. To configure the
SE4000 for PGCA operations, follow these steps:

1. Manage the IRD List.

a.

b.

c.
d.

Review the IRD conditional access list to ensure that all IRDs are listed and that

all IRD information is correctly.

Add IRDs to the conditional access list, as needed.

A decoder's MAC address is required in order to create an authorized decoder

database. This address must be entered in the following 16-character

hexadecimal format. The SE4000 automatically enters the decimal points:

XXXX XX XX XX XX XX XX

If the decoder’'s MAC address is unknown, navigate through the decoder’s front

panel menu to locate the information:

o On the TDR600, TDR77, and TDR777 decoders, the MAC address is
displayed on the System>Status>1D:XXXXXXXXXXXXXXXX menu.

. On the TDR7 and TD3 decoders, the MAC address is displayed on the
System>1D:XXXXXXXXXXXXXXXX menu.

) On the TDRG6 decoder, the MAC address is displayed on the
Control>Network>Addr:xxxxxxxxxxxx menu.
The MAC address on the TDR6 decoder is missing two bytes. To enter
this number into the MAC address field when creating the authorized
decoder database, simply add zeros to the most significant bits, for
example: 00.00.XX.XX.XX.XX.XX.XX

Delete IRDs from the conditional access list, if required

Enable and disable individual IRDs, as appropriate.

2. Enable PGCA at the System Level

e.

Enable PGCA. When PGCA is enabled, all current PGCA configuration settings
are immediately implemented. As the individual IRDs are enabled and disabled,
those configuration settings are immediately implemented as well. If new PGCA
configurations settings are not to be immediately implemented by the SE4000,
Scramble should be set to None. When ready to implement PGCA, set Scramble
to PGCA.

Enter the PGCA Key.

For front panel configurations, PGCA is now enabled and will continue to use the
current PGCA configuration until PGCA is disabled (tuned off) or the PGCA
configuration is changed. As with all other front panel configuration changes,
PGCA changes are automatically saved and immediately implemented.

For remote unit configuration, the new PGCA configuration must be saved.

During PGCA set-up and configuration, signals may be temporarily
unscrambled.
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The high-level procedure for configuring PGCA from the front panel or a
remote unit is the same, however, at the detailed step-by-step level, there
are a few important differences which must be followed. Before
configuring the SE4000 from the front panel or remote unit, carefully read
and follow these instructions.

C.7 High-Level PGCA Overview

Before beginning to configure the encoder for PGCA, the TMA addresses for each of the
decoders must be in the system.

To configure the SE4000 for PGCA, perform the following:
C.7.1 Manage the IRD List
C.7.1.1 Review the IRD Conditional Access List

1. Review the IRD conditional access list to ensure that all IRDs are listed, all IRD
information is correct, and that each IRD are correctly enabled and disabled.

To review the IRD list, select Config>CA>PGCAcfg>LST IRD. The IRD List menu
displays, showing the following information for each IRD: name of the IRD, it's MAC
address, and if it is enabled (on) or disabled (off).

2. Add, deleted, and enable and disable IRDs as needed.

C.7.1.2 Add IRDs to the Conditional Access List, as Needed

3. From the PGCAcfg menu, select ADD IRD. The Name menu displays with the parameter
Name = 0.
4, Enter the name for the IRD using the alpha-numeric keypad and press Enter.

The Enter TMA Address menu displays.

5. Enter the 16-character MAC address for the IRD using the alphanumeric keypad. Press
Enter.
When the information is processed, the system returns to the Name menu.

6. Continue to add all IRDs to the conditional access list.

7. When you have finished adding IRDs to the conditional access list, press Exit to return to
the PGCA menu.
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C.7.1.3 Delete an IRD from the Conditional Access List, if Required

8. From the PGCAcfg menu, select DEL IRD. The IRD Delete menu displays.

9. Use the Up and Down buttons to scroll through the list and select the required IRD.

10. Press Enter. The LCD will display Delete <IRD name> Yes [No]

11. Ensure that the correct IRD name is displayed and select Yes.

12. Press Enter. When the information is processed, the system returns to the PGCA menu.
C.7.1.4 View the IRD Conditional Access List

13. View the IRD conditional access list to ensure that all IRDs are listed and that all IRD
information was correctly entered.

14. From the PGCAcfg menu, select LST IRD. The IRD List menu displays.

For each IRD, the following information is displayed: name of the IRD, it's MAC address,
and if it is enabled (on) or disabled (off).

C.7.1.5 Enable and Disable Individual IRDs
15. From the PGCAcfg menu, select LST IRD. The IRD List menu displays.
16. Use the Up and Down buttons to scroll through the list and select the required IRD.

17. Enable or disable the selected IRD. Use the minus sign (-) on the alpha-numeric keypad
to toggle between On and Off for the selected IRD.

18. Continue selecting IRDs and enabling/disabling each as required.
19. Press Enter. When the information is processed, the system returns to the PGCAcfg
menu.

C.7.2 Enable PGCA at the System Level

C.7.2.1 Enable PGCA

20. From the main menu, select Config>CA>Setup>Service>Scramble>PGCA.
C.7.2.2 Enter the Scramble Key

21. Select PGCA KEY. Type in the key using the alpha-numeric keypad and press Enter.
SE4000 is Now Processing Data Using the Current PGCA Configuration

22. PGCA is now enabled and will continue to use the current PGCA configuration until
PGCA is disabled or the PGCA configuration is changed.

C.7.3 To Disable PGCA at the System Level

To disable PGCA at the system level, select Config>CA>Setup>Service> Scramble>None.
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C.8 Configuring PGCA from a Remote Unit
Before you begin configuring the encoder for PGCA, you must have the following:

e A remote unit with a communications program installed, such as ProComm.
o The TMA addresses for each of the decoders in your system.

C.8.1 Connect to a Remote Unit

1. Ensure that the remote unit has a communications program installed, such as ProComm.
2. Connect an RS-232 cable from the PC COM port 1 to the SE4000 RS-232 port.
3. Start the ProComm software. Configure ProComm to communicate via COM port 1 at a

baud rate of 38400 bps.

4. Power on the encoder.
5. Wait for the main menu to display on the encoder’s front panel.
6. ProComm should display various messages and then end with the prompt >.

If the > prompt does not display, flip the DCE/DTE switch on the back of the SE4000 to
the other position. Press the Enter key on the keyboard several times. The > prompt
should display .

C.8.2 Enable PGCA at the System Level

1. Type tca enable on and press Enter.

PGCA cannot be enabled if BISS is enabled.

C.8.2.1 Enter the PGCA Scramble Key

2. Type tca mask <value> and press Enter.

C.8.3 Manage the IRD List
C.8.3.1 View the IRD Conditional Access List

3. Type tca list and press Enter.
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C.8.3.2 Add IRDs to the Conditional Access List
4. Type tca add <decoder name>@<decoder TMA Address> and press Enter.
Decoder names are limited to 15 characters in length or less. Decoders are automatically

authorized when they are added to the list.

5. Repeat for all required decoders.

C.8.3.3 Delete IRDs from the Conditional Access List

6. Type tca delete <decoder name> and press Enter.
C.8.3.4 Enable Individual IRDs

An enabled, or authorized, decoder will be able to unscramble the incoming transmission from the
encoder.

8. Type tca auth <decoder name> and press Enter.

9. Repeat for all required decoders.
C.8.3.5 Disable Individual IRDs

A disabled, or deauthorized, encoder will not be able to unscramble the incoming transmission
from the encoder.

10. Type tca deauth <decoder name> and press Enter.

11. Repeat for all required decoders.

C.8.3.6 SE4000 is Now Processing Using the Current PGCA Configuration

12. PGCA is now enabled and will continue to use the current PGCA configuration until
PGCA is disabled (tuned off) or the PGCA configuration is changed.

C.8.4 Save the Current PGCA Configuration
13. Save the current PGCA configuration to either:

e Flash memory using the CM Save command.
e A user-defined configuration set, using the cm create and cm save_cfg commands..

Any parameter changes, including conditional access changes, that are made using a
remote unit are not automatically stored in flash memory. When the SE4000 configuration
is changed using a remote unit, an operational test should be performed to verify that the
system is operating correctly. Then the new configuration should be saved by issuing the
CM SAVE command.

If the SE4000 is reset, or looses power prior to issuing the CM SAVE command, any
changes made using the remote unit will not be restored. Instead, the SE4000 restores
the last changes saved to flash memory. Once the configuration is saved using the CM
SAVE command, the SE4000 automatically restores the saved settings when the unit is
reset or powered up.
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C.8.4.1 To Disable PGCA at the System Level

14. Type tca enable off and press Enter.
C.9 Configuring PGCA from a Remote Unit

The following example shows how to add, delete, enable (authorize) and disable (de-authorize)
decoders using a remote unit connected to a SE4000. At the end of the example, the PGCA
configuration is saved to flash memory.

In this example, the following assumptions apply:

1. Two decoders already exist in the database; both are enabled for PGCA. The existing
decoders are:
o decoder1@11.22.33.44.55.66.77.88
e decoder2@22.33.44.55.66.77.88.99

2. Decoder1 will be disabled
3. Decoder2 will be deleted from the database
4, Three new decoders will be added to the database and remain authorized.

C.9.1 Enable PGCA

tca enable on

C.9.2 Enter the PGCA Scramble Key

tca mask <value>

C.9.3 Deauthorize decoder — decoder1 is disabled, or deauthorized

tca deauth decoderl

C.9.4 Remove decoder — decoder2 is deleted from the PGCA database

tca delete decoder?2

C.9.5 Add decoders — three decoders are added to the PGCA database

tca add decoder3@33.44.55.66.77.88.99.00
tca add decoder4@44.55.66.77.88.99.00.11
tca add decoder5@55.66.77.88.99.00.11.22

When decoders are added to the database, they are automatically authorized, or enabled;
therefore, these three new decoders do not have to be authorized using the tca auth command.
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Conditional Access

C.9.6 Review the IRD conditional access list to ensure it is correct

tca list

The SE4000 displays the following:

Decoder 0x586bd0

ID: 11.22.33.44.55.66.77.88
Auth: Deauthorized

Name: decoder1

Decoder 0x586dd0

ID: 33.44.55.66.77.88.99.00
Auth: Authorized

Name: decoder3

Decoder 0x586ad0

ID: 44.55.66.77.88.99.00.11
Auth: Authorized

Name: decoder4

Decoder 0x586¢d0

ID: 55.66.77.88.99.00.11.22
Auth: Authorized

Name: decoder5

C.9.7 The list is correct, save the PGCA configuration changes to flash

cm save
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Default Settings

SE4000 Default Settings

Video Encoder Default Settings

On (analog audio)

Parameter DVB and ATSC Exceptions
Defaults
Data Rate Calc Auto -
Enable On -
Format Mode Auto -
Optimize Quality -
PID 33 decimal -
Resolution 720 -
Data Rate 7.46630 Mbps -
Chroma 4:2:0 -
Timebase Video Input -
Source Analog -
PGCA Off -
Audio Encoder Default Settings
Parameter DVB and ATSC Exceptions
Defaults
Audio Channel A
Enable Off (digital audio) -
On (analog audio)
Compression MPEG -
Data Rate 256 Kbps -
Format Stereo -
PID 36 decimal -
Sample Rate 48 Ksps -
Source Analog -
Lip Sync 0 msec -
Audio Channel B
Enable Off (digital audio) -

01-0934-401-E

D-1



Default Settings

SE4000 MPEG-2 Contribution Encoder

Compression MPEG -
Data Rate 256 Kbps -
Format Stereo -
PID 37 decimal -
Sample Rate 48 Ksps -
Source Analog -
Lip Sync 0 msec -

Aux Data Channels Default Settings

Parameter DVB and ATSC Exceptions
Defaults
Aux Data Async Channel
Enable Off -
Communication Asynchronous -
Mode
Interface RS-232
Baud 38400 bps
Data Bits 8
Parity None
Stop Bits 1
PID 42 decimal
Aux Data Sync Channel
Enable Off -
Interface RS-422 -
Data Rate 102400 bps -
Clock Source Internal -
PID 43 decimal -

D-2
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PSI/SI Tables Default Settings
Parameter DVB and ATSC Exceptions
Defaults
Event Information Table (EIT)
Enable On -
PID 18 -
Transmission Interval 15 dsec -
Network Information Table (NIT)
Enable On -
FEC Convolution 5/6 -
Code Rate
Network 1D 0 -
Network Name MPEG-2 Encoder -
PID 16 -
Satellite Frequency 011.75725 GHz -
Satellite Modulation QPSK -
Scheme
Satellite Orbital 019.2° West -
Position
Sial Polarization Vertical -
Symbol Rate 005.5002 Msps -
Transmission Interval 15 dsec -
Program Association Table (PAT)
Enable On -
PID 0 -
Program Number - 1 (DVB)
2 (ATSC)
Transmission Interval 1 dsec -
Transport Stream ID 1 -
Program Map Table - -
(PMT)
Enable On -
PID 32 decimal -
Transmission Interval 1 dsec -
Service Description Table (SDT)
Enable On -
PID 17 decimal -
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Default Settings
Service Name - Service 1 (DVB)
Ch2 (ATSC)
Service Provider Unnamed -
Transmission Interval 15 dsec -
Enable Off -
PID 20 decimal -
Transmission Interval 100 dsec -

Remote Control Port Default Settings

Parameter DVB and ATSC Exceptions
Defaults
Baud Rate 38400 bps -
Data Bits 8 -
Stop Bits 1 -
Parity None -
Flow Control Software -
XON/XOFF
Communication Full-Duplex -
Method
Network Default Settings
Parameter DVB and ATSC Exceptions
Defaults
IP Address 0.0.0.0 -
IP Mask 225.225.0.0 -
IP Router 0.0.0.0 -

D-4
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Table Top/Rack Mount Installation Instructions E

This appendix presents step-by step instructions for the installation of Tiernan 1U, 2U, and 4U
products. Instructions are presented for installing products:

E NOTE

Instructions are for installation of 1U, 2U and 4U products. A 2U product
is shown for illustrative purposes.

e On atable top
e Using front rack mount brackets
e Using rear rack mount brackets

E.0 Table Top Installation

To install a Tiernan unit on a tabletop or other flat surface, place the unit on a rubber mat or other
material that will prevent the unit from sliding and protect the table top surface.

Ensure that the unit is placed on a stable surface of sufficient size and strength where it will not
be jarred or pushed off its surface. Ensure that all cables and cords are out of the way and that
they will not be tripped over, as this may cause personal injury or serious damage to the unit.

E.1 Rack Mount Installation

To install a Tiernan unit in a standard 19- inch equipment rack using front mounting brackets,
perform these steps:

1. Ensure that there are two brackets and four screws in the front bracket kit. One side of
each bracket has small holes while the other side has large holes. The small holes are
counter-sunk on one side. The side which is not counter-sunk is placed against the unit.
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The 1U unit contains 8 screws in the shipping kit. One side of each
bracket has four small holes while the other side has two large holes.

NOTE

2. Attach the brackets to both sides of the unit:

a. Line up the small holes on the bracket with the unit’'s mounting holes, which are
located towards the front of each side panel.
b. Thread all of the screws through the bracket’s small holes and into the Tiernan unit.
The screws should be flush with the bracket when tightened.

- SE4000 TERveY
o wncn T

3. Mount the unit in the rack by attaching the front brackets to the rack using your own
washers and bolts.

W W |eecoce 7

4. Ensure that the installation provides the minimum required air flow clearances at the
sides and rear of the unit.

E.4 Safety Precautions

If rack-mounted units are installed in a closed or multi-unit rack, consider the following items;
further evaluation by a Certifying Agency may be required.
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E.4.1 Ambient Temperature
The ambient temperature within the rack may be greater than the room’s ambient temperature.

When installing the unit, ensure that the required air flow for safe operation is provided. Never
restrict air flow through the unit’s fans or vents.

E.4.2 Rack Stability

During installation, consider weight distribution on the rack; hazardous stability conditions may
arise if units are loaded into the rack unevenly.

E.4.3 Input Supply
Overloading of supply circuits could impact over-current protection and supply wiring. To ensure

that supply circuits are not overloaded review the nameplate ratings. Connect the unit only to a
properly rated supply circuit.

E.4.4 Grounding

Reliable grounding of this equipment must be maintained. Pay particular attention to supply
connections when connecting to power strips, rather than direct connections to the branch circuit.

E.4.5 Radiation Performance

This unit complies with FDA radiation performance standards, 21CFR, Sub-chapter J.
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Glossary GL
A
A Ampere
AAL1 ATM Adaptation Layer 1.
AALS ATM Adaptation Layer 5.
AC Alternating Current
AC Switching | A pulse-width modulation, AC to DC converter.
Power Supply
ADC Analog to Digital Converter
ADM Add/Drop Multiplexer. A device that provides an interface between SONET and
other network signals, converting DSn signals into or from an OC-n signal.
AGC Automatic Gain Control
AIS Alarm Indication System. A signal comprised of all binary 1s.
AMSL Above Mean Sea Level
Amp or The standard unit of measure for electrical strength defined as the amount of
Ampere current that would be produced by an electromotive force of one volt acting
through a resistance of one ohm.
ANSI American National Standards Institute
ASCII American Standard Code for Information Interchange
ASI Asynchronous serial interface, also referred to as DVB ASI.
ASIC Application Specific Integrated Circuit
ATE Automatic Test Equipment
ATM Asynchronous Transfer Mode. A connection-oriented multiplexing and

switching method with high-speed transmission capability for data, voice and
video.

Auto-Detecting

The capability of a unit to automatically sense and set its configuration to match
the operational parameters of an incoming signal.

Auto-Ranging

The capability of a power supply unit to accept variable voltage rates.

Auto-Sensing

The capability of a power supply unit to detect variable voltage rates.
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B

Baseband The non-modulated transmission of audio and video signals.

Multimedia

Baud Rate A measure of transmission speed over a transmission medium.

BER Bit Error Rate

BERT Bit Error Rate Test

Bit/BIT Binary Digit or Built-In Test

Bit Rate Refers to the number of bits of data transmitted over a given time period. See
also bps.

BITE Built-In Test Equipment

BNC Bayonet Neill-Concelman. A type of connector featuring a locking pin on the
female end and a cut-out groove for the pin on the male end.

bps A ratio of the number of bits of data transmitted to the number of seconds
elapsed, expressed as bits per second.

BPSK Binary Phase Shift Keying

Buffer In data transmission, a buffer is a temporary storage location for information
being sent or received. A buffer is usually located between two different devices
that have different abilities or speeds for handling the data.

Buffer Within a data buffering system, the condition occurring whenever the number of

Overflow data bits entering the buffer exceeds the data capacity of the buffer.

Buffer Within a data buffering system, the condition occurring whenever the number of

Underflow data bits entering the buffer is not sufficient to maintain the buffer minimum
output rate.

Built-In-Self- Evaluative procedures residing in the microcontroller which are used to provide

Test diagnostic information regarding its operational state.

Byte 8 Binary Digits

C

C Celsius

C-Band A portion of the electromagnetic spectrum used heavily for satellite
transmissions. The uplink frequency is at 6 GHz, and the downlink is at 4 GHz.
Traditional applications include voice communications, video conferencing, and
broadcast TV and radio.

Cable Loss Loss of signal quality within cable, typically due to impedance as a result of
excessive cable length or material construction.

Carrier Offset | The frequency difference in Hertz measured between the programmed receive
frequency and the actual frequency received.

CATS Computer Aided Test Software

CA/XxXxXX Cable Assembly

CD-ROM Compact Disk — Read Only Memory

Channel A single path for transmitting electric or electromagnetic signals.
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CLK Clock

cm Centimeter

COM Common

CPS Cells per second

CPU Central Processing Unit

CRC Cyclic Redundancy Check. A system of error checking performed at the
transmitting and receiving stations.

CSA Canadian Standards Association — The Canadian counterpart of the U.S.
Underwriters Laboratories.

cw Continuous Wave

C/N Carrier to Noise Ratio

D

DAC Digital to Analog Converter

Data Typically refers to the information content of a signal including video, audio,
graphic, or character-based information.

Data Bits Within a data packet, the bits which represent the information content of a
packet. See also Data.

dB Decibel. A unit of measure of signal strength, usually the relation between a
transmitted signal and a standard signal source. An increase of 3 dB results in
a doubling of the signal strength. An increase of 6 dB results in a quadrupling
of the signal strength. Conversely, a decrease of 3 dB and 6 dB results in a
reduction in signal strength by one half and three quarters, respectively.

dBc Decibels Referred to Carrier

dBm Decibels Referred to 1.0 milliwatt

DC Direct Current

Decode To convert a coded signal into its original form.

Demod Demodulation. See Demodulate.

Demodulate To retrieve an electrical signal from a carrier signal or wave.

DPLL Digital Phase Locked Loop

DS3 A commercial leased line format that has the capacity to handle up to 44.763
Mbps of digital information; North American standard digital interface.

dsec Deci-seconds. A measurement of time that is equal to 0.1 seconds. For
example, 15 dsec is equal to 1.5 seconds.

DTE Data Termination Equipment. A generic name for any device that generates
information to be transmitted to another device or over a transmission system.
For example, visual display units, computers, and office workstations.

DVB Digital Video Broadcast. A set of standards providing the specifications for
transmission and reception of digitally processed broadcasting signals.

D&l Drop and Insert
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E
Ep/Ng E, = Energy per information bit; N, = Noise energy per Hertz. Signal energy
with respect to noise, expressed in energy per bit/noise in 1 Hz bandwidth.
EEPROM Electrically Erasable Programmable Read Only Memory
EIA Electronic Industries Association
EMI Electromagnetic Interference
ESC Engineering Service Circuits
ES-ES Earth Station to Earth Station Communication
ET Earth Terminal
E-3 European standard 34.368 Mbps digital interface.
F
F Fahrenheit
FAS Frame Acquisition Sync. A repeating series bits, which allow acquisition of a
frame.
Fault A disturbance that impairs or disrupts normal operations.
FCC Federal Communications Commission
FEC Forward Error Correction
FIFO First In, First Out. A type of data buffer.
FPGA Field Programmable Gate Array. A chip that can be reprogrammed for various
uses.
FW Firmware
G
g Force of Gravity
GHz Gigahertz
GND Ground
G.703 ITU-T Recommendation G.703, “Physical/Electrical Characteristics of
Hierarchical Digital Interfaces.” An interface protocol used for terrestrial
transmissions that operates at multiples of 64 Kbps PCM.
H
HPA High power amplifier. A device which provides the high power necessary to
transmit radio signals from an earth terminal to a satellite.
HSSI High Speed Serial Interface
HW Hardware
Hz Hertz (Unit of Frequency)

GL-4
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IBS Intelsat Business Services

IDR Intermediate Data Rate

I/O Input/Output

IEC International Electrotechnical Commission. A Geneva-based organization that
sets international electrical and electronics standards and includes national
committees from over 40 countries.

IEEE International Electrical and Electronic Engineers

IESS INTELSAT Earth Station Standards

IF Intermediate Frequency.

1. A frequency to which a signal wave is shifted locally as an intermediate
step in transmission or reception.

2. The fixed frequency resulting from heterodyning the incoming signal with
a signal from a local oscillator.

IFL Interfacility link. Typically refers to an interfacility link cable used to connect a
low-noise block (LNB) to an IRD. Often this IFL carries power from the IRD to
the LNB.

IF Looptest A diagnostic, troubleshooting, or operational test procedure designed to test
operate satellite equipment by passing video and audio test signals through an
encoder and satellite modulator, looping the output of the modulator to the input
of the IRD, and monitoring the video and audio output of the IRD.

Impedance The total opposition of a device offers to the flow of alternating current.
Measured in Ohms and varies at different frequencies.

Integrated Within a satellite downlink system, a piece of equipment used to demodulate

Receiver/ and decode a transport stream.

Decoder

INTELSAT International Telecommunication Satellite Organization

IRD See Integrated Receiver/Decoder.

ISO International Standards Organization

1&Q Analog In-Phase (1) and Quadrature Signals (Q)

J

J Joule
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K

kbps Kilobits per second. A ratio of 1000 bits transmitted per second. For example,
10 kbps is equal to 10,000 bits transmitted per second.

Kbps Kilobytes per second. A ratio of 1000 bytes transmitted per second. For
example, 10 Kbps is equal to 10,000 bytes transmitted per second.

kg Kilogram

kHz Kilohertz

Ksps Kilosample or kilosymbol per second. A ratio of 1000 samples or symbols
transmitted per second. For example, 10 Ksps is equal to 10,000 samples or
symbols transmitted per second.

Ku-Band A portion of the electromagnetic spectrum in the 12 GHz to 14 GHz range. Used
for satellites, employing 14 GHz on the uplink and 11 GHz on the downlink in
support of such applications as broadcast TV for man-on-the street interviews
and other situations requiring a small, portable dish. Ku is also used in Direct
Broadcast Satellite (DBS) systems, or Direct Satellite System (DSS).

L

LCD Liquid crystal display. A display technology that uses liquid crystals to form
displayed characters.

LED Light emitting diode. A display technology that uses a light emitting diode to
form displayed characters.

Line The degree of sharpness of a displayed video image.

Resolution

LNB Low Noise Block. A combination low noise amplifier and local oscillator used in
some satellite downconverters.

LO Local Oscillator. A device within a frequency converter that is used to reduce or
increase the frequency of the signal passed from the device input to output.

L-Band 1. Portion of the electromagnetic spectrum commonly used in satellite

applications, with frequencies in the 390 MHz to 1550 MHz range.
2. For an IRD, the frequency received from the LNB, existing in a range of

950 MHz to 2050 MHz.

GL-6
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M
mA Milliampere
Mbps Megabits per second. A ratio of 1,000,000 bits transmitted per second. For
example, 15 Mbps is equal to 15,000,000 bits transmitted per second.
MCPC See multi-channel-per-carrier.
MFAS Multi-Frame Acquisition Sync. See FAS.
MHz Megahertz
MIB Management Information Base
Mod Modulator or Modulated
Mono Channel | Referring to one audio output not contained in a stereo mix.
MPEG Moving Picture Experts Group.
1. A joint committee of the International Standards Organization (ISO) and
the International Electrotechnical Commission (IEC).
2. A series of hardware and software standards designed to reduce the
storage requirements of digital video.
3. A compression scheme for full motion video.
MPEG-1 Refers to ISO/IEC standards developed in 1991 by the ISO/IEC JTC1/SC29
WG11, Moving Picture Experts Group.
MPEG-2 Refers to ISO/IEC standards 13818-1 (Systems), 13818-2 (Video), 13818-3
(Audio), 13818-4 (Compliance).
ms or msec Millisecond
MTBF Mean time between failures. The length of time a user may reasonably expect
a device or system to work before an incapacitating fault occurs.
Multi-Channel- | Two or more video programs transmitted per digital transport stream.
Per-Carrier
M&C Monitor and Control
N
NC Normally Closed
Network A system designed to keep a network operating near maximum efficiency and
Management to provide operator interface to the managed system for configuring, isolating
System and correcting faults, and monitoring operational performance.
NO Normally Open
Non-Volatile, A type of Flash ROM used to store configuration parameters. The ROM memory
Field- is configurable by the user but will not clear if the unit loses power.
Programmable
Memory
ns Nanoseconds
NSAP Network Service Access Point. 20 octets ATM address per ISO8348 and ITU-T

X.213.
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NTSC

1. National Television Standards Committee of the Electronic Industries
Association (EIA). A committee which determines the video standards
for broadcast in the U.S.

2. The U.S. standard for video broadcast which uses a 3.57945 MHz
subcarrier whose phase varies with the instantaneous hue of the
televised color, and whose amplitude varies with the instantaneous
saturation of the color. A single frame (picture) in the standard consists
of 525 horizontal scanning lines. Frames are scanned at the rate of
29.97 frames per second.

3. Used to describe the standard method of television transmission in the
U. S., Canada, Japan, Central America, and parts of South America.

NVRAM

Non-Volatile Random Access Memory

N/C

No Connection or Not Connected

(0]

OC-3

Optical Carrier Level 3 (155.52 Mbps); refer to STM-1.

Ohm

A unit of measure for resistance symbolized by the Greek letter omega W.
Defined as the electrical resistance between two points of a conductor when a
constant difference of potential of 1 volt, applied between these points produces
in this conductor a current of 1 ampere, the conductor not being the source of
any electromotive force.

OQPSK

Offset Quadrature Phase Shift Keying

Overhead

A number of data bits used for error-checking, control, timing, and other
communications functions that are inserted in the data stream as an additional
to the individual data rates of the transport stream components. Overhead must
be included when calculating the aggregate transport stream output data rate.

P

PAL

Phase Alteration Line.

1. A broadcast television standard that uses a subcarrier which is
alternated 90 degrees in phase from one line to the next to minimize hue
errors in color transmission.

2. The color television transmission standard used in Europe and many
other parts of the world.

PAL-I

A European color television transmission standard that uses a 4.43361875 MHz
subcarrier. A single frame in this standard consists of 625 scanning line, and
frames are scanned at a rate of 25 frames per second.

PC

Personal Computer

PD Buffer

Plesiochronous/Doppler Buffer

PGCA

A proprietary conditional access method used by Tiernan equipment that
provides basic signal protection and the ability to authorize individual IRDs.

PID

Packet Identifier. Within a data packet, the bits used for its identification.

GL-8
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Pixel Picture Element.

1. The smallest unit of area of a video screen image that can be turned on
or off, or varied in intensity.
2. The smallest division that makes up the raster scan line for a video
display.

PLCP Physical Layer Convergence Protocol. In DS3 transmission, the part of the
physical layer that adapts the transmission facility to perform the distributed
queue dual bus (DQDB) access as defined in IEEE 802.6-1990.

PLL Phase Locked Loop

ppb Parts per Billion

ppm Parts per Million

PSI Program Specific Information.

PVC Permanent Virtual Circuit. A logical dedicated circuit between two user ports in
a point-to-point configuration.

P/N Part Number

Q

QAM Quadrature Amplitude Modulation

QPSK Quadrature Phase Shift Keying. The transmission of 2 bits per symbol, with
each symbol being a phase range of the sine wave. In this fashion, a 2:1
compression ratio is achieved, resulting in a doubling of the efficiency with
which a circuit is employed.

R

RAM Random Access Memory

RCD Remote Control Device. A computer terminal used to configure and monitor an
encoder or an IRD without using the unit’s control front panel.

RF Radio Frequency

RF Input The L-Band, C-Band, or Ku-Band input to an IRD.

ROM Read Only Memory

rms Root Mean Square

RU Rack Unit. 1 RU =1.75"/4.45 cm

Rx Receive (Receiver)

RxD Receive Data

R-S Reed-Solomon Coding. Reed-Solomon codes are block-based error correcting

codes with a wide range of applications in digital communications and storage.

01-0934-401-E
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S

Sample Rate The number of times per second that an analog signal is measured and
converted to a binary number in order to convert the analog signal to a digital
signal.

Satellite Within a satellite system, the frequency, either C-Band or Ku-Band, of the signal

Downlink transmitted to the receiving dish.

Frequency

SEQ Sequential

SCPC Single-Channel-Per-Carrier. One video program transmitted per digital
transport stream.

SNMP Simple Network Management Protocol. A widely used network monitoring and
control protocol. Data is passed from SNMP agents, which are hardware and/or
software processes reporting activity in each network device (hub, router,
bridge, etc.) to the workstation console used to oversee the network. The
agents return information contained in a Management Information Base, which
is a data structure that defines what is obtainable from the device and what can
be controlled.

sps Samples per second.

1. A ratio of the number of times that an analog signal is measured and
converted to a binary number to seconds elapsed, expressed as
samples per second.

2. Symbols per second — A ratio of symbols transmitted to seconds
elapsed expressed as symbols per second. Commonly used to express
the speed at which QPSK symbols are transmitted.

Stereo Pair Two audio signals consisting of sound reproduction of the same audio source.

STS-3c Concatenated SONET Synchronous Transport Signal Level 3.

SvC Switched Virtual Circuit. A circuit between two user points in a point-to-point
configuration that is established by ATM signaling stack rather than being a
dedicated circuit.

Symbol In digital transmission, a recognizable electrical state that is associated with a
signal element, which is an electrical signal within a defined period of time.

SYNC Synchronize

T

TBD To Be Designed or To Be Determined

™ Technical Manual

TPC Turbo Product Codes

TRE Trellis

Tx Transmit (Transmitter)

TxD Transmit Data
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U
UART Universal Asynchronous Receiver/Transmitter
UL Underwriters Laboratories.
uuT Unit Under Test
Vv
\% Volts
VAC Volts, Alternating Current
VCO Voltage Controlled Oscillator
VDC Volts, Direct Current
VDE Verband Deutscher Elektrotechniker. The German counterpart of the U.S.
Underwriters Laboratories.
VIT Viterbi Decoding. See Viterbi Code Rate
Viterbi Code Forward error-correction scheme.
Rate
Vpp or Vp-p Volts peak-to-peak.
WXYZ
w Watt
Misc.
VS Microsecond
Q Ohms
16QAM 16 Quadrature Amplitude Modulation
8PSK 8 Phase Shift Keying
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